Note
Every effort has been made to ensure that the information contained in this document was complete and accurate at the time of publishing. Nevertheless, the authors retain the right to modify the information. This customer document describes all the hardware units and functions known at the present time. Descriptions may be included for units which are not present at the customer site. The exact scope of delivery is described in the respective purchase contract.

CE Conformity
Hereby, VIPA GmbH declares that the products and systems are in compliance with the essential requirements and other relevant provisions of the following directives:
- 2006/95/EC Low Voltage Directive
Conformity is indicated by the CE marking affixed to the product.

Conformity Information
For more information regarding CE marking and Declaration of Conformity (DoC), please contact your local VIPA customer service organization.

Trademarks
VIPA, SLIO, System 100V, System 200V, System 300V, System 300S, System 400V, System 500S and Commander Compact are registered trademarks of VIPA Gesellschaft für Visualisierung und Prozessautomatisierung mbH.
SPEED7 is a registered trademark of profichip GmbH.
SIMATIC, STEP, SINEC, S7-300 and S7-400 are registered trademarks of Siemens AG.
Microsoft und Windows are registered trademarks of Microsoft Inc., USA.
Portable Document Format (PDF) and Postscript are registered trademarks of Adobe Systems, Inc.
All other trademarks, logos and service or product marks specified herein are owned by their respective companies.

Information product support
Contact your local VIPA Customer Service Organization representative if you wish to report errors or questions regarding the contents of this document. If you are unable to locate a customer service center, contact VIPA as follows:
VIPA GmbH, Ohmstraße 4, 91074 Herzogenaurach, Germany
Telefax:+49 9132 744 1204
EMail: documentation@vipa.de

Technical support
Contact your local VIPA Customer Service Organization representative if you encounter problems with the product or have questions regarding the product. If you are unable to locate a customer service center, contact VIPA as follows:
VIPA GmbH, Ohmstraße 4, 91074 Herzogenaurach, Germany
Telephone: +49 9132 744 1150/1180 (Hotline)
EMail: support@vipa.de
## Contents

### About this manual
- 1

### Safety information
- 2

### Chapter 1 Basics
- 1-1
  - Safety Information for Users
    - 1-2
  - Principles of Net-ID, Subnet-ID, Host-ID
    - 1-3
  - Operating structure of a CPU
    - 1-6
  - CPU Applications
    - 1-7
  - Operands of the CPU
    - 1-7
  - CPU 517S/NET
    - 1-9

### Chapter 2 Hardware description
- 2-1
  - Properties
    - 2-2
  - Structure
    - 2-3
  - Components
    - 2-4
  - Technical Data
    - 2-10

### Chapter 3 Deployment CPU 517S/NET
- 3-1
  - Overview
    - 3-2
  - Assembly
    - 3-3
  - Installation of the driver
    - 3-4
  - Guidelines for IP address assignment
    - 3-5
  - Connect power supply
    - 3-8
  - Initialization of the CPU component
    - 3-10
  - Internal access to PG/OP channel
    - 3-14
  - External access to PG/OP channel via routing
    - 3-15
  - Access to the integrated web page
    - 3-18
  - Project engineering
    - 3-20
  - CPU parameterization
    - 3-24
  - Project transfer
    - 3-35
  - Operating modes
    - 3-40
  - Overall reset
    - 3-43
  - Firmware update
    - 3-45
  - Factory reset
    - 3-48
  - Memory expansion with MCC
    - 3-49
  - Extended know-how protection
    - 3-50
  - MMC-Cmd - Auto commands
    - 3-52
  - VIPA specific diagnostic entries
    - 3-54
  - Using test functions for control and monitoring of variables
    - 3-58

### Chapter 4 Deployment CPU with Profibus
- 4-1
  - Overview
    - 4-2
  - Project engineering CPU with integrated Profibus master
    - 4-3
  - Deployment as Profibus DP slave
    - 4-5
  - Project transfer
    - 4-7
  - Profibus installation guidelines
    - 4-8
  - Commissioning and Start-up behavior
    - 4-11
<table>
<thead>
<tr>
<th>Chapter</th>
<th>Deployment PtP communication</th>
<th>Deployment Ethernet communication</th>
<th>Deployment PLC-Tool</th>
<th>WinPLC7</th>
<th>Appendix</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Fast introduction</td>
<td>Basics - Industrial Ethernet in automation</td>
<td>General</td>
<td>System presentation</td>
<td>Index</td>
</tr>
<tr>
<td></td>
<td>Principle of the data transfer</td>
<td>Basics - ISO/OSI reference model</td>
<td>Setup and run of program</td>
<td>Installation</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Deployment of RS485 interface for PtP</td>
<td>Basics - Terms</td>
<td>PLC-Tool Operation</td>
<td>Example project engineering</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Parameterization</td>
<td>Basics - Protocols</td>
<td>Deployment PLC-Tool</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Communication</td>
<td>Basics - IP address and subnet</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Protocols and procedures</td>
<td>Basics - MAC address and TSAP</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Modbus - Function codes</td>
<td>Fast introduction</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Modbus - Example communication</td>
<td>Hardware configuration</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Configure connections</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Communication connections in the user program</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>NCM diagnostic - Help for error diagnostic</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Coupling to other systems</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
About this manual

This product supplement contains all information required for the deployment of the Slot-PLC 517S/NET in your PC. The here described Slot-PLC is a SPEED7 517S/NET with integrated Profibus-DP master. The CPU is included in the PC as Ethernet interface and can be accessed via the IP address.

Overview

Chapter 1: Basics
This Basics contain hints for the usage and information about the project engineering of a System 500S SPEED7 from VIPA. Basic information about the structure of IP addresses can be found further.

Chapter 2: Hardware description
In this chapter the hardware components of the CPU 517S/NET are more described here. The chapter closes with the technical data.

Chapter 3: Deployment CPU 517S/NET
Main topic of this chapter is the deployment of the CPU 517S/NET from VIPA. Here information necessary for installation, start-up and project engineering can be found.

Chapter 4: Deployment with Profibus
Content of this chapter is the deployment of the CPU 517S/NET with Profibus. After a short overview the project engineering and parameterization of a CPU 517S/NET with integrated Profibus-Part from VIPA is shown. Further you get information about usage as DP master and DP slave of the Profibus part. The chapter is ended with notes to commissioning and start-up.

Chapter 5: Deployment PtP Communication
In this chapter the deployment of the RS485 slot for serial PtP communication is described. Here you'll find all information about the protocols and project engineering of the interface, which are necessary for the serial communication using the RS485 interface.

Chapter 6: Deployment TCP/IP
In this chapter the communication via Ethernet is described. Please regard the chapter "Fast introduction" where you will find every information compressed required for the project engineering of the CPU 517S/NET with CP 543. After the fast introduction, the mentioned steps are described in detail.
Chapter 7: Deployment PLC-Tool
This chapter contains the description of the control software *PLC-Tool* from VIPA. PLC-Tool is a component of the OPC-Server package and is installed together with the OPC server at the standard installation.
The OPC-Server package may be found at the enclosed CD *SW-ToolDemo*.

Chapter 8: WINPLC7
In this chapter the programming and simulation software WinPLC7 from VIPA is presented. WinPLC7 is suited for every with Siemens STEP®7 programmable PLC.
Besides the system presentation and installation here the basics for using the software is explained with a sample project.
More information concerning the usage of WinPLC7 may be found in the online help respectively in the online documentation of WinPLC7.
**Objective and contents**

This manual describes the System 500S SPEED7 517S/NET from VIPA. It contains a description of the construction, project implementation and usage.

This manual is part of the documentation package with order number HB145E_CPU and relevant for:

<table>
<thead>
<tr>
<th>Product</th>
<th>Order number</th>
<th>as of state:</th>
<th>CPU-HW</th>
<th>CPU-FW</th>
<th>DPM-FW</th>
<th>CP-FW</th>
</tr>
</thead>
<tbody>
<tr>
<td>CPU 517S/NET</td>
<td>VIPA 517-4NE02</td>
<td>01</td>
<td>V351</td>
<td>V326</td>
<td>V259</td>
<td></td>
</tr>
</tbody>
</table>

**Target audience**

The manual is targeted at users who have a background in automation technology.

**Structure of the manual**

The manual consists of chapters. Every chapter provides a self-contained description of a specific topic.

**Guide to the document**

The following guides are available in the manual:

- an overall table of contents at the beginning of the manual
- an overview of the topics for every chapter
- an index at the end of the manual.

**Availability**

The manual is available in:

- printed form, on paper
- in electronic form as PDF-file (Adobe Acrobat Reader)

**Icons**

Important passages in the text are highlighted by following icons and headings:

- **Danger!**
  Immediate or likely danger.
  Personal injury is possible.

- **Attention!**
  Damages to property is likely if these warnings are not heeded.

- **Note!**
  Supplementary information and useful tips.
Safety information

Applications conforming with specifications

The SPEED7 CPU is constructed and produced for:
- communication and process control
- general control and automation applications
- industrial applications
- operation within the environmental conditions specified in the technical data
- installation into a cubicle

Danger!
This device is not certified for applications in
- in explosive environments (EX-zone)

Documentation

The manual must be available to all personnel in the
- project design department
- installation department
- commissioning
- operation

The following conditions must be met before using or commissioning the components described in this manual:

- Modification to the process control system should only be carried out when the system has been disconnected from power!
- Installation and modifications only by properly trained personnel
- The national rules and regulations of the respective country must be satisfied (installation, safety, EMC ...)

Disposal

National rules and regulations apply to the disposal of the unit!
Chapter 1  Basics

Overview

This Basics contain hints for the usage and information about the project engineering of a System 500S SPEED7 from VIPA.

Basic information about the structure of IP addresses can be found further.

<table>
<thead>
<tr>
<th>Content</th>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chapter 1 Basics</td>
<td>1-1</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Safety Information for Users</td>
<td>1-2</td>
</tr>
<tr>
<td></td>
<td>Principles of Net-ID, Subnet-ID, Host-ID</td>
<td>1-3</td>
</tr>
<tr>
<td></td>
<td>Operating structure of a CPU</td>
<td>1-6</td>
</tr>
<tr>
<td></td>
<td>CPU Applications</td>
<td>1-7</td>
</tr>
<tr>
<td></td>
<td>Operands of the CPU</td>
<td>1-7</td>
</tr>
<tr>
<td></td>
<td>CPU 517S/NET</td>
<td>1-9</td>
</tr>
</tbody>
</table>
Safety Information for Users

Handling of electrostatic sensitive modules

VIPA modules make use of highly integrated components in MOS-Technology. These components are extremely sensitive to over-voltages that can occur during electrostatic discharges.

The following symbol is attached to modules that can be destroyed by electrostatic discharges.

The Symbol is located on the module, the module rack or on packing material and it indicates the presence of electrostatic sensitive equipment.

It is possible that electrostatic sensitive equipment is destroyed by energies and voltages that are far less than the human threshold of perception. These voltages can occur where persons do not discharge themselves before handling electrostatic sensitive modules and they can damage components thereby, causing the module to become inoperable or unusable.

Modules that have been damaged by electrostatic discharges can fail after a temperature change, mechanical shock or changes in the electrical load. Only the consequent implementation of protection devices and meticulous attention to the applicable rules and regulations for handling the respective equipment can prevent failures of electrostatic sensitive modules.

Shipping of electrostatic sensitive modules

Modules must be shipped in the original packing material.

Measurements and alterations on electrostatic sensitive modules

When you are conducting measurements on electrostatic sensitive modules you should take the following precautions:

- Floating instruments must be discharged before use.
- Instruments must be grounded.

Modifying electrostatic sensitive modules you should only use soldering irons with grounded tips.

Attention!

Personnel and instruments should be grounded when working on electrostatic sensitive modules.
Principles of Net-ID, Subnet-ID, Host-ID

Why Principles? The CPU 51xS PC plug-in card consists of a CPU and an Ethernet portion that communicate via a TCP-based point-to-point connection. To enable this, CPU and Ethernet portion each have an alterable IP address that may only differ in the Host-ID.

If you want to install several CPU 51xS in one PC, every CPU 51xS plug-in card needs an own Net-ID.

The following text describes the approach for the assignment of IP addresses together with Net-ID and Host-ID.
Every IP address is a combination of a **Net-ID** and a **Host-ID**.

The **Net**work-ID identifies a network res. a network controller that administrates the network.

The Host-ID marks the network connections of a participant (host) to this network.

The Host-ID can be further divided into a **Subnet-ID** and a *new Host-ID* by using an bit for bit AND assignment with the **Subnet-Mask**.

The area of the original Host-ID that is overwritten by 1 of the Subnet-Mask becomes the Subnet-ID, the rest is the new Host-ID.

<table>
<thead>
<tr>
<th>Subnet-Mask</th>
<th>binary all &quot;1&quot;</th>
<th>binary all &quot;0&quot;</th>
</tr>
</thead>
<tbody>
<tr>
<td>IPv4 address</td>
<td>Net-ID</td>
<td>Host-ID</td>
</tr>
<tr>
<td>Subnet-Mask and IPv4 address</td>
<td>Net-ID</td>
<td>Subnet-ID</td>
</tr>
</tbody>
</table>

A TCP-based communication via point-to-point, hub or switch connection is only possible between stations with identical Network-ID and Subnet-ID! Different area must be connected with a router.

The Subnet-Mask allows you to sort the resources after your needs. This means e.g. that every department gets an own subnet and thus does not interfere another department.

**Note!**
When using the CPU 51xS in your PC, the Net-ID of the CPU 51xS must not be assigned to another device. Otherwise you have to reassign the addresses.
### Address classes

For IPv4 addresses there are five address formats (class A to class E) that are all of a length of 4 byte = 32bit.

<table>
<thead>
<tr>
<th>Class</th>
<th>Network-ID</th>
<th>Host-ID</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>0</td>
<td>32 bit</td>
</tr>
<tr>
<td>B</td>
<td>10</td>
<td>16 bit</td>
</tr>
<tr>
<td>C</td>
<td>110</td>
<td>8 bit</td>
</tr>
<tr>
<td>D</td>
<td>1110</td>
<td>Multicast group</td>
</tr>
<tr>
<td>E</td>
<td>11110</td>
<td>Reserved</td>
</tr>
</tbody>
</table>

The classes A, B and C are used for individual addresses, class D for multicast addresses and class E is reserved for special purposes. The address formats of the classes A, B, C are only differing in the length of Network-ID and Host-ID.

### Private IP networks

To build up private IP-Networks within the internet, RFC1597/1918 reserves the following address areas:

<table>
<thead>
<tr>
<th>Network class</th>
<th>Start IP</th>
<th>End IP</th>
<th>Standard Subnet Mask</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>10.0.0.0</td>
<td>10.255.255.255</td>
<td>255.0.0.0</td>
</tr>
<tr>
<td>B</td>
<td>172.16.0.0</td>
<td>172.31.255.255</td>
<td>255.255.0.0</td>
</tr>
<tr>
<td>C</td>
<td>192.168.0.0</td>
<td>192.168.255.255</td>
<td>255.255.255.0</td>
</tr>
</tbody>
</table>

(The Host-ID is underlined.)

These addresses can be used as net-ID by several organizations without causing conflicts, for these IP addresses are neither assigned in the internet nor are routed in the internet.

### Reserved Host-Ids

Some Host-IDs are reserved for special purposes.

<table>
<thead>
<tr>
<th>Host-ID</th>
<th>Identifier of this network, reserved!</th>
</tr>
</thead>
<tbody>
<tr>
<td>Host-ID = 0</td>
<td></td>
</tr>
<tr>
<td>Host-ID = max</td>
<td>Broadcast address of this network</td>
</tr>
</tbody>
</table>

### Note!

Never choose an IP address with Host-ID=0 or Host-ID=maximum!
(e.g. for class B with Subnet Mask = 255.255.0.0, the "172.16.0.0" is reserved and the "172.16.255.255" is occupied as local broadcast address for this network.)
Operating structure of a CPU

General

The CPU contains a standard processor with internal program memory. In connection with the integrated SPEED7 Technology receive you efficient equipment for process automation.

A CPU supports the following modes of operation:

- cyclic operation
- timer processing
- alarm controlled operation
- priority based processing

Cyclic processing

Cyclic processing represents the major part of all the processes that are executed in the CPU. Identical sequences of operations are repeated in a never-ending cycle.

Timer processing

Where a process requires control signals at constant intervals you can initiate certain operations based upon a timer, e.g. not critical monitoring functions at one-second intervals.

Alarm controlled processing

If a process signal requires a quick response you would allocate this signal to an alarm controlled procedure. An alarm can activate a procedure in your program.

Priority based processing

The above processes are handled by the CPU in accordance with their priority. Since a timer or an alarm event requires a quick reaction, the CPU will interrupt the cyclic processing when these high-priority events occur to react to the event. Cyclic processing will resume, once the reaction has been processed. This means that cyclic processing has the lowest priority.
CPU Applications

Overview
The program that is present in every CPU is divided as follows:
- System routine
- User application

System routine
The system routine organizes all those functions and procedures of the CPU that are not related to a specific control application.

User application
This consists of all the functions that are required for the processing of a specific control application. The operating modules provide the interfaces to the system routines.

Operands of the CPU

Overview
The following series of operands is available for programming the CPU:
- Process image and periphery
- Bit memory
- Timers and counters
- Data blocks

Process image and periphery
The user application can quickly access the process image of the inputs and outputs PAA/PAE. You may manipulate the following types of data:
- individual Bits
- Bytes
- Words
- Double Words

You may also gain direct access to peripheral modules via the bus from user application. The following types of data are available:
- Bytes
- Words
- Blocks
Bit Memory

The bit memory is an area of memory that is accessible by means of certain operations. Bit memory is intended to store frequently used working data.

You may access the following types of data:

- individual Bits
- Bytes
- Words
- Double words

Timers and counters

In your program you may load cells of the timer with a value between 10ms and 9990s. As soon as the user application executes a start-operation, the value of this timer is decremented by the interval that you have specified until it reaches zero.

You may load counter cells with an initial value (max. 999) and increment or decrement these when required.

Data Blocks

A data block contains constants or variables in the form of bytes, words or double words. You may always access the current data block by means of operands.

You may access the following types of data:

- individual Bits
- Bytes
- Words
- Double words
CPU 517S/NET

Overview
The CPU 517S/NET is a fully adequate PLC-CPU in form of a PCI-slot card for PC-based applications. The operating systems Windows® 98, ME, NT4, 2000 and XP are supported.
The range of performance is adequate to a SPEED7 CPU from the System 300S from VIPA. The programming takes place via standard programming tools like e.g. WinPLC7 from VIPA or STEP®7 from Siemens.
For the link up to the process level there is as well a MPI as a Profibus DP master interface. The integrated CP 543 communicate via a twisted pair interface.
Further on, the VIPA OPC-Server is included in the delivery.
After the hardware installation, the card is linked up to the PC as COM interface. The CPU component of the CPU 517S slot card can only be operated with an external or internal DC 24V power supply. The external supply enables the operation of the card outside of a PC res. independent from the PC operation. Please consider for operation that the slot card is connected to ground via its metal cover.

Memory management
The CPU has an integrated work memory. During program run the total memory is divided into 50% for program code and 50% for data.
There is the possibility to extend the total memory to its maximum by means of a MCC memory extension card.

Integrated Ethernet-PG/OP-channel
The CPU has an Ethernet interface for PG/OP communication. Only in installed condition you have access via the PG/OP channel to your CPU. Here you may program, remote control or show the integrated web page.
There are maximum 4 channels.

Integrated Profibus DP master
The CPU has an integrated Profibus DP master. Via the DP master with a data range of 1kByte for in- and output up to 124 DP slaves may be addressed. The project engineering takes place in WinPLC7 from VIPA or in the hardware configurator from Siemens. Please regard there may be a delimitation of the maximum number of configurable DP slaves by the use of the Siemens SIMATIC manager.
The Profibus part may also be used as "intelligent" DP slave. More may be found at "Deployment CPU with Profibus".
During operation the data range of the DP master is monitored at an adjustable address area of the CPU. The address area may be by hardware configuration.

Integrated CP 543
The integrated CP 543 offers you a communication processor. This serves 32 PG/OP channels and 16 by Siemens NetPro respectively 64 by user program configurable productive connections.
The Slot PLC includes a MPI interface. On delivery the default MPI address is 2. This address may be changed at any time via your CPU project engineering tool.

- External power supply of the CPU (autarkic operation)
- ESD/Burst acc. IEC 61000-4-2/IEC 61000-4-4 (up to level 3)
- Shock resistance acc. IEC 60068-2-6 / IEC 60068-2-27 (1G/12G)

- Operating temperature: 0 ... +60°C
- Storage temperature: -25 ... +70°C
- Relative humidity: 5 ... 95% without condensation
- Fanless operation

The SPEED7 CPUs from VIPA are instruction compatible to the programming language STEP®7 from Siemens and may be programmed via WinPLC7 from VIPA or via the Siemens SIMATIC Manager. Here the instruction set of the S7-400 from Siemens is used.

Note!
Please do always use the CPU 318-2DP (6ES7 318-2AJ00-0AB0/V3.0) from Siemens of the hardware catalog to project a CPU 517S/DPM from VIPA.
For the project engineering, a thorough knowledge of the Siemens SIMATIC Manager and the hardware configurator from Siemens is required!

The CPU component of the 517S slot card can only be operated with an external or internal DC 24V power supply. Simultaneous infeed should absolutely be avoided!
Please consider for operation that the slot card is connected to ground via its metal cover.
When connecting please consider that the internal power supply hardware conditionally does not have an EMV filter for protection against disturbances.

For operating the CPU via the PC the program "PLC-Tool" is included in the consignment. For monitoring and operating of the CPU, your PC shows an user interface that is modeled on the schematic view on a CPU front. Via the PLC-Tool you may request the LED state and monitor res. change the operating mode of the CPU.
# Chapter 2   Hardware description

## Overview
In this chapter the hardware components of the CPU 517S/NET are more described here.
The chapter closes with the technical data.

## Content

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chapter 2</td>
<td>2-1</td>
</tr>
<tr>
<td>Hardware description</td>
<td>2-2</td>
</tr>
<tr>
<td>Properties</td>
<td>2-3</td>
</tr>
<tr>
<td>Structure</td>
<td>2-4</td>
</tr>
<tr>
<td>Components</td>
<td>2-4</td>
</tr>
<tr>
<td>Technical Data</td>
<td>2-10</td>
</tr>
</tbody>
</table>
Chapter 2  Hardware description

Manual VIPA System 500S SPEED7

Properties

CPU 517S/NET
517-4NE02

- Integrated SPEED7 technology
- Instruction compatible to STEP®7 from Siemens
- Project engineering via the SIMATIC Manager from Siemens
- Integrated DC 24V power supply
- MPI with max. 32 PG/OP connections with up to 12Mbit/s
- Status-LEDs for operating state and diagnosis
- Battery buffer for RAM and clock
- Integrated Profibus DP master
- Integrated CP 543 Communication processor
- Integrated work memory 2Mbyte expandable up to 8Mbyte (50% program - 50% data)
- Storage media slot for project engineering and firmware update
- 2048 Timer, 2048 Counter, 16384 Memory-Byte

Ordering data

<table>
<thead>
<tr>
<th>Type</th>
<th>Order number</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>517S/NET</td>
<td>VIPA 517-4NE02</td>
<td>2Mbyte work memory expandable up to 8Mbyte (50% code - 50% data), external power supply, MPI, MMC slot, real time clock, Interface: Profibus DP master, 12Mbit/s, up to 124 slaves, PCI-Ethernet interface for PG/OP communication, incl. SW110A2LA OPC-Server (SW110A2LA please order separate). Incl. Drivers and SW860R OPC-Server (on the ToolDemo-CD) 2. slot: Ethernet CP 543, S7 communication, RFC1006, H1, TCP/IP, UDP, up to 64 connections</td>
</tr>
</tbody>
</table>
Structure

CPU 517S/NET
517-4NE02

[1] Clamp for internal DC 24V power supply
[2] LEDs for commissioning (here covered by Ethernet part)
[3] Lithium accu for clock and user memory (here covered by Ethernet part)
[4] Storage media slot (here MMC is plugged)
[5] PCI bus pins
[6] RUN/STOP LEDs
[7] Operating mode switch
[8] Profibus DP master jack
[9] Plug for external DC 24V power supply
[10] MPI jack
[11] LEDs CP 543 communication
[12] Twisted pair interface for CP 543 communication
Chapter 2  Hardware description

Components

LED bar

On the plug-in module you can see a LED bar for status monitoring of the CPU and the Profibus DP master. Especially at the commissioning and the external usage of the module, the state of your CPU and your Profibus-DP master is shown.

At deployment inside a PC, you may issue the state of the LEDs on your PC via the delivered software PLC-Tool.

The usage and the according colors of the LEDs are to see in the following tables:

### Master operation

<table>
<thead>
<tr>
<th>RUN green</th>
<th>ERR red</th>
<th>DE green</th>
<th>IF red</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>○ ○ ○ ○</td>
<td></td>
<td>○</td>
<td></td>
<td>Master has no project, this means the DP interface is not used.</td>
</tr>
<tr>
<td>● ○ ○ ○</td>
<td></td>
<td>○</td>
<td></td>
<td>Master is in &quot;clear&quot; state (safety state). The inputs of the slaves may be read. The outputs are disabled.</td>
</tr>
<tr>
<td>● ○ ● ○</td>
<td></td>
<td>○</td>
<td></td>
<td>Master is in &quot;operate&quot; state (CPU RUN), this means data exchange between master and slaves. The outputs may be accessed.</td>
</tr>
<tr>
<td>● ● ○ ○</td>
<td></td>
<td>○</td>
<td></td>
<td>At least 1 slave is missing.</td>
</tr>
<tr>
<td>● ● ● ○</td>
<td></td>
<td>○</td>
<td></td>
<td></td>
</tr>
<tr>
<td>○ ○ ○ ●</td>
<td></td>
<td>○</td>
<td></td>
<td>Initialization error at faulty parameterization.</td>
</tr>
<tr>
<td>○ ● ○ ●</td>
<td></td>
<td></td>
<td></td>
<td>Waiting state for start command from CPU (state at start-up).</td>
</tr>
</tbody>
</table>

### Slave operation

<table>
<thead>
<tr>
<th>RUN green</th>
<th>ERR red</th>
<th>DE green</th>
<th>IF red</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>○ ○ ○ ○</td>
<td></td>
<td>○</td>
<td></td>
<td>Slave has no project respectively.</td>
</tr>
<tr>
<td>☀ ○ ○ ○</td>
<td></td>
<td>○</td>
<td></td>
<td>Slave is without master.</td>
</tr>
<tr>
<td>☀ ○ ☀ ○</td>
<td></td>
<td>○</td>
<td></td>
<td>Alternate flashing at configuration faults.</td>
</tr>
<tr>
<td>● ○ ● ○</td>
<td></td>
<td>○</td>
<td></td>
<td>Slave exchanges data between master.</td>
</tr>
</tbody>
</table>

on: ● off: ○ flashing: ☀
... continue

LEDs

<table>
<thead>
<tr>
<th>Label</th>
<th>Color</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ethernet</td>
<td></td>
<td></td>
</tr>
<tr>
<td>COLL</td>
<td>green</td>
<td>Collision: on: total duplex operation active&lt;br&gt;off: half duplex operation active&lt;br&gt;blinking: Collision detected</td>
</tr>
<tr>
<td>SPEED</td>
<td>green</td>
<td>Speed: on: 100Mbit&lt;br&gt;off: 10Mbit</td>
</tr>
<tr>
<td>LINK</td>
<td>green</td>
<td>Link: on: physical connection detected&lt;br&gt;off: no physical connection</td>
</tr>
<tr>
<td>CPU</td>
<td></td>
<td></td>
</tr>
<tr>
<td>MMC</td>
<td>yellow</td>
<td>blinks at MMC access</td>
</tr>
<tr>
<td>FRCE</td>
<td>yellow</td>
<td>blinks as soon as variable are forced (fixed)</td>
</tr>
<tr>
<td>SF</td>
<td>red</td>
<td>blinks at system errors (hardware defect)</td>
</tr>
<tr>
<td>PWR</td>
<td>green</td>
<td>CPU section is provided internal with 5V</td>
</tr>
</tbody>
</table>

LEDs at connection panel

Above the operating mode lever there are 2 LEDs, showing the operating state of the CPU:

<table>
<thead>
<tr>
<th>Label</th>
<th>Color</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ST</td>
<td>yellow</td>
<td>CPU is in STOP</td>
</tr>
<tr>
<td>RN</td>
<td>green</td>
<td>CPU is in RUN</td>
</tr>
</tbody>
</table>

LEDs CP 543

The following table shows how the diagnostic LEDs of the integrated CP 543 are used along with the respective colors.

<table>
<thead>
<tr>
<th>Name.</th>
<th>Color</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PW</td>
<td>green</td>
<td>Indicates internal power supply of CP 543</td>
</tr>
<tr>
<td>RN</td>
<td>green</td>
<td>The CP RUNs with a loaded project. The communication by configured connections is enabled.</td>
</tr>
<tr>
<td>ST</td>
<td>yellow</td>
<td>ON at STOP and connections are blocked.</td>
</tr>
<tr>
<td>SF</td>
<td>red</td>
<td>ON at error</td>
</tr>
<tr>
<td>L/A</td>
<td>green</td>
<td>Link/Activity&lt;br&gt;ON: Physically connected&lt;br&gt;OFF: Physically not connected&lt;br&gt;Blinking: Ethernet activity</td>
</tr>
<tr>
<td>S</td>
<td>green</td>
<td>Speed:&lt;br&gt;ON: 100Mbit&lt;br&gt;OFF: 10Mbit.</td>
</tr>
</tbody>
</table>
Jacks and plugs

On the PC plug-in module the following jacks are led out:

Profibus DP master interface PBDP/PtP

Via the 9pin RS485 interface you link up the integrated Profibus DP master to Profibus. The RS485 interface in PtP operation supports the serial process connection to different source or destination systems.

The RS485 jack has the following pin occupancy:

<table>
<thead>
<tr>
<th>Pin</th>
<th>Assignment</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>shield</td>
</tr>
<tr>
<td>2</td>
<td>M24V</td>
</tr>
<tr>
<td>3</td>
<td>RxD/TxD-P (Line B)</td>
</tr>
<tr>
<td>4</td>
<td>RTS</td>
</tr>
<tr>
<td>5</td>
<td>M5V</td>
</tr>
<tr>
<td>6</td>
<td>P5V</td>
</tr>
<tr>
<td>7</td>
<td>P24V</td>
</tr>
<tr>
<td>8</td>
<td>RxD/TxD-N (Line A)</td>
</tr>
<tr>
<td>9</td>
<td>n.c.</td>
</tr>
</tbody>
</table>

Note!

Please make sure to activate the terminating resistors at the bus ends!

MPI interface

MPI serves the connection to the process level. Here you may transfer programs and data between the MPI participants. On delivery the MPI address is 2.

For a serial transfer from your PC you normally need a MPI transducer.

The MPI jack has the following pin assignment:

<table>
<thead>
<tr>
<th>Pin</th>
<th>Assignment</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>reserved (must not be connected)</td>
</tr>
<tr>
<td>2</td>
<td>M24V</td>
</tr>
<tr>
<td>3</td>
<td>RxD/TxD-P (Line B)</td>
</tr>
<tr>
<td>4</td>
<td>RTS</td>
</tr>
<tr>
<td>5</td>
<td>M5V</td>
</tr>
<tr>
<td>6</td>
<td>P5V</td>
</tr>
<tr>
<td>7</td>
<td>P24V</td>
</tr>
<tr>
<td>8</td>
<td>RxD/TxD-N (Line A)</td>
</tr>
<tr>
<td>9</td>
<td>n.c.</td>
</tr>
</tbody>
</table>
CP 543

The CPU 517S/NET has a communication processor CP 543 integrated. This serves 16 configurable connections via NetPro, 64 configurable connections via user program and 32 PG/OP connections. The project engineering happens using NetPro from Siemens as CP343-1EX11.

Via the RJ45 jack you may connect the CP to Twisted-Pair-Ethernet.

The slot has the following pin assignment:

<table>
<thead>
<tr>
<th>8-pin RJ45 jack:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pin</td>
</tr>
<tr>
<td>1</td>
</tr>
<tr>
<td>2</td>
</tr>
<tr>
<td>3</td>
</tr>
<tr>
<td>4</td>
</tr>
<tr>
<td>5</td>
</tr>
<tr>
<td>6</td>
</tr>
<tr>
<td>7</td>
</tr>
<tr>
<td>8</td>
</tr>
</tbody>
</table>

RJ45 jack

Storage media slot

As external storage medium for applications and firmware you may use a MMC storage module (Multimedia card) or a configured MMC as MCC memory extension card. The MCC can additionally be used as an external storage medium.

Both VIPA storage media are pre-formatted with the PC format FAT16 and can be accessed via a card reader.

Memory management

Every CPU 51xS has an integrated work memory. During program run the total memory is divided into 50% for program code and 50% for data.

There is the possibility to extend the total memory to its maximum by means of a Memory Configuration Card called MCC.

Attention!

At deployment of a MMC, please regard, that it has to be preformatted with the FAT16 file system. The VIPA memory cards are always delivered preformatted.

Operating mode switch

With the operating mode switch you may switch the CPU between STOP and RUN. The operating mode START-UP is driven automatically from the CPU between STOP and RUN.

Placing the switch to Memory Reset (MRES), you request an overall reset with following load from MMC (project or firmware update).
Power supply

After the CPU 51xS slot card is installed in the PC and the communication between PC and Ethernet component is established the DC 24V power supply may be attached.

The CPU component of the CPU 51xS slot card can only be operated with an external or internal DC 24V power supply. The external supply enables the operation of the card outside of a PC res. independent from the PC operation. Please consider for operation that the slot card is connected to ground via its metal cover.

**Note!**
The CPU 51xS is to supply either externally or internally with DC 24V. **Simultaneous infeed should absolutely be avoided!**

External power supply

For external power supply there is a plug on slot panel with the following pin assignment:

![DC 24V and GND pins for external power supply](image)

Internal power supply

For the internal power DC 24V supply there is a clamp on the top of the slot card.

Please consider when connecting a DC 24V power supply that the internal power supply hardware conditionally does not have an EMC filter for protection against disturbances (like e.g. EN 61000-4-4 [Burst], EN 61000-4-5 [Surge] or EN 61000-4-6 [conducted disturbance variable, inducted by HF fields]).

Here please use an accordingly filtered supply voltage here.

The clamp has the following pin assignment:

![GND and DC 24V pins for internal power supply](image)
Battery buffer for clock and RAM

The CPU 51xS contains an internal accumulator/battery for protecting the RAM at a power break-down. Additionally the battery buffers the internal clock.

The battery is directly reloaded via the integrated voltage supply by means of a special loading electronic and guarantees a buffer of minimum 30 days.

The battery has to be error free, so that the CPU may automatically restart. A start with a defective battery is possible, if it is manually switched to RUN or if a MMC is plugged, which contains a valid s7prog.wld project with an OB81 for battery fault.

If there is an error concerning the integrated battery, the CPU should be checked. Here please contact VIPA!
## Technical Data

<table>
<thead>
<tr>
<th>Order number</th>
<th>VIPA 517-2NE02</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>CPU 517S/NET</td>
</tr>
<tr>
<td>Technical Data power supply</td>
<td></td>
</tr>
<tr>
<td>Power supply (rated value)</td>
<td>DC 24V</td>
</tr>
<tr>
<td>Power supply (permitted range)</td>
<td>DC 20.4...28.8V</td>
</tr>
<tr>
<td>Reverse polarity protection</td>
<td>yes</td>
</tr>
<tr>
<td>Current consumption (no-load operation)</td>
<td>360mA</td>
</tr>
<tr>
<td>Current consumption (rated value)</td>
<td>1.2A</td>
</tr>
<tr>
<td>Inrush current</td>
<td>5A</td>
</tr>
<tr>
<td>Load and working memory</td>
<td></td>
</tr>
<tr>
<td>Load memory, integrated</td>
<td>8MB</td>
</tr>
<tr>
<td>Load memory, maximum</td>
<td>8MB</td>
</tr>
<tr>
<td>Work memory, integrated</td>
<td>2MB</td>
</tr>
<tr>
<td>Work memory, maximum</td>
<td>8MB</td>
</tr>
<tr>
<td>Memory divided in 50% program / 50% data</td>
<td>yes</td>
</tr>
<tr>
<td>Memory Card Slot</td>
<td>MMC-Card with max. 1GB</td>
</tr>
<tr>
<td>Hardware configuration</td>
<td></td>
</tr>
<tr>
<td>Number of DP master integrated</td>
<td>1</td>
</tr>
<tr>
<td>CP 543 integrated</td>
<td>1</td>
</tr>
<tr>
<td>Status information, interrupts, diagnostics</td>
<td>yes</td>
</tr>
<tr>
<td>Status display</td>
<td>yes</td>
</tr>
<tr>
<td>Interrupts</td>
<td>no</td>
</tr>
<tr>
<td>Process interrupt</td>
<td>no</td>
</tr>
<tr>
<td>Diagnostic interrupt</td>
<td>no</td>
</tr>
<tr>
<td>Command processing times</td>
<td></td>
</tr>
<tr>
<td>Bit instructions, min.</td>
<td>0.01µs</td>
</tr>
<tr>
<td>Word instructions, min.</td>
<td>0.01µs</td>
</tr>
<tr>
<td>Double integer arithmetic, min.</td>
<td>0.01µs</td>
</tr>
<tr>
<td>Floating-point arithmetic, min.</td>
<td>0.06µs</td>
</tr>
<tr>
<td>Timer/Counter and retentive characteristic</td>
<td></td>
</tr>
<tr>
<td>Number of S7 counters</td>
<td>2048</td>
</tr>
<tr>
<td>Number of S7 timers</td>
<td>2048</td>
</tr>
<tr>
<td>Data range and retentive characteristic</td>
<td></td>
</tr>
<tr>
<td>Number of flags</td>
<td>16384Byte</td>
</tr>
<tr>
<td>Number of data blocks</td>
<td>8190</td>
</tr>
<tr>
<td>Max. data blocks size</td>
<td>64KB</td>
</tr>
<tr>
<td>Max. local data size per execution level</td>
<td>510Byte</td>
</tr>
<tr>
<td>Blocks</td>
<td></td>
</tr>
<tr>
<td>Number of OBs</td>
<td>24</td>
</tr>
<tr>
<td>Number of FBs</td>
<td>8191</td>
</tr>
<tr>
<td>Number of FCs</td>
<td>8191</td>
</tr>
<tr>
<td>Maximum nesting depth per priority class</td>
<td>8</td>
</tr>
<tr>
<td>Maximum nesting depth additional within an error OB</td>
<td>4</td>
</tr>
<tr>
<td>Time</td>
<td></td>
</tr>
<tr>
<td>Real-time clock buffered</td>
<td>yes</td>
</tr>
<tr>
<td>Clock buffered period (min.)</td>
<td>6 weeks</td>
</tr>
<tr>
<td>Accuracy (max. deviation per day)</td>
<td>10s</td>
</tr>
<tr>
<td>Number of operating hours counter</td>
<td>8</td>
</tr>
<tr>
<td>Clock synchronization</td>
<td>yes</td>
</tr>
<tr>
<td>Synchronization via MPI</td>
<td>MasterSlave</td>
</tr>
<tr>
<td>Synchronization via Ethernet (NTP)</td>
<td>Slave</td>
</tr>
<tr>
<td>Address areas (I/O)</td>
<td></td>
</tr>
<tr>
<td>Input I/O address area</td>
<td>8192Byte</td>
</tr>
<tr>
<td>Output I/O address area</td>
<td>8192Byte</td>
</tr>
<tr>
<td><strong>Order number</strong></td>
<td>VIPA 517-2NE02</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-------------------------</td>
</tr>
<tr>
<td><strong>Input processing image maximal</strong></td>
<td>8192Byte</td>
</tr>
<tr>
<td><strong>Output processing image maximal</strong></td>
<td>8192Byte</td>
</tr>
<tr>
<td><strong>Digital inputs</strong></td>
<td>65536</td>
</tr>
<tr>
<td><strong>Digital outputs</strong></td>
<td>65536</td>
</tr>
<tr>
<td><strong>Analog inputs</strong></td>
<td>4096</td>
</tr>
<tr>
<td><strong>Analog outputs</strong></td>
<td>4096</td>
</tr>
<tr>
<td><strong>Communication functions</strong></td>
<td></td>
</tr>
<tr>
<td><strong>PG/OP channel</strong></td>
<td>yes</td>
</tr>
<tr>
<td><strong>Global data communication</strong></td>
<td>yes</td>
</tr>
<tr>
<td><strong>Number of GD circuits, max.</strong></td>
<td>16</td>
</tr>
<tr>
<td><strong>Size of GD packets, max.</strong></td>
<td>54Byte</td>
</tr>
<tr>
<td><strong>S7 basis communication</strong></td>
<td>yes</td>
</tr>
<tr>
<td><strong>S7 basis communication, user data per job</strong></td>
<td>76Byte</td>
</tr>
<tr>
<td><strong>S7 communication</strong></td>
<td>yes</td>
</tr>
<tr>
<td><strong>S7 communication as server</strong></td>
<td>yes</td>
</tr>
<tr>
<td><strong>S7 communication, user data per job</strong></td>
<td>160Byte</td>
</tr>
<tr>
<td><strong>Number of connections, max.</strong></td>
<td>32</td>
</tr>
<tr>
<td><strong>Functionality Sub-D interfaces</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Type</strong></td>
<td>X2</td>
</tr>
<tr>
<td><strong>Type of interface</strong></td>
<td>RS485</td>
</tr>
<tr>
<td><strong>Connector</strong></td>
<td>SubD, 9-pin, female</td>
</tr>
<tr>
<td><strong>Electrically isolated</strong></td>
<td>yes</td>
</tr>
<tr>
<td><strong>MPI</strong></td>
<td>yes</td>
</tr>
<tr>
<td><strong>Type</strong></td>
<td>X3</td>
</tr>
<tr>
<td><strong>Type of interface</strong></td>
<td>RS485</td>
</tr>
<tr>
<td><strong>Connector</strong></td>
<td>SubD, 9-pin, female</td>
</tr>
<tr>
<td><strong>Electrically isolated</strong></td>
<td>yes</td>
</tr>
<tr>
<td><strong>DP master</strong></td>
<td>yes</td>
</tr>
<tr>
<td><strong>DP slave</strong></td>
<td>yes</td>
</tr>
<tr>
<td><strong>Functionality Profibus master</strong></td>
<td></td>
</tr>
<tr>
<td><strong>PG/OP channel</strong></td>
<td>yes</td>
</tr>
<tr>
<td><strong>Routing</strong></td>
<td>yes</td>
</tr>
<tr>
<td><strong>S7 basis communication</strong></td>
<td>yes</td>
</tr>
<tr>
<td><strong>S7 communication</strong></td>
<td>yes</td>
</tr>
<tr>
<td><strong>S7 communication as Server</strong></td>
<td>yes</td>
</tr>
<tr>
<td><strong>SYNC/FREEZE</strong></td>
<td>yes</td>
</tr>
<tr>
<td><strong>Activation/Deactivation of DP slaves</strong></td>
<td>yes</td>
</tr>
<tr>
<td><strong>DPV1</strong></td>
<td>yes</td>
</tr>
<tr>
<td><strong>Transmission speed, min.</strong></td>
<td>9.6kbit/s</td>
</tr>
<tr>
<td><strong>Transmission speed max.</strong></td>
<td>12Mbit/s</td>
</tr>
<tr>
<td><strong>Number of DP slaves, max.</strong></td>
<td>32</td>
</tr>
<tr>
<td><strong>Address range inputs, max.</strong></td>
<td>1KB</td>
</tr>
<tr>
<td><strong>Address range outputs, max.</strong></td>
<td>1KB</td>
</tr>
<tr>
<td><strong>User data inputs per slave, max.</strong></td>
<td>244Byte</td>
</tr>
<tr>
<td><strong>User data outputs per slave, max.</strong></td>
<td>244Byte</td>
</tr>
<tr>
<td><strong>Functionality Profibus slave</strong></td>
<td></td>
</tr>
<tr>
<td><strong>PG/OP channel</strong></td>
<td>yes</td>
</tr>
<tr>
<td><strong>Routing</strong></td>
<td>yes</td>
</tr>
<tr>
<td><strong>S7 communication</strong></td>
<td>yes</td>
</tr>
<tr>
<td><strong>S7 communication as Server</strong></td>
<td>yes</td>
</tr>
<tr>
<td><strong>DPV1</strong></td>
<td>yes</td>
</tr>
<tr>
<td><strong>Transmission speed min.</strong></td>
<td>9.6kbit/s</td>
</tr>
<tr>
<td><strong>Transmission speed max.</strong></td>
<td>12Mbit/s</td>
</tr>
<tr>
<td><strong>Transfer memory inputs, max.</strong></td>
<td>244Byte</td>
</tr>
<tr>
<td><strong>Transfer memory outputs, max.</strong></td>
<td>244Byte</td>
</tr>
<tr>
<td><strong>Address areas, max.</strong></td>
<td>32</td>
</tr>
<tr>
<td><strong>User data per address area, max.</strong></td>
<td>32Byte</td>
</tr>
</tbody>
</table>
## Order number
- VIPA 517-2NE02

## Functionality PCI interfaces
<table>
<thead>
<tr>
<th>Type</th>
<th>n/a</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type of interface</td>
<td>Ethernet 10/100Mbit</td>
</tr>
<tr>
<td>Connector</td>
<td>PCI bus</td>
</tr>
<tr>
<td>Electrically isolated</td>
<td>no</td>
</tr>
<tr>
<td>PG/OP channel</td>
<td>yes</td>
</tr>
</tbody>
</table>

## Functionality RJ45 interfaces
<table>
<thead>
<tr>
<th>Type</th>
<th>X4</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type of interface</td>
<td>Ethernet 10/100Mbit</td>
</tr>
<tr>
<td>Connector</td>
<td>RJ45</td>
</tr>
<tr>
<td>Electrically isolated</td>
<td>yes</td>
</tr>
<tr>
<td>PG/OP channel</td>
<td>yes</td>
</tr>
</tbody>
</table>

## Ethernet communication CP
- Number of productive connections, max.: 16
- Number of productive connections by Siemens NetPro, max.: 16
- S7 connections: USEND, URCV, BSEND, BRCV, GET, PUT, connection establishment active and passive
- User data per S7 connection, max.: 32
- TCP connections: SEND, RECEIVE, FETCH PASSIV, WRITE PASSIV, establishment active and passive
- User data per TCP connection, max.: 64KB
- ISO connection: SEND, RECEIVE, FETCH PASSIVE, WRITE PASSIVE, establishment active and passive
- User data per ISO connections, max.: 8KB
- ISO on TCP connections (RFC 1006): SEND, RECEIVE, FETCH PASSIVE, WRITE PASSIVE, establishment active and passive
- User data per ISO on TCP connections, max.: 32KB
- UDP connections: SEND and RECEIVE
- User data per UDP connections, max.: 2KB
- UDP-multicast-connections: SEND and RECEIVE (max. 16 multicast cycles)
- UDP-broadcast-connections: SEND

## Mechanical Data
- Dimensions (WxHxD): 40mm x 106mm x 174mm
- Weight: 290g
- Operating temperature: 0°C to 60°C
- Storage temperature: -25°C to 70°C
- Certification: UL508 certification in preparation
Chapter 3  Deployment CPU 517S/NET

Overview
Main topic of this chapter is the deployment of the CPU 517S/NET from VIPA. Here information necessary for installation, start-up and project engineering may be found.

<table>
<thead>
<tr>
<th>Content</th>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chapter 3</td>
<td>Deployment CPU 517S/NET</td>
<td>3-1</td>
</tr>
<tr>
<td>Overview</td>
<td></td>
<td>3-2</td>
</tr>
<tr>
<td>Assembly</td>
<td></td>
<td>3-3</td>
</tr>
<tr>
<td>Installation of the driver</td>
<td></td>
<td>3-4</td>
</tr>
<tr>
<td>Guidelines for IP address assignment</td>
<td></td>
<td>3-5</td>
</tr>
<tr>
<td>Connect power supply</td>
<td></td>
<td>3-8</td>
</tr>
<tr>
<td>Initialization of the CPU component</td>
<td></td>
<td>3-10</td>
</tr>
<tr>
<td>Internal access to PG/OP channel</td>
<td></td>
<td>3-14</td>
</tr>
<tr>
<td>External access to PG/OP channel via routing</td>
<td></td>
<td>3-15</td>
</tr>
<tr>
<td>Access to the integrated web page</td>
<td></td>
<td>3-18</td>
</tr>
<tr>
<td>Project engineering</td>
<td></td>
<td>3-20</td>
</tr>
<tr>
<td>CPU parameterization</td>
<td></td>
<td>3-24</td>
</tr>
<tr>
<td>Project transfer</td>
<td></td>
<td>3-35</td>
</tr>
<tr>
<td>Operating modes</td>
<td></td>
<td>3-40</td>
</tr>
<tr>
<td>Overall reset</td>
<td></td>
<td>3-43</td>
</tr>
<tr>
<td>Firmware update</td>
<td></td>
<td>3-45</td>
</tr>
<tr>
<td>Factory reset</td>
<td></td>
<td>3-48</td>
</tr>
<tr>
<td>Memory expansion with MCC</td>
<td></td>
<td>3-49</td>
</tr>
<tr>
<td>Extended know-how protection</td>
<td></td>
<td>3-50</td>
</tr>
<tr>
<td>MMC-Cmd - Auto commands</td>
<td></td>
<td>3-52</td>
</tr>
<tr>
<td>VIPA specific diagnostic entries</td>
<td></td>
<td>3-54</td>
</tr>
<tr>
<td>Using test functions for control and monitoring of variables</td>
<td></td>
<td>3-58</td>
</tr>
</tbody>
</table>
Overview

Functionality

**Ethernet (LAN)**

The CPU 51xS PC plug-in card consists of an *Ethernet* (LAN) and a *CPU* component. These communicate internally over an Ethernet connection. For this both components are each assigned to an IP address, which may differ only in the Host-ID. In this way several CPU 51xS may be operated in your PC.

The CPU component of the CPU 51xS slot card can only be operated with an external or internal DC 24V power supply. The external supply enables the operation of the card outside of a PC res. independent from the PC operation. Please consider for operation that the slot card is connected to ground via its metal cover.

**CPU component**

The assignment of IP address parameters for the Ethernet component is made by the Windows operating system by the *Network environment*

The CPU component receives its IP address parameters by the Siemens SIMATIC manager by means of the *PLC functions* or a *minimal project*.

The addresses are not affected by an *overall reset*. The IP address parameters of the CPU component are deleted by a *factory reset*.

IP address parameter assignment

Steps of installation

- Install the CPU 51xS PC slot card at a free 32bit PCI slot (PCI version 2.2, 32bit data/address bus, 3.3V current).
- Switch PC on.
- Install driver for the Ethernet component. This can be found at the "ToolDemo-CD" SW900TOLA at driver/slotplc the according CPU 51xS.
- Set IP address and subnet mask for the Ethernet component of the slot card by means of *Properties* of the *Network environment*. Here the IP addresses may only differ in the Host-ID.
- Supply CPU component with DC 24V.
- Assign IP address parameters to the CPU component by means of Siemens SIMATIC manager. There are the following possibilities for assigning IP address parameters (Initialization):
  - PLC functions with *Edith Ethernet Node* (search PLC and assign IP address)
  - Hardware project engineering with CP (Minimal project)

If the "Net" components are installed at your Siemens SIMATIC manager the CPU 51xS is displayed as **Intel(R) 8255xER PCI Adapter** at the *PG/PC interface* area. The CPU can online be accessed by the PG/OP channel.

The steps are detailed described at the following pages.
Assembly

- Eliminate possibly existing static loading, before mounting the VIPA PCI card, by affecting a grounded metal object.
- Switch your computer off and remove the power cable.
- Remove the covers from your computer according to the manufacturers instructions.
- Search a free 32bit PCI slot (usually white ore beige). Please regard that your PCI bus corresponds to the following specification: PCI version 2.2, 32Bit data/address bus, 3.3V voltage.
- Remove one of the metal covers from a slot. Also with the CPU 517S/NET 1 PCI slot is used. Here an additional slot cover is to be removed at the right side.
- Insert the slot card, bolt the slot card with the computer case and close the covers of your computer.

Please consider that the metal cover of the slot card is always connected to ground and bolted with the computer case!

Note!
The installation should only be accomplished by experienced technical personnel!
Slot card or PC may be damaged by an incorrect installation.

[1] Screw
[2] Metal slot cover
[3] Metal slot cover, to be additionally removed for CPU 517S/NET
Installation of the driver

Overview

A driver is necessary for the integration of the slot card into the operating system. The slot card driver may be found at the enclosed CD SW900TOLA. For start-up the power supply of the CPU component is not for the time being necessary.

Start-up without external CPU power supply

- Turn the PC on after mounting the slot card. The slot card is recognized as a new network hardware after run-up of the PC and the appropriate driver is requested. The driver can be found on the enclosed "ToolDemo CD" SW900TOLA.
- Put in the CD and navigate via driver/slotplc to the directory from the according PLC 51xS. Here the slot card driver for each relevant operating system may be found.
- Install the slot card driver.

The CPU 51xS slot card is now specified to the operating system and is listed as an additional LAN connection with the device name "Intel(R) 8255 PCI adapters". As long as the CPU component is not supplied with DC 24V the message appears "The network cable was removed".

Assign IP address parameters to the Ethernet component

After installation of the driver IP address and Subnet mask can be assigned by the properties of the network environment at any time. Attention should be paid that the IP address of the CPU and Ethernet component differs exclusively in the Host-ID.

Note!

More information about assigning IP addresses may be found at "Guidelines for IP address assignment" at the following pages. Please consider the guidelines, since incorrect adjusted IP address parameters may have effects on the whole firm net.
Guidelines for IP address assignment

Overview

The CPU 51xS slot card consists of a CPU and a Ethernet component that communicate via a TCP-based point-to-point connection. To enable this, CPU and Ethernet component each have an alterable IP address that may only differ in the Host-ID.

For start-up and for further comprehension, a thorough knowledge of Net-ID, Host-ID and Subnet-ID are assumed. In the following detailed information about this can be found.

If you want to install several CPU 51xS in one PC, every CPU 51xS plug-in card needs an own Net-ID.

The following text describes the approach for the assignment of IP addresses together with Net-ID and Host-ID.

Net-ID

Every IP address is a combination of a Net-ID and a Host-ID.

The Network-ID identifies a network res. a network controller that administrates the network.

The Host-ID marks the network connections of a participant (host) to this network.

Note!

Never choose an IP address with Host-ID=0 or Host-ID=maximum!
(e.g. for class B with Subnet Mask = 255.255.0.0, the "172.16.0.0" is reserved and the "172.16.255.255" is occupied as local broadcast address for this network.)
Subnet-Mask

The Host-ID can be further divided into a Subnet-ID and a new Host-ID by using an bit for bit AND assignment with the Subnet-Mask.

The area of the original Host-ID that is overwritten by 1 of the Subnet-Mask becomes the Subnet-ID, the rest is the new Host-ID.

<table>
<thead>
<tr>
<th>Subnet-Mask</th>
<th>binary all &quot;1&quot;</th>
<th>binary all &quot;0&quot;</th>
</tr>
</thead>
<tbody>
<tr>
<td>IPv4 address</td>
<td>Net-ID</td>
<td>Host-ID</td>
</tr>
<tr>
<td>Subnet-Mask and IPv4 address</td>
<td>Net-ID</td>
<td>Subnet-ID</td>
</tr>
</tbody>
</table>

A TCP-based communication via point-to-point, hub or switch connection is only possible between stations with identical Network-ID and Subnet-ID! Different area must be connected with a router.

The Subnet-Mask allows you to sort the resources after your needs. This means e.g. that every department gets an own subnet and thus does not interfere another department.

Address classes

For IPv4 addresses there are five address formats (class A to class E) that are all of a length of 4byte = 32bit.

<table>
<thead>
<tr>
<th>Class</th>
<th>Network-ID</th>
<th>Host-ID</th>
</tr>
</thead>
<tbody>
<tr>
<td>Class A</td>
<td>0 Network-ID (1+7 bit)</td>
<td>Host-ID (24 bit)</td>
</tr>
<tr>
<td>Class B</td>
<td>10 Network-ID (2+14 bit)</td>
<td>Host-ID (16 bit)</td>
</tr>
<tr>
<td>Class C</td>
<td>110 Network-ID (3+21 bit)</td>
<td>Host-ID (8 bit)</td>
</tr>
<tr>
<td>Class D</td>
<td>1110 Multicast group</td>
<td></td>
</tr>
<tr>
<td>Class E</td>
<td>11110 Reserved</td>
<td></td>
</tr>
</tbody>
</table>

The classes A, B and C are used for individual addresses, class D for multicast addresses and class E is reserved for special purposes.

The address formats of the classes A, B, C are only differing in the length of Network-ID and Host-ID.

Private IP networks

To build up private IP-Networks within the internet, RFC1597/1918 reserves the following address areas:

<table>
<thead>
<tr>
<th>Network class</th>
<th>Start IP</th>
<th>End IP</th>
<th>Standard Subnet Mask</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>10.0.0.0</td>
<td>10.255.255.255</td>
<td>255.0.0.0</td>
</tr>
<tr>
<td>B</td>
<td>172.16.0.0</td>
<td>172.31.255.255</td>
<td>255.255.0.0</td>
</tr>
<tr>
<td>C</td>
<td>192.168.0.0</td>
<td>192.168.255.255</td>
<td>255.255.255.0</td>
</tr>
</tbody>
</table>

(The Host-ID is underlined.)

These addresses can be used as net-ID by several organizations without causing conflicts, for these IP addresses are neither assigned in the internet nor are routed in the internet.

Reserved Host-Ids

Some Host-IDs are reserved for special purposes.

<table>
<thead>
<tr>
<th>Host-ID</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Identifier of this network, reserved!</td>
</tr>
<tr>
<td>Maximum (binary complete 1)</td>
<td>Broadcast address of this network</td>
</tr>
</tbody>
</table>
In common, your complete network consists of a PC with (at least) one network card and one or more CPU 51xS plug-in cards that are also each listed as network card with the CPU as single participant:

In this example for Ethernet and CPU component IP addresses from private class C net were selected. Using the Subnet mask 255.255.255.0 256 different networks with 254 host addresses each are available.

<table>
<thead>
<tr>
<th>CPU 51xS</th>
<th>LAN with recomm. IP/Mask</th>
<th>192.168.201.2 / 255.255.255.0</th>
</tr>
</thead>
<tbody>
<tr>
<td>CPU with example IP/Mask</td>
<td>192.168.201.3 / 255.255.255.0</td>
<td></td>
</tr>
</tbody>
</table>

Host-ID (chosen from 1...254)
Net-ID Class C private area
(3rd Byte freely chosen)

To enable the PC to connect the CPU 51xS plug-in cards and the subordinated CPUs without using a router table, you have to assign an individual Net-ID for every card!

<table>
<thead>
<tr>
<th>PC</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Network card</strong> (IP/Mask from DHCP-Server)</td>
</tr>
<tr>
<td>e.g. 192.168.1.2 / 255.255.255.0</td>
</tr>
</tbody>
</table>

1. **CPU 51xS**
   | LAN with example IP/Mask | 192.168.201.2 / 255.255.255.0 |
   | CPU with example IP/Mask  | 192.168.201.3 / 255.255.255.0 |

2. **CPU 51xS**
   | LAN with example IP/Mask | 192.168.202.2 / 255.255.255.0 |
   | CPU with example IP/Mask  | 192.168.202.3 / 255.255.255.0 |

3. **CPU 51xS**
   | LAN with example IP/Mask | 192.168.203.2 / 255.255.255.0 |
   | CPU with example IP/Mask  | 192.168.203.3 / 255.255.255.0 |
Connect power supply

After the CPU 51xS slot card is installed in the PC and the communication between PC and Ethernet component is established the DC 24V power supply may be attached.

The CPU component of the CPU 51xS slot card can only be operated with an external or internal DC 24V power supply. The external supply enables the operation of the card outside of a PC res. independent from the PC operation. Please consider for operation that the slot card is connected to ground via its metal cover.

Note!
The CPU 51xS is to supply either externally or internally with DC 24V. Simultaneous infeed should absolutely be avoided!

External power supply

For external power supply there is a plug on slot panel with the following pin assignment:

For the cabling of power supply of a CPU, a green plug with CageClamp technology is deployed.

The connection clamp is realized as plug that may be clipped off carefully if it is still wired.

Here wires with a cross-section of 0.08mm² to 2.5mm² may be connected. You can use flexible wires without end cases as well as stiff wires.

The picture on the left side shows the cabling step by step from top view.

- For cabling you push the locking vertical to the inside with a suiting screwdriver and hold the screwdriver in this position.
- Insert the insulation striped wire into the round opening. You may use wires with a cross-section from 0.08mm² to 2.5mm².
- By removing the screwdriver the wire is connected safely with the plug connector via a spring.
**Internal power supply**

For the internal power DC 24V supply there is a clamp on the top of the slot card.

Please consider when connecting a DC 24V power supply that the internal power supply hardware conditionally does not have an EMC filter for protection against disturbances (like e.g. EN 61000-4-4 [Burst], EN 61000-4-5 [Surge] or EN 61000-4-6 [conducted disturbance variable, inducted by HF fields]).

Here please use an accordingly filtered supply voltage here.

The clamp has the following pin assignment:
Initialization of the CPU component

Overview

The CPU 51xS slot card consists of a CPU and an Ethernet component. For communication both components own an IP address, which may differ only in the Host-ID. For online access to the CPU component valid IP address parameters have to be assigned to this by means of the Siemens SIMATIC manager. This is called "initialization".

The initialization of the Ethernet component takes place by the properties of the network environment of your operating system, as described above.

Possibilities for Initialization

There are the following possibilities for assignment of IP address parameters:

- PLC functions with Edith Ethernet Node (projecting tool and slot card in the same PC)
- Hardware project engineering with CP (Minimal project)

Requirements

For the hardware configuration the following software is necessary:

- Siemens SIMATIC manager V. 5.1 and SIMATIC NET or Siemens SIMATIC manager V. 5.2 and SP1
The initialization by PLC function can only be established if Siemens SIMATIC manager and CPU 51xS slot card are at the same PC. The initialization takes place after the following proceeding:

- Start the Siemens SIMATIC manager.
- Set via Options > Set PG/PC Interface the Access Path to "Intel(R) 8255xER".
- Open with PLC > Edit Ethernet Node the dialog window for "initialization" of a station.
- Use the [Browse] button to determine the CPU components via MAC address.

![Edit Ethernet Node dialog window]

- Choose the determined module and click to [OK].
- Set the IP configuration by entering IP address, subnet mask and net transition. In addition an IP address may be received from a DHCP server. For this depending upon the selected option the MAC address, device name or the Client ID which can be entered here is to be conveyed to the DHCP server. The Client-ID is a character sequence from maximally 63 characters. Here the following indications may be used: Dash "-", 0-9, A-z, A-Z
- Confirm your settings by button [Assign IP Configuration]

Direct after the assignment the CPU component may be reached by the Siemens SIMATIC manager by means of these IP address parameters.
Initialization via minimal project

If the CPU 51xS slot card and the Siemens SIMATIC manager are not at the same PC, the CPU component may get its IP address parameters from a minimal project for CPU with CP.

The Project may be transferred to the CPU 51xS slot card by MPI or by means of a MMC memory card.

The initialization by means of a minimal project takes place after the following proceeding:

- Start the Siemens SIMATIC manager and create a new project.
- Add a new System 300 station via Insert > Station > SIMATIC 300-Station.
- Activate the station "SIMATIC 300" and open the hardware configurator by clicking on "Hardware".
- Engineer a rack (SIMATIC 300 \ Rack-300 \ Profile rail).
- For the SPEED7-CPUs are configured as CPU 318-2, choose the CPU 318-2 with the order no. 6ES7 318-2AJ00-0AB0 V3.0 from the hardware catalog. You'll find this at SIMATIC 300 \ CPU 300 \ CPU 318-2.
- Project engineering Ethernet PG/OP channel as CP 343-1 (343-1EX11).
- Project engineering and networking Ethernet-CP 343 and DP master as CP 343-1 (343-1EX11) respectively CP 342-5 (342-5DA02 V5.0).
• Type the wanted IP address and subnet mask into the dialog window and connect the CP with "Ethernet".

![Image of IP address type window]

• Save and compile your project.
• Transfer your project via MPI or MMC into your CPU.

**Project transfer**

There are 2 possibilities for the transfer of your project into the CPU:
• Transfer via MPI
• Transfer via storage card at deployment of a card reader

**Transfer via MPI**

• Change to the Siemens SIMATIC manager.
• Choose **Options > Set PG/PC interface**
  → A dialog window opens where you may configure the MPI interface you want to use.
• Choose the "PC Adapter (MPI)" from the selection list; where appropriate you have to add this first. Click on [Properties].
• Select the wanted COM port in the register "Local Port" and set the transfer rate 38400bit/s.
• Connect your PC via MPI with your CPU and transfer your project.

**Transfer via MMC**

As external storage medium a MMC (Memory Card) is employed. The MMC is available at VIPA preformatted with the FAT16 PC file system.
• Create a new wld file via **File > Memory Card file > New** and use the mouse to drag the system data case into the window of the wld file.
• Copy the wld file with the help of a reading device to the MMC and rename the file to S7PROG.WLD.
• Insert the MMC in your CPU and execute an overall reset. This causes a transfer of the data from the MMC into the battery-buffered RAM of the CPU.

**Note!**

More information about transfer methods may be found in the chapter "Project transfer".
Internal access to PG/OP channel

Overview

Every CPU 51xS has an integrated Ethernet-PG/OP channel. Only in installed condition you have access via the PG/OP channel to your CPU. Here you may program, remote control or show the integrated web page. There are maximum 4 channels.

Access to PG/OP channel

If the conditions for communication are fulfilled, the slot card may be accesses by the PG/PC interface as "Intel(R) 8255xER" for project transfer and diagnostics.

Requirements

- CPU 51xS slot card and Siemens SIMATIC manager are installed at the same PC.
- Ethernet and CPU component are assigned each to one IP address that may only differ in the Host-ID.
- Siemens SIMATIC manager starting with version V. 5.1 and SIMATIC NET respectively V. 5.2 and SP1 are installed for hardware configuration.

Approach

- Start the Siemens SIMATIC manager.
- Set Options > PG/PC Interface... to: "Intel(R) 8255xER"

The PG/OP channel may online be accessed, now.
External access to PG/OP channel via routing

Overview

You may access the CPU 51xS from an external PC via Ethernet. The following preconditions must be fulfilled:

- The routing is activated on the PC with the CPU 51xS
- The route is entered at the CPU 51xS via a CP343 hardware configuration with the following parameters:
  - Destination router: IP address of the Ethernet component IP_{Eth} of the CPU 51xS
- The route is entered at the external PC with the following parameters:
  - Destination-IP: Net-ID of the Ethernet component of the CPU 51xS
  - IP-Mask: subnet mask of the CPU 51xS (default: 255.255.255.0)
  - Gateway: IP address of the PCs IP_{PC} with the CPU 51xS at the home network

Attention!

Only a trained system administrator should execute changes at the network neighborhood for this may cause conflicts with the company network!

The employment with Windows 9x res. Windows XP Home is not recommended and not described.
Activate routing

The following text describes the steps of configuration. More detailed information especially to the operating system specific routing is to find in the documentation of the operating system.


The activation of the routing happens in the "Network neighborhood properties" at the properties of the TCP/IP protocol.

Activation at Windows XPProfessional / 2000Professional

For the activation, an entry into the registry file is required like illustrated below:

![Registry Editor](image)

After a reboot, the routing is active.

Enter route

The entry of a route happens exclusively via the command console of the operating system by using the "route" command. The following parameters are required:

route ADD <Destination-IP> MASK <IP-Mask> <Gateway> METRIC <Metric> IF <IF>

with

ADD: Command for adding a route

Dest.-IP: IP address of the network (Net-ID) of the CPU 51xS
IP-Mask: Subnet mask of the net of the CPU 51xS
Gateway: IP address of the destination computer at the home network with the plugged CPU 51xS
Metric: (optional) Price value for a destination
IF: (optional) Preset interface or best alternate interface

route PRINT lists all entered routes
route DELETE <Destination-IP> deletes the entry
Example: The following constellation is present and you want to access the CPU via PC:

- Activate the routing at PC1 like described above.
- Start the hardware configurator from Siemens and configure a system with CP 343.
- Enter the IP address 192.168.201.5 and the subnet mask 255.255.255.0 in "Properties Ethernet interface".
- Choose the function "Use router" at "Parameter", enter the IP address 192.168.201.3 of the Ethernet part of the CPU 51xS as "Gateway" and transfer your project.
- Start the command console at PC2 and enter the following statement:
  ```
  route add 192.168.201.0 mask 255.255.255.0 172.16.128.15
  ```

Now you may access the CPU from PC2 via PC1. You may test the connection with the command `ping 192.168.201.5`.
Access to the integrated web page

**Access to the web page**

The PG/OP channel provides a web page that you may access via an internet browser. The web page contains information about firmware versions, current cycle times etc.

The current content of the web page is stored on MMC by means of the MMC-Cmd WEBPAGE. More information may be found at "MMC-Cmd - Auto commands".

**Requirements**

A PG/OP channel should be established between PC with Internet browser and CPU 51xS slot card. This may be tested by *Ping* to the IP address of the CPU component.

**Web page**

The access takes place via the IP address of the CPU component. The web page only serves for information output. The monitored values are not alterable.

**CPU WITH ETHERNET-PG/OP**

**Slot 100**

VIPA 517-4NE02 V3.5.1.4 Px000118.pkg, SERIALNUMBER 18525

- **Order no., firmware version, package, serial no.**
- **Information for support:**
  - **SUPPORTDATA :**
    - PRODUCT V3514, HARDWARE V0110, 5448D-V10, Hx000062.100, Bx000227 V6514, Ax000086 V1200, fx000007.wld V1140, FlashFileSystem : V102
  - **Memorysizes (Bytes):**
    - LoadMem : 8388608,
    - WorkMemCode : 1048576,
    - WorkMemData : 1048576
  - **OnBoardEthernet:**
    - MacAddress : 0020d577485D,
    - IP-Address : 192.168.201.3,
    - SubnetMask : 255.255.255.0,
    - Gateway : 192.168.201.2
  - **Cpu state :** Stop
  - **FunctionRS485 X2/COM1:** MPI
  - **FunctionRS485 X3/COM2:** DPM-async
  - **Cycletime [microseconds] :**
    - min=381 cur=503 ave=499 max=550
  - **ArmLoad [percent] :** cur=0, max=51
  - **PowerCycleHxRetries :** 19, 0, 0, 0, 0

**Ethernet PG/OP: Addresses**

- **CPU status**
  - **RS485 function**
  - **CPU cycle time:**
    - min= minimal
    - cur= current
    - max= maximal

*continued ...*
... continue

**Slot 201**

VIPA 542-1DP00 V3.2.6 Px000119.pkg
SUPPORTDATA : PRODUCT V3260,
BB000554 V5260, AB000120 V4170,
ModuleType CB2C0010
Cycletime [microseconds] :
min=65535000 cur=0 ave=0 max=0 cnt=0

**Slot 206**

VIPA 543-1EX71 V2.5.9 Px000059.pkg
SUPPORTDATA : Bb000165 V2590,
AB000075 V1000, PRODUCT V2590,
Hx000019 V1000,
ModuleType ACDB0000
Address Input 1024...1039
Address Output 1024...1039

BaudRate Read Model, BaudRate Write Model

Additional CPU components:
Slot 201 (DP master):
Name, firmware version, package
Information for support:

Slot 206 (CP 543):
Name, firmware version, package
Information for support:

Standard Bus
Information for support:
Project engineering

Overview
The project engineering of CPU and DP master takes place in the Siemens SIMATIC manager. The CPU 51xS slot card may online be accessed for parameterization by PLC functions via Ethernet respectively MPI/Profibus. In addition, the project may be transferred by a MMC memory card to the PC slot card. On delivery the CPU 51xS slot card has the MPI address 2.

Preconditions
For the hardware configuration of the CPU and the project engineering of the integrated Profibus DP master of the CPU, the following preconditions must be met:
• Siemens SIMATIC manager starting with version V. 5.1 and SIMATIC NET respectively V. 5.2 and SP1 are installed for hardware configuration.
• A communication connection to the slot card is established
• At usage of Profibus DP slaves of the Systems 100V, 200V and 300V from VIPA: GSD files are included in the hardware configurator.
For the project engineering of the CPU and the Profibus DP master, a thorough knowledge of the SIMATIC manager and the hardware configurator from Siemens are assumed!

Install hardware configurator from Siemens
The hardware configurator is part of the Siemens SIMATIC manager. It serves the project engineering. The modules that you may configure here are to find in the hardware catalog.
For the deployment of Profibus slaves of the Systems 100V, 200V and 300V from VIPA, the import of the modules to the hardware catalog via the GSD-files from VIPA is necessary.
The project engineering of the CPU 51xS takes place at the Siemens hardware configurator and is divided into the following parts:

- Project engineering as CPU 318-2 (318-2AJ00-0AB00 V3.0)
- Project engineering Ethernet PG/OP channel as CP 343-1 (343-1EX11)
- Project engineering internal CP 543 as CP 343-1 (343-1EX11).
- Project engineering CPU 51xS as DP slaves in a virtual DP master CP 342-5 (342-5DA02 V5.0).

To be compatible with the Siemens SIMATIC manager the following steps should be executed:

- Start the hardware configurator from Siemens.
- Configure the Siemens CPU 318-2 (6ES7 318-2AJ00-0AB0/V3.0). Configure the internal DP master of your CPU via the internal DP master of the CPU 318-2. Leave MPI/DP of the CPU 318-2 in MPI mode. The Profibus mode is not supported.
- For the internal Ethernet PG/OP channel you have to configure a Siemens CP 343-1 (343-1EX11).
- Configure the integrated CP 543 of the CPU 517/NET always as 2. CP after the placed Ethernet PG/OP channel as Siemens CP343-1 (343-1EX11).
- Configure as last module the Siemens DP master 342-5 (342-5DA02 V5.0). Link the DP master and switch it to DP master operating mode.
- To this master system you assign the CPU via a "VIPA_SPEEDBUS" slave. Here the Profibus address corresponds to the slot no. Beginning with 100 for the CPU. Place at slot 0 of every slave the assigned module and alter the parameters if needed.

In the following these steps are more described.

**Note!**

More concerning the project engineering of the integrated CP 543 may be found at the chapter "Deployment Ethernet".
The CPU 51xS has to be configured analog to a CPU 318-2 from Siemens with Profibus DP master and a plugged Ethernet-CP CP343-1.

- Start the hardware configurator and create a new project System 300.
- Add a profile rail from the hardware catalog.
- You reach the CPU with Profibus master in the hardware catalog at: Simatic300/CPU-300/CPU318-2DP/6ES7 318-2AJ00-0AB0
- Insert the CPU 318-2DP (6ES7 318-2AJ00-0AB0/V3.0).
- Enter a Profibus address for the master (e.g. 2)
- Click on DP and set the operating mode “DP Master” in the Object properties. Confirm the settings by [OK].

Configure representatively for the CPU component a CP 343-1. This may be found in the hardware catalog at: Simatic300/CP-300/Industrial Ethernet.

- Add the CP 343-1 (343-1EX11-0XE0) at slot 4.
- Click on the CP and enter the according IP address and subnet mask at Object properties. Enter the IP address parameters favored or assigned at initialization.

Please note that the IP address may differ exclusively in the host ID from the IP address of the Ethernet component. The CPU component of the CPU 51xS slot card may be accessed by this address by means of the PLC functions.
Configure DP master system

For the project engineering of the DP master system, you have to execute the following steps:

- Right click on DP and choose "Add Master System ".
- Create a new Profibus subnet with NEW. This subnet allows you to configure your Profibus slave modules.

Include DP slaves

- For the project engineering of Profibus-DP slaves, choose the according Profibus-DP slave from the hardware catalog and move it to the subnet of your master.
- Assign a valid Profibus address to the DP slave.
- Include the modules of the DP slave system in plugged sequence and assign valid addresses to the modules.
- Parameterize the modules if needed.

The following illustration shows the project engineering. Additionally the picture includes a VIPA Profibus-DP slave as example:

<table>
<thead>
<tr>
<th>Slot</th>
<th>Module</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>CPU 318-2</td>
</tr>
<tr>
<td>3</td>
<td>X1</td>
</tr>
<tr>
<td>4</td>
<td>X2</td>
</tr>
<tr>
<td>5</td>
<td>CP 343-1</td>
</tr>
<tr>
<td>6</td>
<td></td>
</tr>
<tr>
<td>...</td>
<td></td>
</tr>
</tbody>
</table>

The CPU 51xS slot card may online be accessed for parameterization by PLC functions via Ethernet respectively MPI/Profibus.

In addition, the project may be transferred by a MMC memory card to the PC slot card.

More information about transferring a project can be found at "Project transfer" below.

During start-up the Profibus project is forwarded to the Profibus master.

Transfer project
CPU parameterization

Overview

Except of the VIPA specific CPU parameters the CPU parameterization takes place in the parameter dialog of the CPU 318-2DP.

The VIPA specific CPU parameters like the RS485 interface behavior and the synchronization between CPU and DP master can be configured in the SPEED-Bus CPU parameter dialog.

Parameterization via Siemens CPU 318-2DP

For the SPEED7-CPU are configured in the hardware configurator from Siemens as Siemens CPU 318-2DP you may adjust the parameters for the SPEED7 CPUs at the hardware configuration at "Properties" of the CPU 318-2DP.

Via a double-click on the CPU 318-2DP the parameter window of the CPU can be archived. Using the registers you get access to all parameters of the CPU.

Setting IP address and subnet mask of the CPU

IP address and subnet mask are entered via the properties of the integrated CP 343-1.
The CPU does not evaluate each parameter, which may be set at the hardware configuration. The following parameters are supported by the CPU at this time:

<table>
<thead>
<tr>
<th><strong>Supported parameters</strong></th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>General</strong></td>
<td></td>
</tr>
<tr>
<td>Short description</td>
<td>Since every CPU 51xS from VIPA is configured as CPU 318-2AJ00 from Siemens, here the short description CPU 318-2 stands.</td>
</tr>
<tr>
<td>Order No. / Firmware</td>
<td>Order number and firmware are identical to the details in the &quot;hardware catalog&quot; window.</td>
</tr>
<tr>
<td>Name</td>
<td>The Name field provides the short description of the CPU. If you change the name the new name appears in the Siemens SIMATIC manager.</td>
</tr>
<tr>
<td>Plant designation</td>
<td>Here is the possibility to specify a plant designation for the CPU. This plant designation identifies parts of the plant according to their function. This has a hierarchical structure and confirms to IEC 1346-1.</td>
</tr>
<tr>
<td>Comment</td>
<td>In this field information about the module may be entered.</td>
</tr>
<tr>
<td><strong>Startup</strong></td>
<td></td>
</tr>
<tr>
<td>Startup when expected/actual configuration differs</td>
<td>If the checkbox for &quot;Startup when expected/actual configuration differ&quot; is deselected and at least one module is not located at its configured slot or if another type of module is inserted there instead, then the CPU switches to STOP mode. If the checkbox for &quot;Startup when expected/actual configuration differ&quot; is selected, then the CPU starts even if there are modules not located in their configured slots of if another type of module is inserted there instead, such as during an initial system start-up.</td>
</tr>
<tr>
<td>Monitoring time for ready message by modules [100ms]</td>
<td>This operation specifies the maximum time for the ready message of every configured module after PowerON. If the modules do not send a ready message to the CPU by the time the monitoring time has expired, the actual configuration becomes unequal to the preset configuration.</td>
</tr>
<tr>
<td>Monitoring time for transfer of parameters to modules [100ms]</td>
<td>The maximum time for the transfer of parameters to parameterizable modules. If not every module has been assigned parameters by the time this monitoring time has expired; the actual configuration becomes unequal to the preset configuration.</td>
</tr>
</tbody>
</table>
Activate the checkbox for cyclic updates of the OB1 process image. Updating increases the cycle time.

Here the scan cycle monitoring time in milliseconds may be set. If the scan cycle time exceeds the scan cycle monitoring time, the CPU enters the STOP mode. Possible reasons for exceeding the time are:

- Communication processes
- A series of interrupt events
- An error in the CPU program

The minimum scan cycle time specifies the time interval, in which the CPU program is called. If the scan cycle time is less than the specified minimum scan cycle time, the CPU waits until the minimum scan cycle time is reached.

Using this parameter you can control the duration of communication processes, which always extend the scan cycle time so it does not exceed a specified length. If there are no additional asynchronous events, the scan cycle time of OB1 is increased by following factor:

\[
\frac{100}{100 - \text{cycle load from communication} \%}
\]

If the cycle load from communication is set to 50%, the scan cycle time of OB 1 can be doubled. At the same time, the scan cycle time of OB 1 is still being influenced by asynchronous events (e.g. process interrupts) as well.

Here the size of the process image max. 2048 for the input/output periphery may be fixed.

The preset reaction of the CPU may be changed to an I/O access error that occurs during the update of the process image by the system. Each CPU 51xS from VIPA is preset such that OB 85 is not called if an I/O access error occurs and no entry is made in the diagnostic buffer either.

Activate the check box if you want to use clock memory and enter the number of the memory byte.

Note!

The selected memory byte cannot be used for temporary data storage.
**Retentive Memory**

- **Number of Memory Bytes from MB0**
  Enter the number of retentive memory bytes from memory byte 0 onwards.

- **Number of S7 Timers from T0**
  Enter the number of retentive S7 timers from T0 onwards.

- **Number of S7 Counters from C0**
  Enter the number of retentive S7 counters from C0 onwards.

- **Areas**
  Since with every VIPA CPU 51xS each data block is remanent stored, the settings at *Areas* are non-relevant and they are ignored.

**Memory**

- **Local data (priority classes)**
  In these fields you may define the number of local data (temporary data) for the priority classes 1 to 29.

**Interrupts**

- **Priority**
  Here the priorities may be specified according to which the hardware interrupt OBs are processed (hardware interrupt, time-delay interrupt, async. error interrupts). *Interrupts for DPV1* are not supported.
  With priority "0" the corresponding OB is deactivated. Please regard that this is not supported by each OB.

**Time-of-day interrupts**

- **Priority**
  Here the priorities may be specified according to which the time-of-day interrupt is processed.
  With priority "0" the corresponding OB is deactivated.

- **Active**
  Activate the check box of the time-of-day interrupt OBs if these are to be automatically started on complete restart.

- **Execution**
  Select how often the interrupts are to be triggered. Intervals ranging from every minute to yearly are available. The intervals apply to the settings made for *start date* and *time*.

- **Start date / time**
  Enter date and time of the first execution of the time-of-day interrupt.

- **Process image partition**
  This is not supported.
### Cyclic interrupts

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Priority</td>
<td>Here the priorities may be specified according to which the corresponding cyclic interrupt is processed. With priority &quot;0&quot; the corresponding interrupt is deactivated.</td>
</tr>
<tr>
<td>Execution</td>
<td>Enter the time intervals in ms, in which the watchdog interrupt OBs should be processed. The start time for the clock is when the operating mode switch is moved from STOP to RUN.</td>
</tr>
<tr>
<td>Phase offset</td>
<td>Enter the delay time in ms for current execution for the watchdog interrupt. This should be performed if several watchdog interrupts are enabled. Phase offset allows to distribute processing time for watchdog interrupts across the cycle.</td>
</tr>
<tr>
<td>Process image partition</td>
<td>Is not supported.</td>
</tr>
</tbody>
</table>

### Diagnostics/Clock

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Report cause of STOP</td>
<td>Activate this parameter, if the CPU should report the cause of STOP to PG respectively OP on transition to STOP.</td>
</tr>
<tr>
<td>Number of messages in the diagnostics buffer</td>
<td>Here the number of diagnostics are displayed, which may be stored in the diagnostics buffer (circular buffer).</td>
</tr>
<tr>
<td>Synchronization type</td>
<td>You can specify whether the CPU clock should be used to synchronize other clocks or not.</td>
</tr>
<tr>
<td></td>
<td>- as slave: The clock is synchronized by another clock.</td>
</tr>
<tr>
<td></td>
<td>- as master: The clock synchronizes other clocks as master.</td>
</tr>
<tr>
<td></td>
<td>- none: There is no synchronization</td>
</tr>
<tr>
<td>Time interval</td>
<td>Select the time intervals within which the synchronization is to be carried out.</td>
</tr>
<tr>
<td>Correction factor</td>
<td>Lose or gain in the clock time may be compensated within a 24 hour period by means of the correction factor in ms. If the clock is 1s slow after 24 hours, you have to specify a correction factor of &quot;+1000&quot; ms.</td>
</tr>
</tbody>
</table>
Protection

Level of protection Here 1 of 3 protection levels may be set to protect the CPU from unauthorized access.

Protection level 1 (default setting):
• No password adjustable, no restrictions

Protection level 2 with password:
• Authorized users: read and write access
• Unauthorized user: read access only

Protection level 3:
• Authorized users: read and write access
• Unauthorized user: no read and write access

Parameter for DP The properties dialog of the Profibus part is opened via a double click to the sub module DP.

General

Short description Here the short description "DP" for Profibus DP is specified.

Order no. Nothing is shown here.

Name Here "DP" is shown. If you change the name, the new name appears in the Siemens SIMATIC manager.

Interface The Profibus address is shown here.

Properties With this button the properties of the Profibus DP interface may be preset.

Comment You can enter the purpose of the DP master in this box.

Addresses

Diagnostics A diagnostics address for Profibus DP is to be preset here. In the case of an error the CPU is informed via this address.

Operating mode Here the operating mode of the Profibus part may be preset. More may be found at chapter "Deployment CPU with Profibus".

Configuration Within the operating mode "DP-Slave" you may configure your slave system. More may be found at chapter "Deployment CPU with Profibus".

Clock These parameters are not supported.
The properties dialog of the MPI interface is opened via a double click to the sub module MPI/DP.

### General

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Short description</td>
<td>Here the short description &quot;MPI/DP&quot; for the MPI interface is specified.</td>
</tr>
<tr>
<td>Order no.</td>
<td>Nothing is shown here.</td>
</tr>
<tr>
<td>Name</td>
<td>At Name &quot;MPI/DP&quot; for the MPI interface is shown. If you change the name, the new name appears in the Siemens SIMATIC manager.</td>
</tr>
<tr>
<td>Type</td>
<td>Please regard only the type &quot;MPI&quot; is supported by the VIPA CPU 51xS.</td>
</tr>
<tr>
<td>Interface</td>
<td>Here the MPI address is shown.</td>
</tr>
<tr>
<td>Properties</td>
<td>With this button the properties of the MPI interface may be preset.</td>
</tr>
<tr>
<td>Comment</td>
<td>You can enter the purpose of the MPI interface in this box.</td>
</tr>
</tbody>
</table>

### Addresses

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Diagnostics</td>
<td>A diagnostics address for the MPI interface is to be preset here. In the case of an error the CPU is informed via this address.</td>
</tr>
<tr>
<td>Operating mode, Configuration, Clock</td>
<td>These parameters are not supported.</td>
</tr>
</tbody>
</table>
Here the following parameters may be accessed:

- Function RS485 (Synchronization DP master and CPU)
- Token Watch
- Number remanence flag
- Priority OB 28, OB 29, OB 33, OB 34
- Execution OB 33, OB 34
- Phase offset OB 33, OB 34

Via a hardware configuration you may configure the behavior of the synchronization between CPU and DP master using the parameter "Function RS485" of the object properties. Via a double-click on the inserted CPU 51xS at SPEED-Bus the parameter window of the SPEED7 CPU can be achieved.

Configure your SPEED7 system as shown above. After configuration the CPU 51xS must be located at slot 0 of the VIPA SPEED-Bus slave with address 100.

The object properties are opened via a double-click on the SPEED-Bus slave CPU 51xS.

With the parameter Function RS485 the following adjustment possibilities are given.

---

**Object properties:**
- Function RS485
Per default the RS485 interface is used for the Profibus DP master. Using this parameter the RS485 interface may be switched to PtP communication (point to point) respectively the synchronization between DP master system and CPU may be set:

- **Deactivated**: Deactivates the RS485 interface
- **PtP**: With this operating mode the Profibus DP master is deactivated and the RS485 interface acts as an interface for serial point-to-point communication. Here data may be exchanged between two stations by means of protocols. More about this may be found at chapter "Deployment PtP communication" in this manual.

**Profibus-DP async**

Profibus DP master operation asynchronous to CPU cycle

The RS485 interface is preset at default to **Profibus-DP async**. Here CPU cycle and cycles of every VIPA Profibus DP master run independently.

- **Profibus-DP syncIn**: The CPU is waiting for DP master input data.
- **Profibus-DP syncOut**: The DP master system is waiting for CPU output data.
- **Profibus-DP syncInOut**: CPU and DP master system are waiting on each other and form thereby a cycle.

Default: Profibus-DP async

Normally the cycle of CPU and DP master run independently. The cycle time of the CPU is the time needed for one OB1 cycle and for reading respectively writing the inputs respectively outputs. The cycle time of a DP Master depends among others on the number of connected slaves and the baud rate, thus every plugged DP master has its own cycle time. Due to the asynchronism of CPU and DP master the whole system gets relatively high response times.

The synchronization behavior between every SPEED-Bus Profibus DP master and the SPEED7 CPU can be configured by means of a hardware configuration as shown above. The different modes for the synchronization are in the following described.
In *Profibus-DP SyncInOut* mode CPU and DP master system are waiting on each other and form thereby a cycle. Here the whole cycle is the sum of the longest DP master cycle and CPU cycle.

By this synchronization mode you receive global consistent in-/output data, since within the total cycle the same input and output data are handled successively by CPU and DP master system.

If necessary the time of the *Watchdog* of the bus parameters should be increased at this mode.

---

**Profibus-DP SyncOut**

In this operating mode the cycle time of the SPEED-Bus DP master system depends on the CPU cycle time. After CPU start-up the DP master gets synchronized.

As soon as their cycle is passed they wait for the next synchronization impulse with output data of the CPU. So the response time of your system can be improved because output data were directly transmitted to the DP master system. If necessary the time of the *Watchdog* of the bus parameters should be increased at this mode.

---

**Profibus-DP SyncIn**

In the operating mode *Profibus-DP SyncIn* the CPU cycle is synchronized to the cycle of the SPEED-Bus Profibus DP master system.

Here the CPU cycle depends on the speed bus DP master with the longest cycle time. If the CPU gets into RUN it is synchronized with all speed bus DP master. As soon as the CPU cycle is passed it waits for the next synchronization impulse with input data of the DP master system.

If necessary the *Scan Cycle Monitoring Time* of the CPU should be increased.
Token Watch

This is a VIPA internal parameter. Nothing should be changed here.
Default: On

Number remanence flag

Here the number of flag bytes may be set. With 0 the value Retentive memory > Number of memory bytes starting with MB0 set at the parameters of the Siemens CPU 318-2 is used. Otherwise the adjusted value (1 ... 16384) is used.
Default: 0

Phase offset and execution of OB33 and OB34

The CPU offers additional cyclic interrupts, which interrupt the cyclic processing in certain distances. Point of start of the time interval is the change of operating mode from STOP to RUN.
To avoid that the cyclic interrupts of different cyclic interrupt OBs receive a start request at the same time and so a time out may occur, there is the possibility to set a phase offset respectively a time of execution.
The phase offset (0 ... 60000ms) serves for distribution processing times for cyclic interrupts across the cycle.
The time intervals, in which the cyclic interrupt OB should be processed may be entered with execution (1 ... 60000ms).
Default: Phase offset: 0
Execution: OB33: 500ms
OB34: 200ms

Priority of OB28, OB29, OB33 and OB34

The priority fixes the order of interrupts of the corresponding interrupt OB.
Here the following priorities are supported:
0 (Interrupt-OB is deactivated), 2,3,4,9,12,16,17,24
Default: 24
Project transfer

Overview
The following options are available to transfer a project into the CPU 51x slot card:

- internal via PCI slot (Ethernet connection)
- external via PC network card (routing necessary)
- external via RS485
- external via Profibus (not for first project)
- external via MMC storage card

For this transfer method CPU 51xS slot card and Siemens SIMATIC manager are installed at the same PC.

As soon as the Ethernet and CPU component have been assigned to valid IP address parameters the CPU 51xS may internal be accessed with the IP address of its CPU component. Adjust here as PG/PC interface "Intel(R) 8255xER".

For the communication functions of the CPU component a hardware configuration in which beside the CPU 318-2DP a CP 343-1 is configured. Set the desired IP address parameters here. Please note that the IP address may differ exclusively in the host ID from the IP address of the Ethernet component.

Within the PLC function the IP address parameters of the CP 343-1 may be used as target parameters.

If the target station indicated by the IP address parameters is not found during transmission, the original IP parameters for the CPU component may be entered in a hint dialog.

With confirmation of your input your project will be transferred to the original IP address. After the restart of the CPU the new IP parameters of the project are active.
For this transfer method it is presupposed that CPU 51xS slot card and a network card are in the target PC and the network card is connected with the projecting PC by Ethernet.

So that the CPU 51xS slot card may be accessed by the projecting PC via the network card a "routing" is necessary. For this details may be found at "External access to PG/OP channel via routing" above.

Proceed now as described at internal project transfer. Configure a CPU 318-2DP and a CP 343-1. Set the desired IP address parameters here. Choose at parameters "use router" and enter as "Gateway" the IP address of the Ethernet component of the CPU 51xS slot card.

Within the PLC function the IP address parameters of the CP 343 may be used as target parameters.

If the target station indicated by the IP address parameters is not found during transmission, the original IP parameters for the CPU component may be entered in a hint dialog.

With confirmation of your input your project will be transferred to the original IP address. After the restart of the CPU the new IP parameters of the project are active.
Transfer via RS485

For transfer via RS485 there are the following 2 interfaces:

- MPI interface supports maximally 32 PG/OP channels
- PB-DP/PtP interface supports maximally 31 PG/OP channels
  (exclusive at Profinet DP master operation)

MPI programming cable

The MPI programming cables are available at VIPA in different variants. The deployment of the cables is identical. The cables provide a bus enabled RS485 plug for the CPU and a RS232 res. USB plug for the PC. Due to the RS485 connection you may plug the MPI programming cables directly to an already plugged plug on the RS485 jack. Every bus participant identifies itself at the bus with an unique address, in the course of the address 0 is reserved for programming devices.

Net structure

The structure of a MPI net is in the principal identical with the structure of a 1.5Mbit/s Profibus net. This means the same rules are valid and you use the same components for the build-up. The single participants are connected with each other via bus interface plugs and Profibus cables. Per default the MPI net runs with 187.5kbit/s. VIPA CPUs are delivered with MPI address 2.

Terminating resistor

A cable has to be terminated with its surge impedance. For this you switch on the terminating resistor at the first and the last participant of a network or a segment.

Please make sure that the participants with the activated terminating resistors are always provided with voltage during start-up and operation.
Approach transfer via MPI interface

- Connect your PC to the MPI jack of your CPU via a MPI programming cable.
- Load your project in the SIMATIC manager from Siemens.
- Choose in the menu **Options > Set PG/PC interface**
- Select in the according list the "PC Adapter (MPI)"; if appropriate you have to add it first, then click on [Properties].
- Set in the register **MPI** the transfer parameters of your MPI net and type a valid **address**.
- Switch to the register **Local connection**
- Set the COM port of the PC and the transfer rate 38400bit/s for the MPI programming cable from VIPA.
- Via **PLC > Load to module** you may transfer your project via MPI to the CPU and save it on a MMC via **PLC > Copy RAM to ROM** if one is plugged.

Approach transfer via Profibus interface

- Connect your PC to the DP-PB/PtP jack of your CPU via a MPI programming cable.
- Load your project in the Siemens SIMATIC manager.
- Choose in the menu **Options > Set PG/PC interface**
- Select in the according list the "PC Adapter (Profibus)"; if appropriate you have to add it first, then click on [Properties].
- Set in the register **Profibus** the transfer parameters of your Profibus net and type a valid **Profibus address**. The **Profibus address** must be assigned to the DP master by a project before.
- Switch to the register **Local connection**
- Set the COM port of the PCs and the transfer rate 38400bit/s for the MPI programming cable from VIPA.
- Via **PLC > Load to module** you may transfer your project via Profibus to the CPU and save it on a MMC via **PLC > Copy RAM to ROM** if one is plugged.

**Note!**

An according project with an activated Profibus must have been loaded to the CPU before (not suited for first start-up), otherwise the CPU may not be reached after a overall reset.
The MMC (Memory Card) serves as external transfer and storage medium for programs and firmware. It has the PC compatible FAT16 file system. There may be stored several projects and sub-directories on a MMC storage module. Please regard that your current project respectively the file with the reserved file name is stored in the root directory.

With an overall reset, PowerON or CPU-STOP the MMC is automatically read. By presetting a reserved file name the functionality of the CPU may be influenced.

<table>
<thead>
<tr>
<th>File name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>S7PROG.WLD</td>
<td>Project file - is read after overall reset respectively may be written by CPU by an order.</td>
</tr>
<tr>
<td>AUTOLOAD.WLD</td>
<td>Project file - is read after PowerON.</td>
</tr>
<tr>
<td>PROTECT.WLD</td>
<td>Protected project file (see &quot;Extended know-how protection&quot;).</td>
</tr>
<tr>
<td>VIPA_CMD.MMC</td>
<td>Command file - file is once executed during CPU-STOP by plugging a MMC or after PowerON (see &quot;MMC-Cmd - Auto command&quot;).</td>
</tr>
<tr>
<td>*.pkg</td>
<td>Firmware file - is recognized after PowerON and may be installed by means of an update request (see &quot;Firmware update&quot;).</td>
</tr>
</tbody>
</table>

The transfer of the application program from the MMC into the CPU takes place depending on the file name after overall reset or PowerON. The blinking of the LED "MCC" of the CPU marks the active transfer. A transfer from CPU to MMC only happens if the size of the user memory exceeds the size of the user program. Else a memory expansion via MCC is necessary.

When the MMC has been installed, the write command stores the content of the battery buffered RAM as S7PROG.WLD at the MMC. The write command is controlled by means of the Siemens hardware configurator via PLC > Copy RAM to ROM. During the write process the "MMC"-LED of the CPU is blinking. When the LED expires the write process is finished.

<table>
<thead>
<tr>
<th>Event-ID</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>0xE100</td>
<td>MMC access error</td>
</tr>
<tr>
<td>0xE101</td>
<td>MMC error file system</td>
</tr>
<tr>
<td>0xE102</td>
<td>MMC error FAT</td>
</tr>
<tr>
<td>0xE200</td>
<td>MMC writing finished successful</td>
</tr>
</tbody>
</table>

After a write process on the MMC, an according ID event is written into the diagnostic buffer of the CPU. To monitor the diagnosis entries, you select PLC > Module Information in the Siemens SIMATIC manager. Via the register "Diagnostic Buffer" you reach the diagnosis window. When writing on the MMC, the following events may occur:
Operating modes

Overview

The CPU has 4 operating modes:

- operating mode STOP
- operating mode START-UP
- operating mode RUN
- operating mode FLAG

Certain conditions in the operating modes START-UP and RUN require a specific reaction from the system program. In this case the application interface is often provided by a call to an organization block that was included specifically for this event.

Operating mode STOP

- Processing of the application program has stopped.
- If the program was being processed before, the values of counters, timers, flags and the contents of the process image are retained during the transition to the STOP mode.
- Outputs are inhibited, i.e. all digital outputs are disabled.
- RN-LED off
- ST-LED on

Operating mode START-UP

- During the transition from STOP to RUN a call is issued to the start-up organization block OB 100. The length of this OB is not limited. The processing time for this OB is not monitored. The start-up OB may issue calls to other blocks.
- All digital outputs are disabled during the start-up, i.e. outputs are inhibited.
- RN-LED blinks
- ST-LED off

When the CPU has completed the start-up OB, it assumes the operating mode RUN.

Operating mode RUN

- The application program in OB 1 is processed in a cycle. At the control of alarms other program sections can be included in the cycle.
- All timers and counters, being started by the program, are active and the process image is updated with every cycle.
- The BASP-signal (outputs inhibited) is deactivated, i.e. all digital outputs are enabled.
- RN-LED on
- ST-LED off
**Operating mode**

**FLAG**

The CPU 51xS provides the opportunity to define up to 4 break points (flags) for program diagnosis purposes. The flags are set and deleted via your programming neighborhood. As soon as a break point is reached, you may execute your application line by line and may activate in- and outputs.

**Preconditions**

For the usage of break points, the following preconditions must be fulfilled:

- The single step test mode is only available for STL, if needed, change the view via View > STL to STL.
- The block has to be opened online and must not be protected.
- The opened block must not have been altered in the editor.

**Approach with break points**

- Activate the break point bar via View > Break point bar.
- Put the cursor to the statement line where a break point is to be set.
- Set the break point with Test > Set break point. The statement line is marked with a ring.
- To activate the break point, choose Test > Break point active. The ring changes to a circle.
- Switch the CPU to RUN. When the user application reaches the break point, the CPU switches into the state FLAG, the break point is marked with an arrow and the register contents are shown.
- Now you may execute your application code step by step via Test > Next command or execute the application until the next break point with Test > Continue.
- Test > Delete (all) break points deletes (all) break points.

**Behavior in operating mode**

**FLAG**

- LED RN blinks and LED ST is on.
- The code execution has been stopped. All run levels are not executed.
- All timer are frozen.
- The real-time clock is still active.
- The outputs are shut down, but may be released for test purposes.
- Passive CP communication is possible.

**Note!**

The usage of break points is possible at any time. A switch to the operating mode “Test operation” is not required.

If you set more than 3 break points, the single step operation is not longer available.
The CPUs include security mechanisms like a Watchdog (100ms) and a parameterizable cycle time surveillance (parameterizable min. 1ms) that stop res. execute a RESET at the CPU in case of an error and set it into a defined STOP state.

The VIPA CPUs are developed function secure and have the following system properties:

<table>
<thead>
<tr>
<th>Event</th>
<th>concerns</th>
<th>Effect</th>
</tr>
</thead>
<tbody>
<tr>
<td>RUN → STOP</td>
<td>general</td>
<td>BASP (Befehls-Ausgabe-Sperre, i.e. command output lock) is set.</td>
</tr>
<tr>
<td></td>
<td>central digital outputs</td>
<td>The outputs are set to 0V.</td>
</tr>
<tr>
<td></td>
<td>central analog outputs</td>
<td>The voltage supply for the output channels is switched off.</td>
</tr>
<tr>
<td></td>
<td>decentralized outputs</td>
<td>The outputs are set to 0V.</td>
</tr>
<tr>
<td></td>
<td>decentralized inputs</td>
<td>The inputs are read constantly from the slave and the recent values are put at disposal.</td>
</tr>
<tr>
<td>STOP → RUN res. Power on</td>
<td>general</td>
<td>First the PII is deleted, then OB 100 is called. After the execution of the OB, the BASP is reset and the cycle starts with: Delete PIQ → Read PII → OB1.</td>
</tr>
<tr>
<td></td>
<td>central analog outputs</td>
<td>The behavior of the outputs at restart can be preset.</td>
</tr>
<tr>
<td></td>
<td>decentralized inputs</td>
<td>The inputs are read constantly from the slave and the recent values are put at disposal.</td>
</tr>
<tr>
<td>RUN</td>
<td>general</td>
<td>The program execution happens cyclically and can therefore be foreseen: Read PII → OB1 → Write PIQ.</td>
</tr>
</tbody>
</table>

PII: = Process image inputs
PIQ: = Process image outputs
Overall reset

Overview
During the overall reset the entire user memory (RAM) and the retentive memory area is erased. Data located on the storage medium (MMC, MCC) is not affected. You should always issue an overall reset to your CPU before loading an application program into your CPU, to ensure that all blocks have been cleared from it.

Overall reset by means of the operating mode switch

Condition
The operating mode of the CPU is STOP. Place the operating mode switch on the CPU in position "STOP" → The ST-LED is on.

Overall reset
• Place the operating mode switch in the position MR and hold it in this position for app. 3 seconds. → The ST-LED changes from blinking to permanently on.
• Place the operating mode switch in the position STOP and switch it to MR and quickly back to STOP within a period of less than 3 seconds. → The ST-LED blinks (overall reset procedure).
• The overall reset has been completed when the ST-LED is on permanently. → The ST-LED is on.

The following figure illustrates the above procedure:
At deployment of the operating software PLC-Tool you may initialize the overall reset via the button [M-RES]. The button is available as soon as your CPU is in STOP.

**Conditions**

Your CPU has to be in STOP. Via the menu command **PLC > Operating Mode** you switch your CPU in STOP.

**Overall reset**

Via the menu command **PLC > Clear/Reset** you request the overall reset. In the dialog window you may switch your CPU to STOP if you didn't that yet and start the overall reset. During the overall reset procedure the ST-LED is blinking. When the ST-LED changes to permanently on, the overall reset has been finished.

**Automatic reload**

After the overall reset the CPU attempts to reload the parameters and the program from the memory card. → The MMC-LED at the board blinks. When the reload has been completed, the LED extinguishes. The operating mode of the CPU will be STOP or RUN, depending on the position of the operating mode switch.
Firmware update

Overview
The CPU offer you the opportunity to execute a firmware update for the CPU via MMC.
For this an accordingly prepared MMC must be in the CPU during the startup.
So a firmware file can be recognized and assigned with startup, a pkg file name is reserved for each updateable component and hardware release, which begins with "px" and differs in a number with six digits.
As soon as with startup a pkg file is on the MMC and the firmware is more current than in the components, all the pkg file assigned components within the CPU and at the SPEED-Bus get the new firmware.

Latest Firmware at www.vipa.de
The latest firmware versions may be found in the service area at www.vipa.de.

For example the following files are necessary for the firmware update of the CPU 517-4NE02 and its components (Profibus, CP 543) with hardware release 1:

- 517-4NE02, Hardware release 1: Px000118.zip
- Profibus DP master (integrated): Px000119.zip
- Ethernet CP 543 (integrated): Px000059.zip

Attention!
When installing a new firmware you have to be extremely careful. Under certain circumstances you may destroy the CPU, for example if the voltage supply is interrupted during transfer or if the firmware file is defective.
In this case, please call the VIPA-Hotline!
Please regard that the version of the update firmware has to be different from the existing firmware otherwise no update is executed.
Every SPEED7-CPU has got an integrated web page that monitors information about firmware version of the SPEED7 components. The Ethernet-PG/OP channel provides the access to this web page. More detailed information can be found at "Access to integrated web page".

**Load firmware and transfer it to storage media**

- Go to www.vipa.de.
- Navigate to "Firmware".
- Click at "System 500S".
- Choose the according modules and download the firmware Px......zip to your PC.
- Extract the zip-file and copy the extracted file to your MMC.
- Following this approach, transfer all wanted firmware files to your MMC.

**Attention!**

With a firmware update an overall reset is automatically executed. If your program is only available in the load memory of the CPU it is deleted! Save your program before executing a firmware update! After the firmware update you should execute a "Set back to factory settings" (see following page).
Transfer firmware from MMC to CPU

1. Get the RUN-STOP lever of your CPU in position STOP. Turn off the voltage supply. In installed condition depending upon operating system now you get a message that the connected partner is no longer present. This message can be ignored. Plug the MMC with the firmware files into the CPU. Please take care of the correct plug-in direction of the MMC. Turn on the voltage supply.

2. After a short boot-up time, the alternate blinking of the LEDs SF and FRCE shows that at least a more current firmware file was found on the MMC.

3. You start the transfer of the firmware as soon as you tip the RUN/STOP lever downwards to MRES within 10s.

4. During the update process, the LEDs SF and FRCE are alternately blinking and MMC LED is on. This may last several minutes.

5. The update is successful finished when the LEDs PWR, STOP, SF, FRCE and MCC are on. If they are blinking fast, an error occurred.

6. Turn Power OFF and ON. Now it is checked by the CPU, whether further current firmware versions are available at the MMC. If so, again the LEDs SF and FRCE flash after a short start-up period. Continue with point 3.

   If the LEDs do not flash, the firmware update is ready.

   Now a factory reset should be executed (see next page). After that the CPU is ready for duty.
Factory reset

**Proceeding**

With the following proceeding the internal RAM of the CPU is completely deleted and the CPU is reset to delivery state. Please note that here also the MPI address is reset to the default address 2 and the IP address of the Ethernet PG/OP channel is reset to 0.0.0.0!

A factory reset may also be executed by the MMC-Cmd FACTORY_RESET. More information may be found at "MMC-Cmd - Auto commands".

1. Switch the CPU to STOP.
2. Push the operating switch down to position MR for 30s. Here the ST-LED flashes. After a few seconds the ST-LED changes to static light. Now the ST-LED changes between static light and flashing. Starting here count the static light states.
3. After the 6. static light release the operating mode switch and tip it shortly downwards to MR.
4. For the confirmation of the resetting procedure the green run LED gets ON within 0.5s. If not the factory reset has failed and only an overall reset was executed. In this case you can repeat the procedure. An factory reset can only be executed if the stop LED has static light for exactly 6 times.
5. The end of factory reset is showing by static light of the LEDs STOP, SF, FRCE and MMC. Switch the power supply off and on.

The proceeding is shown in the following Illustration:

![Illustration of factory reset procedure](image.png)

**Note!**

After the firmware update you always should execute a Factory reset.
**Memory expansion with MCC**

**Overview**
You have the option to expand the work memory of your CPU. For this, a MCC (Memory Configuration Card) is available at VIPA. The MCC is a specially prepared MMC (Multimedia Card). By plugging the MCC into the MCC slot and then an overall reset the according memory expansion is released. There may only one memory expansion be activated at the time.

On the MCC there is the file `memory.key`. This file may not be altered or deleted. You may use the MCC also as "normal" MMC for storing your project.

**Approach**
To extend the memory, plug the MCC into the card slot at the CPU labeled with "MCC" and execute an overall reset.

![Overall reset](image)

→ Memory is extended for the MCC memory configuration (diagnostic entry 0xE400).

If the memory expansion on the MCC exceeds the maximum extendable memory range of the CPU, the maximum possible memory of the CPU is automatically used.

You may determine the recent memory extension via the Siemens SIMATIC manager at Module Information - "Memory".

**Attention!**
Please regard that the MCC must remain plugged when you've executed the memory expansion at the CPU. Otherwise the CPU switches to STOP after 72h. The MCC can not be exchanged with a MCC of the same memory configuration.

**Behavior**
When the MCC memory configuration has been set you may find the diagnosis entry 0xE400 in the diagnostic buffer of the CPU.

After pulling the MCC the entry 0xE401 appears in the diagnostic buffer, the SF-LED is on and after 72h the CPU switches to STOP. A reboot is only possible after plugging-in the MCC again or after an overall reset.

After re-plugging the MCC, the SF-LED extinguishes and 0xE400 is entered into the diagnostic buffer. You may reset the memory configuration of your CPU to the initial status at any time by executing an overall reset without MCC.
Extended know-how protection

Overview
Besides the "standard" know-how protection the SPEED7-CPU's from VIPA provide an "extended" know-how protection that serves a secure block protection for accesses of third persons.

Standard protection
The standard protection from Siemens transfers also protected blocks to the PG but their content is not displayed. But with according manipulation the know-how protection is not guaranteed.

Extended protection
The "extended" know-how protection developed by VIPA offers the opportunity to store blocks permanently in the CPU.
At the "extended" protection you transfer the protected blocks into a wld file named protect.wld. By plugging the MMC and following overall reset, the blocks in the protect.wld are permanently stored in the CPU.
You may protect OBs, FBs and FCs.
When back-reading the protected blocks into the PG, exclusively the block header are loaded. The source remains in the CPU and is thus protected for accesses of third persons.

Protected blocks are located in the CPU
**protect blocks with protect.wld**

Create a new wld file in your project engineering tool with **File > Memory Card file > New** and rename it to "protect.wld". Transfer the according blocks into the file by dragging them with the mouse from the project to the file window of protect.wld.

**Transfer protect.wld to CPU with overall reset**

Transfer the file protect.wld to a MMC storage module, plug the MMC into the CPU and execute an overall reset with the following approach:

1. RN ST
2. RN ST
3. RN ST
4. RN ST

The overall reset stores the blocks in protect.wld permanently in the CPU protected from accesses of third persons.

**Protection behavior**

Protected blocks are overwritten by a new protect.wld. Using a PG third persons may access protected blocks but only the block header is transferred to the PG. The block code that is to protect remains in the CPU and can not be read.

**Change respectively delete protected blocks**

Protected blocks in the RAM of the CPU may be substituted at any time by blocks with the same name. This change remains up to next overall reset. Protected blocks may permanently be overwritten only if these are deleted at the protect.wld before.

By transferring an empty protect.wld from the MMC you may delete all protected blocks in the CPU.

**Usage of protected blocks**

Due to the fact that reading of a "protected" block from the CPU monitors no symbol labels it is convenient to provide the "block covers" for the end user.

For this, create a project out of all protected blocks. Delete all networks in the blocks so that these only contain the variable definitions in the according symbolism.
MMC-Cmd - Auto commands

Overview

A command file at a MMC may be started automatically when the MMC is stuck and the CPU is in STOP. As soon as the MMC is stuck the command file is once executed at CPU STOP up to the next PowerON.

The command file is a text file, which consists of a command sequence to be stored as vipa_cmd.mmc in the root directory of the MMC.

The file has to be started by CMD_START as 1. command, followed by the desired commands (no other text) und must be finished by CMD_END as last command.

Text after the last command CMD_END e.g. comments is permissible, because this is ignored. As soon as the command file is recognized and executed each action is stored at the MMC in the log file logfile.txt. In addition for each executed command a diagnostics entry may be found in the diagnostics buffer.

Commands

In the following there is an overview of the commands. Please regard the command sequence is to be started with CMD_START and ended with CMD_END.

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
<th>Diagnostics entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>CMD_START</td>
<td>In the first line CMD_START is to be located.</td>
<td>0xE801</td>
</tr>
<tr>
<td></td>
<td>There is a diagnostic entry if CMD_START is missing</td>
<td>0xE8FE</td>
</tr>
<tr>
<td>WAIT1SECOND</td>
<td>Waits ca. 1 second.</td>
<td>0xE803</td>
</tr>
<tr>
<td>WEBPAGE</td>
<td>The current web page of the CPU is stored at the MMC as &quot;webpage.htm&quot;.</td>
<td>0xE804</td>
</tr>
<tr>
<td>LOAD_PROJECT</td>
<td>The function &quot;Overall reset and reload from MMC&quot; is executed. The wld file located after the command is loaded else &quot;s7prog.wld&quot; is loaded.</td>
<td>0xE805</td>
</tr>
<tr>
<td>SAVE_PROJECT</td>
<td>The recent project (blocks and hardware configuration) is stored as &quot;s7prog.wld&quot; at the MMC. If the file just exists it is renamed to &quot;s7prog.old&quot;. If your project is password protected you have to add to SAVE_PROJECT your password as parameter. Example: Password = &quot;vipa&quot;: SAVE_PROJECT vipa</td>
<td>0xE806</td>
</tr>
<tr>
<td>FACTORY_RESET</td>
<td>Executes &quot;factory reset&quot;.</td>
<td>0xE807</td>
</tr>
<tr>
<td>DIAGBUF</td>
<td>The current diagnostics buffer of the CPU is stored as &quot;diagbuff.txt&quot; at the MMC.</td>
<td>0xE80B</td>
</tr>
<tr>
<td>SET_NETWORK</td>
<td>IP parameters for Ethernet PG/OP channel may be set by means of this command. The IP parameters are to be given in the order IP address, subnet mask and gateway in the format xxx.xxx.xxx.xxx each separated by a comma. Enter the IP address if there is no gateway used.</td>
<td>0xE80E</td>
</tr>
<tr>
<td>CMD_END</td>
<td>In the last line CMD_END is to be located.</td>
<td>0xE802</td>
</tr>
</tbody>
</table>
Examples

The structure of a command file is shown in the following. The corresponding diagnostics entry is put in parentheses.

Example 1

CMD_START Marks the start of the command sequence (0xE801)
LOAD_PROJECT proj.wld Execute an overall reset and load "proj.wld" (0xE805)
WAIT1SECOND Wait ca. 1s (0xE803)
WEBSITE Wait ca. 1s (0xE803)
WEBPAGE Store web page as "webpage.htm" (0xE804)
DIAGBUF Store diagnostics buffer of the CPU as "diagbuff.txt" (0xE80B)
CMD_END Marks the end of the command sequence (0xE802)
... arbitrary text ... Text after the command CMD_END is not evaluated.

Example 2

CMD_START Marks the start of the command sequence (0xE801)
LOAD_PROJECT proj2.wld Execute an overall reset and load "proj2.wld" (0xE805)
WAIT1SECOND Wait ca. 1s (0xE803)
WAIT1SECOND Wait ca. 1s (0xE803)
SET_NETWORK 172.16.129.210, 255.255.224.0, 172.16.129.210 IP parameter (0xE80E)
WAIT1SECOND Wait ca. 1s (0xE803)
WAIT1SECOND Wait ca. 1s (0xE803)
WEBSITE Store web page as "webpage.htm" (0xE804)
DIAGBUF Store diagnostics buffer of the CPU as "diagbuff.txt" (0xE80B)
CMD_END Marks the end of the command sequence (0xE802)
... arbitrary text ... Text after the command CMD_END is not evaluated.

Note!
The parameters IP address, subnet mask and gateway may be received from the system administrator.
Enter the IP address if there is no gateway used.
VIPA specific diagnostic entries

Entries in the diagnostic buffer

You may read the diagnostic buffer of the CPU via the Siemens SIMATIC manager. Besides of the standard entries in the diagnostic buffer, the VIPA CPUs support some additional specific entries in form of event-IDs.

The current content of the diagnostics buffer is stored on MMC by means of the MMC-Cmd DIAGBUF. More information may be found at "MMC-Cmd - Auto commands".

Note!

Every register of the module information is supported by the VIPA CPUs. More information may be found at the online help of the Siemens SIMATIC manager.

Monitoring the diagnostic entries

To monitor the diagnostic entries you choose the option PLC > Module Information in the Siemens SIMATIC manager. Via the register "Diagnostic Buffer" you reach the diagnostic window:

The diagnosis is independent from the operating mode of the CPU. You may store a max. of 100 diagnostic entries in the CPU.

The following page shows an overview of the VIPA specific Event-IDs.
### Overview of the Event-IDs

<table>
<thead>
<tr>
<th>Event-ID</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0xE003</td>
<td>Error at access to I/O devices</td>
</tr>
<tr>
<td></td>
<td>Zinfo1: I/O address</td>
</tr>
<tr>
<td></td>
<td>Zinfo2: Slot</td>
</tr>
<tr>
<td>0xE004</td>
<td>Multiple parameterization of a I/O address</td>
</tr>
<tr>
<td></td>
<td>Zinfo1: I/O address</td>
</tr>
<tr>
<td></td>
<td>Zinfo2: Slot</td>
</tr>
<tr>
<td>0xE005</td>
<td>Internal error - Please contact the VIPA-Hotline!</td>
</tr>
<tr>
<td>0xE006</td>
<td>Internal error - Please contact the VIPA-Hotline!</td>
</tr>
<tr>
<td>0xE007</td>
<td>Configured in-/output bytes do not fit into I/O area</td>
</tr>
<tr>
<td>0xE008</td>
<td>Internal error - Please contact the VIPA-Hotline!</td>
</tr>
<tr>
<td>0xE009</td>
<td>Error at access to standard back plane bus</td>
</tr>
<tr>
<td>0xE010</td>
<td>Not defined module group at backplane bus recognized</td>
</tr>
<tr>
<td></td>
<td>Zinfo2: Slot</td>
</tr>
<tr>
<td></td>
<td>Zinfo3: Type ID</td>
</tr>
<tr>
<td>0xE011</td>
<td>Master project engineering at Slave-CPU not possible or wrong slave configuration</td>
</tr>
<tr>
<td>0xE012</td>
<td>Error at parameterization</td>
</tr>
<tr>
<td>0xE013</td>
<td>Error at shift register access to standard bus digital modules</td>
</tr>
<tr>
<td>0xE014</td>
<td>Error at Check_Sys</td>
</tr>
<tr>
<td>0xE015</td>
<td>Error at access to the master</td>
</tr>
<tr>
<td></td>
<td>Zinfo2: Slot of the master (32=page frame master)</td>
</tr>
<tr>
<td>0xE016</td>
<td>Maximum block size at master transfer exceeded</td>
</tr>
<tr>
<td></td>
<td>Zinfo1: I/O address</td>
</tr>
<tr>
<td></td>
<td>Zinfo2: Slot</td>
</tr>
<tr>
<td>0xE017</td>
<td>Error at access to integrated slave</td>
</tr>
<tr>
<td>0xE018</td>
<td>Error at mapping of the master I/O devices</td>
</tr>
<tr>
<td>0xE019</td>
<td>Error at standard back plane bus system recognition</td>
</tr>
<tr>
<td>0xE01A</td>
<td>Error at recognition of the operating mode (8 / 9bit)</td>
</tr>
<tr>
<td>0xE01B</td>
<td>Error - maximum number of plug-in modules exceeded</td>
</tr>
<tr>
<td>0xE030</td>
<td>Error of the standard bus</td>
</tr>
<tr>
<td>0xE0B0</td>
<td>SPEED7 is not stoppable (probably undefined BCD value at timer)</td>
</tr>
<tr>
<td>0xE0C0</td>
<td>Not enough space in work memory for storing code block (block size exceeded)</td>
</tr>
<tr>
<td>0xE0CC</td>
<td>Communication error MPI / Serial</td>
</tr>
<tr>
<td>0xE0CD</td>
<td>Error at DPV1 job management</td>
</tr>
<tr>
<td>0xE0CE</td>
<td>Error: Timeout at sending of the i-slave diagnostics</td>
</tr>
<tr>
<td>0xE100</td>
<td>MMC access error</td>
</tr>
<tr>
<td>0xE101</td>
<td>MMC error file system</td>
</tr>
<tr>
<td>0xE102</td>
<td>MMC error FAT</td>
</tr>
<tr>
<td>0xE104</td>
<td>MMC error at saving</td>
</tr>
<tr>
<td>0xE200</td>
<td>MMC writing finished (Copy Ram2Rom)</td>
</tr>
</tbody>
</table>

*continued ...*
<table>
<thead>
<tr>
<th>Event-ID</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0xE210</td>
<td>MMC reading finished (reload after overall reset)</td>
</tr>
<tr>
<td>0xE21F</td>
<td>MMC reading: error at reload (after overall reset), read error, out of memory</td>
</tr>
<tr>
<td>0xE400</td>
<td>Memory expansion MCC has been plugged</td>
</tr>
<tr>
<td>0xE401</td>
<td>Memory expansion MCC has been removed</td>
</tr>
<tr>
<td>0xE801</td>
<td>MMC-Cmd: CMD_START recognized and successfully executed</td>
</tr>
<tr>
<td>0xE802</td>
<td>MMC-Cmd: CMD_END recognized and successfully executed</td>
</tr>
<tr>
<td>0xE803</td>
<td>MMC-Cmd: WAIT1SECOND recognized and successfully executed</td>
</tr>
<tr>
<td>0xE804</td>
<td>MMC-Cmd: WEBPAGE recognized and successfully executed</td>
</tr>
<tr>
<td>0xE805</td>
<td>MMC-Cmd: LOAD_PROJECT recognized and successfully executed</td>
</tr>
<tr>
<td>0xE806</td>
<td>MMC-Cmd: SAVE_PROJECT recognized and successfully executed</td>
</tr>
<tr>
<td>0xE807</td>
<td>MMC-Cmd: FACTORY_RESET recognized and successfully executed</td>
</tr>
<tr>
<td>0xE80B</td>
<td>MMC-Cmd: DIAGBUF recognized and successfully executed</td>
</tr>
<tr>
<td>0xE80E</td>
<td>MMC-Cmd: SET_NETWORK recognized and successfully executed</td>
</tr>
<tr>
<td>0xE8FB</td>
<td>MMC-Cmd: Error: Initialization of the Ethernet PG/OP channel by means of SET_NETWORK is faulty.</td>
</tr>
<tr>
<td>0xE8FC</td>
<td>MMC-Cmd: Error: Not every IP-Parameter is set at SET_NETWORK.</td>
</tr>
<tr>
<td>0xE8FE</td>
<td>MMC-Cmd: Error: CMD_START was not found</td>
</tr>
<tr>
<td>0xE8FF</td>
<td>MMC-Cmd: Error: Reading the CMD file is faulty (MMC error)</td>
</tr>
<tr>
<td>0xE901</td>
<td>Check sum error</td>
</tr>
<tr>
<td>0xEA00</td>
<td>Internal error - Please contact the VIPA-Hotline!</td>
</tr>
<tr>
<td>0xEA01</td>
<td>Internal error - Please contact the VIPA-Hotline!</td>
</tr>
<tr>
<td>0xEA02</td>
<td>SBUS: Internal error (internal plugged sub module not recognized)</td>
</tr>
<tr>
<td></td>
<td>Zinfo1: Internal slot</td>
</tr>
<tr>
<td>0xEA04</td>
<td>SBUS: Multiple parameterization of a I/O address</td>
</tr>
<tr>
<td></td>
<td>Zinfo1: I/O address</td>
</tr>
<tr>
<td></td>
<td>Zinfo2: Slot</td>
</tr>
<tr>
<td></td>
<td>Zinfo3: Data width</td>
</tr>
<tr>
<td>0xEA05</td>
<td>Internal error - Please contact the VIPA-Hotline!</td>
</tr>
<tr>
<td>0xEA07</td>
<td>Internal error - Please contact the VIPA-Hotline!</td>
</tr>
<tr>
<td>0xEA08</td>
<td>SBUS: Parameterized input data width unequal to plugged input data width</td>
</tr>
<tr>
<td></td>
<td>Zinfo1: Parameterized input data width</td>
</tr>
<tr>
<td></td>
<td>Zinfo2: Slot</td>
</tr>
<tr>
<td></td>
<td>Zinfo3: Input data width of the plugged module</td>
</tr>
<tr>
<td>0xEA09</td>
<td>SBUS: Parameterized output data width unequal to plugged output data width</td>
</tr>
<tr>
<td></td>
<td>Zinfo1: Parameterized output data width</td>
</tr>
<tr>
<td></td>
<td>Zinfo2: Slot</td>
</tr>
<tr>
<td></td>
<td>Zinfo3: Output data width of the plugged module</td>
</tr>
</tbody>
</table>
### Event-ID Description

<table>
<thead>
<tr>
<th>Event-ID</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0xEA10</td>
<td>SBUS: Input address outside input area</td>
</tr>
<tr>
<td></td>
<td>Zinfo1: I/O address</td>
</tr>
<tr>
<td></td>
<td>Zinfo2: Slot</td>
</tr>
<tr>
<td></td>
<td>Zinfo3: Data width</td>
</tr>
<tr>
<td>0xEA11</td>
<td>SBUS: Output address outside output area</td>
</tr>
<tr>
<td></td>
<td>Zinfo1: I/O address</td>
</tr>
<tr>
<td></td>
<td>Zinfo2: Slot</td>
</tr>
<tr>
<td></td>
<td>Zinfo3: Data width</td>
</tr>
<tr>
<td>0xEA12</td>
<td>SBUS: Error at writing record set</td>
</tr>
<tr>
<td></td>
<td>Zinfo1: Slot</td>
</tr>
<tr>
<td></td>
<td>Zinfo2: Record set number</td>
</tr>
<tr>
<td></td>
<td>Zinfo3: Record set length</td>
</tr>
<tr>
<td>0xEA14</td>
<td>SBUS: Multiple parameterization of a I/O address (Diagnostic address)</td>
</tr>
<tr>
<td></td>
<td>Zinfo1: I/O address</td>
</tr>
<tr>
<td></td>
<td>Zinfo2: Slot</td>
</tr>
<tr>
<td></td>
<td>Zinfo3: Data width</td>
</tr>
<tr>
<td>0xEA15</td>
<td>Internal error - Please contact the VIPA-Hotline!</td>
</tr>
<tr>
<td>0xEA18</td>
<td>SBUS: Error at mapping of the master I/O devices</td>
</tr>
<tr>
<td></td>
<td>Zinfo2: Master slot</td>
</tr>
<tr>
<td>0xEA19</td>
<td>Internal error - Please contact the VIPA-Hotline!</td>
</tr>
<tr>
<td>0xEA20</td>
<td>Error - RS485 interface is not set to Profibus DP master but there is a Profibus DP master configured.</td>
</tr>
<tr>
<td>0xEA21</td>
<td>Error - Project engineering RS485 interface X2/X3: Profibus DP master is configured but missing</td>
</tr>
<tr>
<td></td>
<td>Zinfo2: Interface x</td>
</tr>
<tr>
<td>0xEA22</td>
<td>Error - RS485 interface X2 - value is out of range</td>
</tr>
<tr>
<td></td>
<td>Zinfo: Configured value X2</td>
</tr>
<tr>
<td>0xEA23</td>
<td>Error - RS485 interface X3 - value is out of range</td>
</tr>
<tr>
<td></td>
<td>Zinfo: Configured value X3</td>
</tr>
<tr>
<td>0xEA24</td>
<td>Error - Project engineering RS485 interface X2/X3: Interface/Protocol is missing, the default settings are used.</td>
</tr>
<tr>
<td></td>
<td>Zinfo2: Configured value X2</td>
</tr>
<tr>
<td></td>
<td>Zinfo2: Configured value X3</td>
</tr>
<tr>
<td>0xEA30</td>
<td>Internal error - Please contact the VIPA-Hotline!</td>
</tr>
<tr>
<td>0xEA40</td>
<td>Internal error - Please contact the VIPA-Hotline!</td>
</tr>
<tr>
<td>0xEA41</td>
<td>Internal error - Please contact the VIPA-Hotline!</td>
</tr>
<tr>
<td>0xEA98</td>
<td>Timeout at waiting for reboot of a SBUS module (Server)</td>
</tr>
<tr>
<td>0xEA99</td>
<td>Error at file reading via SBUS</td>
</tr>
<tr>
<td>0xEE00</td>
<td>Internal error - Please contact the VIPA-Hotline!</td>
</tr>
</tbody>
</table>
Using test functions for control and monitoring of variables

Overview
For troubleshooting purposes and to display the status of certain variables you can access certain test functions via the menu item Debug of the Siemens SIMATIC manager.

The status of the operands and the VKE can be displayed by means of the test function Debug > Monitor.

You can modify and/or display the status of variables by means of the test function PLC > Monitor/Modify Variables.

Debug > Monitor
This test function displays the current status and the VKE of the different operands while the program is being executed.
It is also possible to enter corrections to the program.

Note!
When using the test function “Monitor” the PLC must be in RUN mode!

The processing of the states may be interrupted by means of jump commands or by timer and process-related alarms. At the breakpoint the CPU stops collecting data for the status display and instead of the required data it only provides the PG with data containing the value 0.

For this reason, jumps or time and process alarms can result in the value displayed during program execution remaining at 0 for the items below:

- the result of the logical operation VKE
- Status / AKKU 1
- AKKU 2
- Condition byte
- absolute memory address SAZ. In this case SAZ is followed by a “?”. 

The interruption of the processing of statuses does not change the execution of the program. It only shows that the data displayed is no longer.
PLC > Monitor/Modify Variables

This test function returns the condition of a selected operand (inputs, outputs, flags, data word, counters or timers) at the end of program-execution. This information is obtained from the process image of the selected operands. During the "processing check" or in operating mode STOP the periphery is read directly from the inputs. Otherwise only the process image of the selected operands is displayed.

Control of outputs
It is possible to check the wiring and proper operation of output-modules. You can set outputs to any desired status with or without a control program. The process image is not modified but outputs are no longer inhibited.

Control of variables
The following variables may be modified:
I, Q, M, T, C and D.
The process image of binary and digital operands is modified independently of the operating mode of the CPU 51xS.
When the operating mode is RUN the program is executed with the modified process variable. When the program continues they may, however, be modified again without notification.
Process variables are controlled asynchronously to the execution sequence of the program.
Chapter 4  Deployment CPU with Profibus

Overview  
Content of this chapter is the deployment of the CPU 517S/NET with Profibus. After a short overview the project engineering and parameterization of a CPU 517S/NET with integrated Profibus-Part from VIPA is shown.  
Further you get information about usage as DP master and DP slave of the Profibus part.  
The chapter is ended with notes to commissioning and start-up.

Content  

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chapter 4 Deployment CPU with Profibus</td>
<td>4-1</td>
</tr>
<tr>
<td>Overview</td>
<td>4-2</td>
</tr>
<tr>
<td>Project engineering CPU with integrated Profibus master</td>
<td>4-3</td>
</tr>
<tr>
<td>Deployment as Profibus DP slave</td>
<td>4-5</td>
</tr>
<tr>
<td>Project transfer</td>
<td>4-7</td>
</tr>
<tr>
<td>Profibus installation guidelines</td>
<td>4-8</td>
</tr>
<tr>
<td>Commissioning and Start-up behavior</td>
<td>4-11</td>
</tr>
</tbody>
</table>
Overview

Profibus DP

Profibus is an international standard applicable to an open and serial field bus for building, manufacturing and process automation that can be used to create a low (sensor-/actuator level) or medium (process level) performance network of programmable logic controllers.

Profibus comprises an assortment of compatible versions. The following details refer to Profibus DP.

Profibus DP is a special protocol intended mainly for automation tasks in a manufacturing environment. DP is very fast, offers Plug'n'Play facilities and provides a cost-effective alternative to parallel cabling between PLC and remote I/O. Profibus-DP was designed for high-speed data communication on the sensor-actuator level. The data transfer referred to as "Data Exchange" is cyclical. During one bus cycle, the master reads input values from the slaves and writes output information to the slave.

CPU with DP master

The Profibus DP master is to configure via the hardware configurator from Siemens. Therefore you have to choose the Siemens-CPU 318-2AJ00 in the hardware configurator from Siemens.

The transmission of your project engineering into the CPU takes place by means of MPI. This is internally passing on your project data to the Profibus master part.

During the start-up the DP master automatically includes his data areas into the address range of the CPU. A project engineering in the CPU is not required.

As external storage medium the Profibus DP master uses the MMC (Multi Media Card) together with the CPU.

Deployment of the DP Master with CPU

Via the Profibus DP master up to 124 Profibus DP slaves may be coupled to the CPU. The DP master communicates with the DP slaves and links up its data areas with the address area of the CPU. There may be created maximal 1024Byte Input and 1024Byte Output data.

At every POWER ON res. overall reset the CPU fetches the I/O mapping data from the master.

At DP slave failure, the ER-LED is on and the OB 86 is requested. If this is not available, the CPU switches to STOP and BASP is set.

As soon as the BASP signal comes from the CPU, the DP master is setting the outputs of the connected periphery to zero. The DP master remains in the operating mode RUN independent from the CPU.

DP slave operation

For the deployment in an super-ordinated master system you first have to project your slave system as CPU 318-2DP (6ES7 318-2AJ00-0AB0/V3.0) in Slave operation with configured in-/output areas. Afterwards you configure your master system. Assign your slave system to your master system by dragging the "CPU 31x" from the hardware catalog at Configured stations onto the master system, choose your slave system and connect it.
Project engineering CPU with integrated Profibus master

Overview

For the project engineering of the Profibus DP master you have to use the hardware manager from Siemens. Your Profibus projects are transferred via MPI to the CPU by means of the "PLC" functions. The CPU passes the data on to the Profibus DP master.

Preconditions

For the project engineering of the Profibus DP master in the CPU 51xS/DPM the following preconditions have to be fulfilled:

- Siemens SIMATIC Manager has to be installed.
- With Profibus DP slaves of the Systems 100V, 200V and 300V from VIPA: GSD Files are included into the hardware configurator.
- There is a transfer possibility between configuration tool and CPU 51xS.

Note!

For the project engineering of the CPU and the Profibus DP master a thorough knowledge of the Siemens SIMATIC manager is required!

Install Siemens Hardware configurator

The hardware configurator is a part of the Siemens SIMATIC Manager. It serves the project engineering. The modules that may be configured here, are listed in the hardware catalog.

For the deployment of the Profibus DP slaves of the Systems 100V, 200V and 300V from VIPA you have to include the modules into the hardware catalog by means of the GSD file from VIPA.

Configure DP master

- Create a new project System 300.
- Add a profile rail from the hardware catalog.
- In the hardware catalog the CPU with Profibus master is listed as: Simatic300/CPU-300/CPU318-2DP/6ES7 318-2AJ00-0AB0
- Insert the CPU 318-2DP (6ES7 318-2AJ00-0AB0).
- Type the Profibus address of your master (e.g. 2).
- Click on DP, choose the operating mode "DP master" under object properties and confirm your entry with OK.
- Click on "DP" with the right mouse button and choose "add master system".
- Create a new Profibus subnet via NEW.
Now the project engineering of your Profibus DP master is finished. Please link up now your DP slaves with periphery to your DP master.

- For the project engineering of Profibus DP slaves you search the concerning Profibus DP slave in the hardware catalog and drag&drop it in the subnet of your master.
- Assign a valid Profibus address to the DP slave.
- Link up the modules of your DP slave system in the plugged sequence and add the addresses that should be used by the modules.
- If needed, parameterize the modules.

**Slave operation possible**

You may deploy your Profibus part from the SPEED7-CPU as DP slave. The approach is described on the following page.
Deployment as Profibus DP slave

Fast introduction
The deployment of the Profibus section as "intelligent" DP slave happens exclusively at master systems that may be configured in the Siemens SIMATIC manager. The following steps are required:

- Start the Siemens SIMATIC manager and configure a CPU 318-2DP with the operating mode DP slave.
- Connect to Profibus and configure the in-/output area for the slave section.
- Save and compile your project.
- Configure another station as CPU 318-2DP with operating mode DP master.
- Connect to Profibus and configure the in-/output area for the master section.
- Save and compile your project.

In the following these steps are more detailed.

Project engineering of the slave section

- Start the Siemens SIMATIC manager with a new project.
- Insert a SIMATIC 300 station and name it as "...DP slave"
- Open the hardware configurator and insert a profile rail from the hardware catalog.
- Place the following Siemens CPU at slot 2: CPU 318-2DP (6ES7 318-2AJ00-0AB0 V3.0)
- Connect the CPU to Profibus, set a Profibus address >1 (preferably 3) and switch the Profibus section via operating mode to "slave operation".
- Via Configuration you define the in-/output address area of the slave CPU that shall be assigned to the DP slave.
- Save and compile your project.

Slave section

<table>
<thead>
<tr>
<th>Slot</th>
<th>Module</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>CPU 318-2</td>
</tr>
<tr>
<td></td>
<td>DP</td>
</tr>
<tr>
<td></td>
<td>X2</td>
</tr>
<tr>
<td></td>
<td>X1</td>
</tr>
<tr>
<td></td>
<td>X2</td>
</tr>
<tr>
<td>3</td>
<td></td>
</tr>
</tbody>
</table>

Object properties
- Operating mode: DP slave
- Connect: Profibus
- Profibus address: > 1
- Configuration:
  - Input area
  - Output area
Project engineering of the master section

- Insert another *SIMATIC 300 station* and name it as "...DP master".
- Open the hardware configurator and insert a profile rail from the hardware catalog.
- Place the following Siemens CPU at slot 2: **CPU 318-2DP (6ES7 318-2AJ00-0AB0 V3.0)**
- Add your modules according to the real hardware assembly.
- Connect the CPU to *Profibus*, set a Profibus address >1 (preferably 2) and switch the Profibus section via *operating mode* to "master operation".
- Connect your slave system to the master system by dragging the "CPU 31x" from the hardware catalog at *configured stations* onto the master system and select your slave system.
- Open the *Configuration* at *Object properties* of your slave system.
- Via double click to the according configuration line you assign the according input address area on the master CPU to the slave output data and the output address area to the slave input data.
- Save and compile your project.

**Master section**

**Standard bus**

<table>
<thead>
<tr>
<th>Slot</th>
<th>Module</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>CPU 318-2</td>
</tr>
<tr>
<td>X2</td>
<td>DP</td>
</tr>
<tr>
<td>X1</td>
<td>MPI/DP</td>
</tr>
<tr>
<td>3</td>
<td></td>
</tr>
</tbody>
</table>

**Object properties**

Operating mode: DP master  
Connect: Profibus  
Profibus address: > 1

**Configuration:**

Input area slave CPU = Output area master-CPU  
Output area slave CPU = Input area master-CPU

---

**Note!**

Data consistency can only be guaranteed for one *unit*! The choice "Data consistency by length" is not supported.
Project transfer

Overview

The following options are available to transfer a project into the CPU 51x slot card:
- internal via PCI slot (Ethernet connection)
- external via PC network card (routing necessary)
- external via MPI
- external via Profibus (not for first project)
- external via MMC storage card

More about the transfer methods may be found at chapter "Deployment CPU 51xS" at "Project transfer".
Profibus installation guidelines

**Profibus in general**

- A Profibus DP network may only be built up in linear structure.
- Profibus DP consists of minimum one segment with at least one master and one slave.
- A master has always been deployed together with a CPU.
- Profibus supports max. 124 participants.
- Per segment a max. of 32 participants is permitted.
- The max. segment length depends on the transfer rate:
  
<table>
<thead>
<tr>
<th>Transfer Rate</th>
<th>Max. Length</th>
</tr>
</thead>
<tbody>
<tr>
<td>9.6 ... 187.5kbit/s</td>
<td>1000m</td>
</tr>
<tr>
<td>500kbit/s</td>
<td>400m</td>
</tr>
<tr>
<td>1.5Mbit/s</td>
<td>200m</td>
</tr>
<tr>
<td>3 ... 12Mbit/s</td>
<td>100m</td>
</tr>
</tbody>
</table>
- Max. 10 segments may be built up. The segments are connected via repeaters. Every repeater counts for one participant.
- All participants are communicating with the same transfer rate. The slaves adjust themselves automatically on the transfer rate.
- The bus has to be terminated at both ends.
- Master and slaves are free combinable.

**Transfer medium**

As transfer medium Profibus uses an isolated twisted-pair cable based upon the RS485 interface.

The RS485 interface is working with voltage differences. Though it is less irritable from influences than a voltage or a current interface. You are able to configure the network as well linear as in a tree structure.

Your VIPA CPU includes a 9pin slot "PBDP" where you connect the Profibus coupler into the Profibus network as a slave.

Max. 32 participants per segment are permitted. The segments are connected via repeaters. The maximum segment length depends on the transfer rate.

Profibus DP uses a transfer rate between 9.6kbit/s and 12Mbit/s, the slaves are following automatically. All participants are communicating with the same transfer rate.

The bus structure under RS485 allows an easy connection res. disconnection of stations as well as starting the system step by step. Later expansions don’t have any influence on stations that are already integrated. The system realizes automatically if one partner had a fail down or is new in the network.
Bus connection

The following picture illustrates the terminating resistors of the respective start and end station.

Note!
The Profibus line has to be terminated with its ripple resistor. Please make sure to terminate the last participants on the bus at both ends by activating the terminating resistor.

EasyConn bus connector

In systems with more than two stations all partners are wired in parallel. For that purpose, the bus cable must be feed-through uninterrupted.

Via the order number VIPA 972-0DP10 you may order the bus connector "EasyConn". This is a bus connector with switchable terminating resistor and integrated bus diagnostic.

<table>
<thead>
<tr>
<th></th>
<th>0°</th>
<th>45°</th>
<th>90°</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>64</td>
<td>61</td>
<td>66</td>
</tr>
<tr>
<td>B</td>
<td>34</td>
<td>53</td>
<td>40</td>
</tr>
<tr>
<td>C</td>
<td>15.8</td>
<td>15.8</td>
<td>15.8</td>
</tr>
</tbody>
</table>

all in mm
Note!
To connect this EasyConn plug, please use the standard Profibus cable type A (EN50170). Starting with release 5 you also can use highly flexible bus cable: Lapp Kabel order no.: 2170222, 2170822, 2170322.
With the order no. 905-6AA00 VIPA offers the "EasyStrip" de-isolating tool that makes the connection of the EasyConn much easier.

Dimensions in mm

Termination with "EasyConn"
The "EasyConn" bus connector is provided with a switch that is used to activate a terminating resistor.

Attention!
The terminating resistor is only effective, if the connector is installed at a slave and the slave is connected to a power supply.

Note!
A complete description of installation and deployment of the terminating resistors is delivered with the connector.

Assembly
- Loosen the screw.
- Lift contact-cover.
- Insert both wires into the ducts provided (watch for the correct line color as below!)
- Please take care not to cause a short circuit between screen and data lines!
- Close the contact cover.
- Tighten screw (max. tightening torque 4Nm).

Please note: The green line must be connected to A, the red line to B!
Commissioning and Start-up behavior

Start-up on delivery
In delivery the CPU is overall reset. The Profibus part is deactivated and its LEDs are off after Power ON.

Online with bus parameter without slave project
The DP master can be served with bus parameters by means of a hardware configuration. A soon as these are transferred the DP master goes online with his bus parameter. This is shown by the RUN LED. Now the DP master can be contacted via Profibus by means of his Profibus address. In this state the CPU can be accessed via Profibus to get configuration and DP slave project.

Slave configuration
If the master has received valid configuration data, he switches to Data Exchange with the DP Slaves. This is indicated by the DE-LED.

CPU state controls DP master
After Power ON respectively a receipt of a new hardware configuration the configuration data and bus parameter were transferred to the DP master. The DP master does not have any operation switch. His state is controlled by the RUN/STOP state of the CPU. Dependent on the CPU state the following behavior is shown by the DP master:

Master behavior at CPU RUN
- The global control command "Operate" is sent to the slaves by the master. Here the DE-LED is ON.
- Every connected DP slave is cyclically attended with an output telegram containing recent output data.
- The input data of the DP slaves were cyclically transferred to the input area of the CPU.

Master behavior at CPU RUN
- The global control command "Clear" is sent to the slaves by the master. Here the DE-LED is blinking.
- DP slaves with fail safe mode were provided with output telegram length "0".
- DP slaves without fail safe mode were provided with the whole output telegram but with output data = 0.
- The input data of the DP slaves were further cyclically transferred to the input area of the CPU.
Chapter 5  Deployment PtP communication

Overview

Content of this chapter is the deployment of the RS485 slot for serial PtP communication.
Here you’ll find all information about the protocols and project engineering of the interface, which are necessary for the serial communication using the RS485 interface.

<table>
<thead>
<tr>
<th>Content</th>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chapter 5  Deployment PtP communication</td>
<td>..................................................</td>
<td>5-1</td>
</tr>
<tr>
<td>Fast introduction</td>
<td>..................................................</td>
<td>5-2</td>
</tr>
<tr>
<td>Principle of the data transfer</td>
<td>..................................................</td>
<td>5-3</td>
</tr>
<tr>
<td>Deployment of RS485 interface for PtP</td>
<td>..................................................</td>
<td>5-4</td>
</tr>
<tr>
<td>Parameterization</td>
<td>..................................................</td>
<td>5-6</td>
</tr>
<tr>
<td>Communication</td>
<td>..................................................</td>
<td>5-9</td>
</tr>
<tr>
<td>Protocols and procedures</td>
<td>..................................................</td>
<td>5-15</td>
</tr>
<tr>
<td>Modbus - Function codes</td>
<td>..................................................</td>
<td>5-19</td>
</tr>
<tr>
<td>Modbus - Example communication</td>
<td>..................................................</td>
<td>5-23</td>
</tr>
</tbody>
</table>
Fast introduction

**General**
Via a hardware configuration you may de-activate the Profibus part integrated to the CPU 51xS and thus release the RS485 interface for PtP (point-to-point) communication.
The RS485 interface supports in PtP operation the serial process connection to different source res. destination systems.

**Protocols**
The protocols res. procedures ASCII, STX/ETX, 3964R, USS and Modbus are supported.

**Parameterization**
The parameterization of the serial interface happens during runtime using the SFC 216 (SER_CFG). For this you have to store the parameters in a DB for all protocols except ASCII.

**Communication**
The SFCs are controlling the communication. Send takes place via SFC 217 (SER_SND) and receive via SFC 218 (SER_RCV).
The repeated call of the SFC 217 SER_SND delivers a return value for 3964R, USS and Modbus via RetVal that contains, among other things, recent information about the acknowledgement of the partner station.
The protocols USS and Modbus allow to evaluate the receipt telegram by calling the SFC 218 SER_RCV after SER_SND.
The SFCs are included in the consignment of the CPU.

**Overview SFCs for serial communication**
The following SFCs are used for the serial communication:

<table>
<thead>
<tr>
<th>SFC</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SFC 216</td>
<td>SER_CFG</td>
</tr>
<tr>
<td>SFC 217</td>
<td>SER_SND</td>
</tr>
<tr>
<td>SFC 218</td>
<td>SER_RCV</td>
</tr>
</tbody>
</table>

RS485 parameterize
RS485 send
RS485 receive
Principle of the data transfer

Overview
The data transfer is handled during runtime by using SFCs. The principle of data transfer is the same for all protocols and is shortly illustrated in the following.

Principle
Data, which are written into the according data channel by the PLC, is stored in a FIFO send buffer (first in first out) with a size of 2x1024byte and then put out via the interface.

When the interface receives data, this is stored in a FIFO receive buffer with a size of 2x1024byte and can there be read by the PLC.

If the data is transferred via a protocol, the adoption of the data to the according protocol happens automatically.

In opposite to ASCII and STX/ETX, the protocols 3964R, USS and Modbus require the acknowledgement of the partner.

An additional call of the SFC 217 SER_SND causes a return value in RetVal that includes among others recent information about the acknowledgement of the partner.

Further on for USS and Modbus after a SER_SND the acknowledgement telegram must be evaluated by call of the SFC 218 SER_RCV.

RS485 PtP communication

<table>
<thead>
<tr>
<th>Program</th>
<th>Protocol</th>
<th>FIFO Buffer</th>
<th>Interface</th>
</tr>
</thead>
<tbody>
<tr>
<td>SER_RCV SFC 218</td>
<td>RECEIVE</td>
<td>1024Byte IN</td>
<td>RS485 RS485</td>
</tr>
<tr>
<td>SER_CFG SFC 216</td>
<td>CFG</td>
<td>1024Byte</td>
<td></td>
</tr>
<tr>
<td>SER_SND SFC 217</td>
<td>SEND</td>
<td>1024Byte OUT</td>
<td></td>
</tr>
</tbody>
</table>

An additional call of the SFC 217 SER_SND causes a return value in RetVal that includes among others recent information about the acknowledgement of the partner.

Further on for USS and Modbus after a SER_SND the acknowledgement telegram must be evaluated by call of the SFC 218 SER_RCV.
Deployment of RS485 interface for PtP

Switch to PtP operation

Per default, the RS485 interface X3 of the CPU is used for the Profibus DP master. Via hardware configuration the RS485 interfaces may be switched to point-to-point communication via the Parameter Function RS485 X3 of the Properties.

Hardware configuration

The hardware configuration happens as described at "Project engineering" by means of a virtual Profibus master system with the following approach:

- Start the Siemens hardware configurator.
- Configure the Siemens CPU 318-2AJ00 (6ES7 318-2AJ00-0AB0/V3.0).
- Configure a Siemens CP 343-1 (343-1EX11) for the internal Ethernet PG/OP channel.
- Configure the integrated CP 543 of the CPU 517/NET always as 2. CP after the placed Ethernet PG/OP channel as CP343-1 (343-1EX11).
- Configure always as last module a Siemens DP master CP 342-5 (342-5DA02 V5.0). Connect and parameterize it at operation mode "DP-Master".
- Connect the slave system "VIPA_SPEEDbus".
- For the slave system set the Profibus address 100.
- Configure at slot 0 the VIPA CPU 51xS of the hardware catalog from VIPA_SPEEDbus.
- By double clicking the placed CPU 51xS the properties dialog of the CPU may be opened.
- Switch the Parameter Function RS485 X3 to "PtP".

As soon as the project is transferred together with the PLC user program to the CPU, the parameters will be taken after start-up.
Properties RS485

- Logical states represented by voltage differences between the two cores of a twisted pair cable
- Serial bus connection in two-wire technology using half duplex mode
- Data communications up to a max. distance of 500m
- Data communication rate up to 115.2kbit/s

Connection RS485

9pin SubD jack

<table>
<thead>
<tr>
<th>Pin</th>
<th>Assignment</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>n.c.</td>
</tr>
<tr>
<td>2</td>
<td>M24V</td>
</tr>
<tr>
<td>3</td>
<td>RxD/TxD-P (Line B)</td>
</tr>
<tr>
<td>4</td>
<td>RTS</td>
</tr>
<tr>
<td>5</td>
<td>M5V</td>
</tr>
<tr>
<td>6</td>
<td>P5V</td>
</tr>
<tr>
<td>7</td>
<td>P24V</td>
</tr>
<tr>
<td>8</td>
<td>RxD/TxD-N (Line A)</td>
</tr>
<tr>
<td>9</td>
<td>n.c.</td>
</tr>
</tbody>
</table>

Connection

CPU - RS485

Periphery

RxD/TxD-P (B)
RxD/TxD-N (A)

Shield

RxD/TxD-P (B)
RxD/TxD-N (A)

...
Parameterization

SFC 216 (SER_CFG)

The parameterization happens during runtime deploying the SFC 216 (SER_CFG). You have to store the parameters for STX/ETX, 3964R, USS and Modbus in a DB.

<table>
<thead>
<tr>
<th>Name</th>
<th>Declaration</th>
<th>Type</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Protocol</td>
<td>IN</td>
<td>BYTE</td>
<td>1=ASCII, 2=STX/ETX, 3=3964R</td>
</tr>
<tr>
<td>Parameter</td>
<td>IN</td>
<td>ANY</td>
<td>Pointer to protocol-parameters</td>
</tr>
<tr>
<td>Baudrate</td>
<td>IN</td>
<td>BYTE</td>
<td>Number of the baudrate</td>
</tr>
<tr>
<td>CharLen</td>
<td>IN</td>
<td>BYTE</td>
<td>0=5Bit, 1=6Bit, 2=7Bit, 3=8Bit</td>
</tr>
<tr>
<td>Parity</td>
<td>IN</td>
<td>BYTE</td>
<td>0=None, 1=Odd, 2=Even</td>
</tr>
<tr>
<td>StopBits</td>
<td>IN</td>
<td>BYTE</td>
<td>1=1Bit, 2=1.5Bit, 3=2Bit</td>
</tr>
<tr>
<td>FlowControl</td>
<td>IN</td>
<td>BYTE</td>
<td>1 (fix)</td>
</tr>
<tr>
<td>RetVal</td>
<td>OUT</td>
<td>WORD</td>
<td>Return value (0 = OK)</td>
</tr>
</tbody>
</table>

Parameter description

All time settings for timeouts must be set as hexadecimal value. Find the hex value by multiply the wanted time in seconds with the baud rate.

Example: Wanted time 8ms at a baud rate of 19200Baud

Calculation: \(19200 \text{bit/s} \times 0.008\text{s} = 154\text{Bit} \rightarrow (9Ah)\)

Hex value is 9Ah.

Protocol

Here you fix the protocol to be used. You may choose between:

1: ASCII
2: STX/ETX
3: 3964R
4: USS Master
5: Modbus RTU Master
6: Modbus ASCII Master
Parameter (as DB)  

At ASCII protocol, this parameter is ignored.
At STX/ETX, 3964R, USS and Modbus you fix here a DB that contains the communication parameters and has the following structure for the according protocols:

**Data block at STX/ETX**

| DBB0: STX1 BYTE     | (1. Start-ID in hexadecimal) |
| DBB1: STX2 BYTE     | (2. Start-ID in hexadecimal) |
| DBB2: ETX1 BYTE     | (1. End-ID in hexadecimal)   |
| DBB3: ETX2 BYTE     | (2. End-ID in hexadecimal)   |
| DBW4: TIMEOUT WORD   | (max. delay time between 2 telegrams) |

**Note!**

The start res. end sign should always be a value <20, otherwise the sign is ignored!
With not used IDs please always enter FFh!

**Data block at 3964R**

| DBB0: Prio BYTE     | (The priority of both partners must be different) |
| DBB1: ConnAttmptNr BYTE | (Number of connection trials) |
| DBB2: SendAttmptNr BYTE | (Number of telegram retries) |
| DBW4: CharTimeout WORD | (Character delay time) |
| DBW6: ConfTimeout WORD | (Acknowledgement delay time) |

**Data block at USS**

| DBW0: Timeout WORD | (Delay time in) |

**Data block at Modbus-Master**

| DBW0: Timeout WORD | (Respond delay time) |

**Baudrate**

Velocity of data transfer in bit/s (Baud).

| 04h | 1200Baud |
| 05h | 1800Baud |
| 06h | 2400Baud |
| 07h | 4800Baud |
| 08h | 7200Baud |
| 09h | 9600Baud |
| 0Ah | 14400Baud |
| 0Bh | 19200Baud |
| 0Ch | 38400Baud |
| 0Dh | 57600Baud |
| 0 Eh | 115200Baud |

**CharLen**

Number of data bits where a character is mapped to.

| 0: 5Bit | 1: 6Bit | 2: 7Bit | 3: 8Bit |
Parity

The parity is -depending on the value- even or odd. For parity control, the information bits are extended with the parity bit that amends via its value ("0" or "1") the value of all bits to a defined status. If no parity is set, the parity bit is set to "1", but not evaluated.

0: NONE  1: ODD  2: EVEN

StopBits

The stop bits are set at the end of each transferred character and mark the end of a character.

1: 1Bit  2: 1.5Bit  3: 2Bit

FlowControl

The parameter FlowControl is ignored. When sending RST=1, when receiving RST=0.

RetVal SFC 216

(Error message SER_CFG)

<table>
<thead>
<tr>
<th>Error code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0000h</td>
<td>no error</td>
</tr>
<tr>
<td>809Ah</td>
<td>interface not found</td>
</tr>
<tr>
<td>8x24h</td>
<td>Error at SFC-Parameter x, with x:</td>
</tr>
<tr>
<td></td>
<td>1: Error at &quot;Protocol&quot;</td>
</tr>
<tr>
<td></td>
<td>2: Error at &quot;Parameter&quot;</td>
</tr>
<tr>
<td></td>
<td>3: Error at &quot;Baudrate&quot;</td>
</tr>
<tr>
<td></td>
<td>4: Error at &quot;CharLength&quot;</td>
</tr>
<tr>
<td></td>
<td>5: Error at &quot;Parity&quot;</td>
</tr>
<tr>
<td></td>
<td>6: Error at &quot;StopBits&quot;</td>
</tr>
<tr>
<td></td>
<td>7: Error at &quot;FlowControl&quot; (Parameter missing)</td>
</tr>
<tr>
<td>809xh</td>
<td>Error in SFC parameter value x, where x:</td>
</tr>
<tr>
<td></td>
<td>1: Error at &quot;Protocol&quot;</td>
</tr>
<tr>
<td></td>
<td>3: Error at &quot;Baudrate&quot;</td>
</tr>
<tr>
<td></td>
<td>4: Error at &quot;CharLength&quot;</td>
</tr>
<tr>
<td></td>
<td>5: Error at &quot;Parity&quot;</td>
</tr>
<tr>
<td></td>
<td>6: Error at &quot;StopBits&quot;</td>
</tr>
<tr>
<td></td>
<td>7: Error at &quot;FlowControl&quot;</td>
</tr>
<tr>
<td>8092h</td>
<td>Access error in parameter DB (DB too short)</td>
</tr>
<tr>
<td>828xh</td>
<td>Error in parameter x of DB parameter, where x:</td>
</tr>
<tr>
<td></td>
<td>1: Error 1. parameter</td>
</tr>
<tr>
<td></td>
<td>2: Error 2. parameter</td>
</tr>
<tr>
<td></td>
<td>...</td>
</tr>
</tbody>
</table>
Communication

Overview

The communication happens via the send and receive blocks SFC 217 (SER_SND) and SFC 218 (SER_RCV). The SFCs are included in the consignment of the CPU.

SFC 217 (SER_SND)

This block sends data via the serial interface.

The repeated call of the SFC 217 SER_SND delivers a return value for 3964R, USS and Modbus via RetVal that contains, among other things, recent information about the acknowledgement of the partner station. The protocols USS and Modbus require to evaluate the receipt telegram by calling the SFC 218 SER_RCV after SER_SND.

Parameter

<table>
<thead>
<tr>
<th>Name</th>
<th>Declaration</th>
<th>Type</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>DataPtr</td>
<td>IN</td>
<td>ANY</td>
<td>Pointer to Data Buffer for sending data</td>
</tr>
<tr>
<td>DataLen</td>
<td>OUT</td>
<td>WORD</td>
<td>Length of data sent</td>
</tr>
<tr>
<td>RetVal</td>
<td>OUT</td>
<td>WORD</td>
<td>Return value (0 = OK)</td>
</tr>
</tbody>
</table>

DataPtr

Here you define a range of the type Pointer for the send buffer where the data that has to be sent is stored. You have to set type, start and length.

Example: Data is stored in DB5 starting at 0.0 with a length of 124Byte.

DataPtr:=P#DB5.DBX0.0 BYTE 124

DataLen

Word where the number of the sent Bytes is stored.

At ASCII if data were sent by means of SFC 217 faster to the serial interface than the interface sends, the length of data to send could differ from the DataLen due to a buffer overflow. This should be considered by the user program.

With STX/ETX, 3964R, Modbus and USS always the length set in DataPtr is stored or 0.
Return values of the block:

<table>
<thead>
<tr>
<th>Error code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0000h</td>
<td>Send data - ready</td>
</tr>
<tr>
<td>1000h</td>
<td>Nothing sent (data length 0)</td>
</tr>
<tr>
<td>20xxh</td>
<td>Protocol executed error free with xx bit pattern for diagnosis</td>
</tr>
<tr>
<td>7001h</td>
<td>Data is stored in internal buffer - active (busy)</td>
</tr>
<tr>
<td>7002h</td>
<td>Transfer - active</td>
</tr>
<tr>
<td>80xxh</td>
<td>Protocol executed with errors with xx bit pattern for diagnosis (no acknowledgement by partner)</td>
</tr>
<tr>
<td>90xxh</td>
<td>Protocol not executed with xx bit pattern for diagnosis (no acknowledgement by partner)</td>
</tr>
<tr>
<td>8x24h</td>
<td>Error in SFC parameter x, where x:</td>
</tr>
<tr>
<td></td>
<td>1: Error in &quot;DataPtr&quot;</td>
</tr>
<tr>
<td></td>
<td>2: Error in &quot;DataLen&quot;</td>
</tr>
<tr>
<td>8122h</td>
<td>Error in parameter &quot;DataPtr&quot; (e.g. DB too short)</td>
</tr>
<tr>
<td>807Fh</td>
<td>Internal error</td>
</tr>
<tr>
<td>809Ah</td>
<td>Interface not found or interface is used for Profibus</td>
</tr>
<tr>
<td>809Bh</td>
<td>Interface not configured</td>
</tr>
</tbody>
</table>

Protocol specific RetVal values

**ASCII**

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>9000h</td>
<td>Buffer overflow (no data send)</td>
</tr>
<tr>
<td>9002h</td>
<td>Data too short (0Byte)</td>
</tr>
</tbody>
</table>

**STX/ETX**

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>9000h</td>
<td>Buffer overflow (no data send)</td>
</tr>
<tr>
<td>9001h</td>
<td>Data too long (&gt;1024Byte)</td>
</tr>
<tr>
<td>9002h</td>
<td>Data too short (0Byte)</td>
</tr>
<tr>
<td>9004h</td>
<td>Character not allowed</td>
</tr>
</tbody>
</table>

**3964R**

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>2000h</td>
<td>Send ready without error</td>
</tr>
<tr>
<td>80FFh</td>
<td>NAK received - error in communication</td>
</tr>
<tr>
<td>80FEh</td>
<td>Data transfer without acknowledgement of partner or error at acknowledgement</td>
</tr>
<tr>
<td>9000h</td>
<td>Buffer overflow (no data send)</td>
</tr>
<tr>
<td>9001h</td>
<td>Data too long (&gt;1024Byte)</td>
</tr>
<tr>
<td>9002h</td>
<td>Data too short (0Byte)</td>
</tr>
</tbody>
</table>
### USS

<table>
<thead>
<tr>
<th>Error code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>2000h</td>
<td>Send ready without error</td>
</tr>
<tr>
<td>8080h</td>
<td>Receive buffer overflow (no space for receipt)</td>
</tr>
<tr>
<td>8090h</td>
<td>Acknowledgement delay time exceeded</td>
</tr>
<tr>
<td>80F0h</td>
<td>Wrong checksum in respond</td>
</tr>
<tr>
<td>80FEh</td>
<td>Wrong start sign in respond</td>
</tr>
<tr>
<td>80FFh</td>
<td>Wrong slave address in respond</td>
</tr>
<tr>
<td>9000h</td>
<td>Buffer overflow (no data send)</td>
</tr>
<tr>
<td>9001h</td>
<td>Data too long (&gt;1024Byte)</td>
</tr>
<tr>
<td>9002h</td>
<td>Data too short (&lt;2Byte)</td>
</tr>
</tbody>
</table>

### Modbus RTU/ASCII Master

<table>
<thead>
<tr>
<th>Error code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>2000h</td>
<td>Send ready (positive slave respond)</td>
</tr>
<tr>
<td>2001h</td>
<td>Send ready (negative slave respond)</td>
</tr>
<tr>
<td>8080h</td>
<td>Receive buffer overflow (no space for receipt)</td>
</tr>
<tr>
<td>8090h</td>
<td>Acknowledgement delay time exceeded</td>
</tr>
<tr>
<td>80F0h</td>
<td>Wrong checksum in respond</td>
</tr>
<tr>
<td>80FDh</td>
<td>Length of respond too long</td>
</tr>
<tr>
<td>80FEh</td>
<td>Wrong function code in respond</td>
</tr>
<tr>
<td>80FFh</td>
<td>Wrong slave address in respond</td>
</tr>
<tr>
<td>9000h</td>
<td>Buffer overflow (no data send)</td>
</tr>
<tr>
<td>9001h</td>
<td>Data too long (&gt;1024Byte)</td>
</tr>
<tr>
<td>9002h</td>
<td>Data too short (&lt;2Byte)</td>
</tr>
</tbody>
</table>
The following text shortly illustrates the structure of programming a send command for the different protocols.

**3964R**

1. **SFC 217 SER_SND**
2. **Busy?**
   - **N**
   - **RetVal 8000h / 9000h ?**
     - **N**
     - **RetVal 2001h ?**
       - **N**
       - **RetVal 2000h ?**
         - **N**
3. **Data evaluation**
4. **End**

**USS / Modbus**

1. **SFC 217 SER_SND**
2. **Busy?**
   - **N**
   - **RetVal 8000h / 9000h ?**
     - **N**
     - **RetVal 2001h ?**
       - **N**
       - **RetVal 2000h ?**
         - **N**
3. **Error evaluation**
4. **End**

**ASCII / STX/ETX**

1. **SFC 217 SER_SND**
2. **RetVal 9000h**
   - **J**
   - **Error evaluation**
   - **End**
**SFC 218 (SER_RCV)**

This block receives data via the serial interface.

Using the SFC 218 SER_RCV after SER_SND with the protocols USS and Modbus the acknowledgement telegram can be read.

**Parameter**

<table>
<thead>
<tr>
<th>Name</th>
<th>Declaration</th>
<th>Type</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>DataPtr</td>
<td>IN</td>
<td>ANY</td>
<td>Pointer to Data Buffer for received data</td>
</tr>
<tr>
<td>DataLen</td>
<td>OUT</td>
<td>WORD</td>
<td>Length of received data</td>
</tr>
<tr>
<td>Error</td>
<td>OUT</td>
<td>WORD</td>
<td>Error Number</td>
</tr>
<tr>
<td>RetVal</td>
<td>OUT</td>
<td>WORD</td>
<td>Return value (0 = OK)</td>
</tr>
</tbody>
</table>

**DataPtr**

Here you set a range of the type Pointer for the receive buffer where the reception data is stored. You have to set type, start and length.

Example: Data is stored in DB5 starting at 0.0 with a length of 124Byte.

```
DataPtr := P#DB5.DBX0.0 BYTE 124
```

**DataLen**

Word where the number of received Bytes is stored.

At **STX/ETX** and **3964R**, the length of the received user data or 0 is entered.

At **ASCII**, the number of read characters is entered. This value may be different from the read telegram length.

**Error**

This word gets an entry in case of an error. The following error messages may be created depending on the protocol:

**ASCII**

<table>
<thead>
<tr>
<th>Bit</th>
<th>Error</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>overrun</td>
<td>Overflow, a sign couldn’t be read fast enough from the interface</td>
</tr>
<tr>
<td>1</td>
<td>framing error</td>
<td>Error that shows that a defined bit frame is not coincident, exceeds the allowed length or contains an additional Bit sequence (Stopbit error)</td>
</tr>
<tr>
<td>2</td>
<td>parity</td>
<td>Parity error</td>
</tr>
<tr>
<td>3</td>
<td>overflow</td>
<td>Buffer is full</td>
</tr>
</tbody>
</table>

**STX/ETX**

<table>
<thead>
<tr>
<th>Bit</th>
<th>Error</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>overflow</td>
<td>The received telegram exceeds the size of the receive buffer.</td>
</tr>
<tr>
<td>1</td>
<td>char</td>
<td>A sign outside the range 20h...7Fh has been received.</td>
</tr>
<tr>
<td>3</td>
<td>overflow</td>
<td>Buffer is full</td>
</tr>
</tbody>
</table>

**3964R / Modbus RTU/ASCII Master**

<table>
<thead>
<tr>
<th>Bit</th>
<th>Error</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>overflow</td>
<td>The received telegram exceeds the size of the receive buffer.</td>
</tr>
</tbody>
</table>
Return values of the block:

<table>
<thead>
<tr>
<th>Error code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0000h</td>
<td>no error</td>
</tr>
<tr>
<td>1000h</td>
<td>Receive buffer too small (data loss)</td>
</tr>
<tr>
<td>8x24h</td>
<td>Error at SFC-Parameter x, with x:</td>
</tr>
<tr>
<td></td>
<td>1: Error at &quot;DataPtr&quot;</td>
</tr>
<tr>
<td></td>
<td>2: Error at &quot;DataLen&quot;</td>
</tr>
<tr>
<td></td>
<td>3: Error at &quot;Error&quot;</td>
</tr>
<tr>
<td>8122h</td>
<td>Error in parameter &quot;DataPtr&quot; (e.g. DB too short)</td>
</tr>
<tr>
<td>809Ah</td>
<td>Serial interface not found res. interface is used by Profibus</td>
</tr>
<tr>
<td>809Bh</td>
<td>Serial interface not configured</td>
</tr>
</tbody>
</table>

Principles of programming

The following picture shows the basic structure for programming a receive command. This structure can be used for all protocols.
Protocols and procedures

Overview
The CPU supports the following protocols and procedures:
- ASCII communication
- STX/ETX
- 3964R
- USS
- Modbus

ASCII
ASCII data communication is one of the simple forms of data exchange. Incoming characters are transferred 1 to 1.
At ASCII, with every cycle the read-SFC is used to store the data that is in the buffer at request time in a parameterized receive data block. If a telegram is spread over various cycles, the data is overwritten. There is no reception acknowledgement. The communication procedure has to be controlled by the concerning user application.

STX/ETX
STX/ETX is a simple protocol with start and end ID, where STX stands for Start of Text and ETX for End of Text.
The STX/ETX procedure is suitable for the transfer of ASCII characters. It does not use block checks (BCC). Any data transferred from the periphery must be preceded by a start followed by the data characters and the end character.
Depending of the byte width the following ASCII characters can be transferred: 5Bit: not allowed: 6Bit: 20...3Fh, 7Bit: 20...7Fh, 8Bit: 20...FFh.
The effective data, which includes all the characters between Start and End are transferred to the PLC when the End has been received.
When data is send from the PLC to a peripheral device, any user data is handed to the SFC 217 (SER_SND) and is transferred with added Start- and End-ID to the communication partner.
Message structure:

```
| STX1 | STX2 | Z1 | Z2 | Zn | ETX1 | ETX2 |
```

You may define up to 2 Start- and End-IDs.
You may work with 1, 2 or no Start- and with 1, 2 or no End-ID. As Start-res. End-ID all Hex values from 01h to 1Fh are permissible. Characters above 1Fh are ignored. In the user data, characters below 20h are not allowed and may cause errors. The number of Start- and End-IDs may be different (1 Start, 2 End res. 2 Start, 1 End or other combinations). If no End-ID is defined, all read characters are transferred to the PLC after a parameterizable character delay time (Timeout).
The 3964R procedure controls the data transfer of a point-to-point link between the CPU and a communication partner. The procedure adds control characters to the message data during data transfer. These control characters may be used by the communication partner to verify the complete and error free receipt.

The procedure employs the following control characters:

- **STX** Start of Text
- **DLE** Data Link Escape
- **ETX** End of Text
- **BCC** Block Check Character
- **NAK** Negative Acknowledge

### Procedure

<table>
<thead>
<tr>
<th>Active partner</th>
<th>Passive partner</th>
</tr>
</thead>
<tbody>
<tr>
<td>STX</td>
<td></td>
</tr>
<tr>
<td>Monitor delayed acknowledgment</td>
<td></td>
</tr>
<tr>
<td>DLE</td>
<td></td>
</tr>
<tr>
<td>Message-data</td>
<td></td>
</tr>
<tr>
<td>DLE</td>
<td></td>
</tr>
<tr>
<td>ETX</td>
<td></td>
</tr>
<tr>
<td>BCC</td>
<td></td>
</tr>
<tr>
<td>Monitor delayed acknowledgment</td>
<td></td>
</tr>
<tr>
<td>DLE</td>
<td></td>
</tr>
</tbody>
</table>

You may transfer a maximum of 255Byte per message.

**Note!**

When a DLE is transferred as part of the information it is repeated to distinguish between data characters and DLE control characters that are used to establish and to terminate the connection (DLE duplication). The DLE duplication is reversed in the receiving station.

The 3964R procedure requires that a lower priority is assigned to the communication partner. When communication partners issue simultaneous send commands, the station with the lower priority will delay its send command.
The USS protocol (Universelle serielle Schnittstelle = universal serial interface) is a serial transfer protocol defined by Siemens for the drive and system components. This allows to build-up a serial bus connection between a superordinated master and several slave systems.

The USS protocol enables a time cyclic telegram traffic by presetting a fix telegram length.

The following features characterize the USS protocol:

- Multi point connection
- Master-Slave access procedure
- Single-Master-System
- Max. 32 participants
- Simple and secure telegram frame

You may connect 1 master and max. 31 slaves at the bus where the single slaves are addressed by the master via an address sign in the telegram. The communication happens exclusively in half-duplex operation.

After a send command, the acknowledgement telegram must be read by a call of the SFC 218 SER_RCV.

The telegrams for send and receive have the following structure:

**Master-Slave telegram**

<table>
<thead>
<tr>
<th>STX</th>
<th>LGE</th>
<th>ADR</th>
<th>PKE</th>
<th>IND</th>
<th>PWE</th>
<th>STW</th>
<th>HSW</th>
<th>BCC</th>
</tr>
</thead>
<tbody>
<tr>
<td>02h</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

| PKE | L  | H  | L  | H  | L  | H  | H  | L  |

**Slave-Master telegram**

<table>
<thead>
<tr>
<th>STX</th>
<th>LGE</th>
<th>ADR</th>
<th>PKE</th>
<th>IND</th>
<th>PWE</th>
<th>ZSW</th>
<th>HIW</th>
<th>BCC</th>
</tr>
</thead>
<tbody>
<tr>
<td>02h</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

| PKE | L  | H  | L  | H  | L  | H  | H  | BCC |

where

- STX: Start sign
- LGE: Telegram length
- ADR: Address
- PKE: Parameter ID
- IND: Index
- PWE: Parameter value
- STW: Control word
- ZSW: State word
- HSW: Main set value
- HIW: Main effective value
- BCC: Block Check Character

A request can be directed to a certain slave or be send to all slaves as broadcast message. For the identification of a broadcast message you have to set bit 5 to 1 in the ADR-Byte. Here the slave addr. (bit 0 ... 4) is ignored. In opposite to a "normal" send command, the broadcast does not require a telegram evaluation via SFC 218 SER_RCV. Only write commands may be sent as broadcast.
The Modbus protocol is a communication protocol that fixes a hierarchic structure with one master and several slaves. Physically, Modbus works with a serial half-duplex connection. There are no bus conflicts occurring, because the master can only communicate with one slave at a time. After a request from the master, this waits for a preset delay time for an answer of the slave. During the delay time, communication with other slaves is not possible. After a send command, the acknowledgement telegram must be read by a call of the SFC 218 SER_RCV.

The request telegrams send by the master and the respond telegrams of a slave have the following structure:

<table>
<thead>
<tr>
<th>Start sign</th>
<th>Slave address</th>
<th>Function Code</th>
<th>Data</th>
<th>Flow control</th>
<th>End sign</th>
</tr>
</thead>
</table>

**Broadcast with slave address = 0**

A request can be directed to a special slave or at all slaves as broadcast message. To mark a broadcast message, the slave address 0 is used. In opposite to a "normal" send command, the broadcast does not require a telegram evaluation via SFC 218 SER_RCV. Only write commands may be sent as broadcast.

**ASCII, RTU mode**

Modbus offers 2 different transfer modes:

- **ASCII mode**: Every Byte is transferred in the 2 sign ASCII code. The data are marked with a start and an end sign. This causes a transparent but slow transfer.
- **RTU mode**: Every Byte is transferred as one character. This enables a higher data pass through as the ASCII mode. Instead of start and end sign, a time control is used.

The mode selection happens during runtime by using the SFC 216 SER_CFG.

**Supported Modbus protocols**

The following Modbus Protocols are supported by the RS485 interface:

- Modbus RTU Master
- Modbus ASCII Master
Modbus - Function codes

Modbus has some naming conventions:

- Modbus differentiates between bit and word access; Bits = "Coils" and Words = "Register".
- Bit inputs are referred to as "Input-Status" and Bit outputs as "Coil-Status".
- Word inputs are referred to as "Input-Register" and Word outputs as "Holding-Register".

Normally the access at Modbus happens by means of the ranges 0x, 1x, 3x and 4x.
0x and 1x gives you access to digital Bit areas and 3x and 4x to analog word areas.
For the CPs from VIPA is not differentiating digital and analog data, the following assignment is valid:

0x: Bit area for master output data
    Access via function code 01h, 05h, 0Fh
1x: Bit area for master input data
    Access via function code 02h
3x: Word area for master input data
    Access via function code 04h
4x: Word area for master output data
    Access via function code 03h, 06h, 10h

A description of the function codes follows below.
Overview

With the following Modbus function codes a Modbus master can access a Modbus slave. The description always takes place from the point of view of the master:

<table>
<thead>
<tr>
<th>Code</th>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>01h</td>
<td>Read n Bits</td>
<td>Read n Bits of master output area 0x</td>
</tr>
<tr>
<td>02h</td>
<td>Read n Bits</td>
<td>Read n Bits of master input area 1x</td>
</tr>
<tr>
<td>03h</td>
<td>Read n Words</td>
<td>Read n Words of master output area 4x</td>
</tr>
<tr>
<td>04h</td>
<td>Read n Words</td>
<td>Read n Words of master input area 3x</td>
</tr>
<tr>
<td>05h</td>
<td>Write 1 Bit</td>
<td>Write 1 Bit to master output area 0x</td>
</tr>
<tr>
<td>06h</td>
<td>Write 1 Word</td>
<td>Write 1 Word to master output area 4x</td>
</tr>
<tr>
<td>0Fh</td>
<td>Write n Bits</td>
<td>Write n Bits to master output area 0x</td>
</tr>
<tr>
<td>10h</td>
<td>Write n Words</td>
<td>Write n Words to master output area 4x</td>
</tr>
</tbody>
</table>

Point of View of "Input" and "Output" data

The description always takes place from the point of view of the master. Here data, which were sent from master to slave, up to their target are designated as "output" data (OUT) and contrary slave data received by the master were designated as "input" data (IN).

Respond of the slave

If the slave announces an error, the function code is send back with an "ORed" 80h. Without an error, the function code is sent back.

Slave answer: Function code OR 80h → Error
Function code → OK

Byte sequence in a Word

For the Byte sequence in a Word is always valid:

<table>
<thead>
<tr>
<th>1 Word</th>
</tr>
</thead>
<tbody>
<tr>
<td>High</td>
</tr>
<tr>
<td>Low</td>
</tr>
<tr>
<td>Byte</td>
</tr>
<tr>
<td>Byte</td>
</tr>
</tbody>
</table>

Check sum CRC, RTU, LRC

The shown check sums CRC at RTU and LRC at ASCII mode are automatically added to every telegram. They are not shown in the data block.
### Read n Bits

**01h, 02h**

Code 01h: Read n Bits of master output area 0x
Code 02h: Read n Bits of master input area 1x

#### Command telegram

<table>
<thead>
<tr>
<th>Slave address</th>
<th>Function code</th>
<th>Address 1. Bit</th>
<th>Number of Bits</th>
<th>Check sum CRC/LRC</th>
</tr>
</thead>
<tbody>
<tr>
<td>1Byte</td>
<td>1Byte</td>
<td>1Word</td>
<td>1Word</td>
<td>1Word</td>
</tr>
</tbody>
</table>

#### Respond telegram

<table>
<thead>
<tr>
<th>Slave address</th>
<th>Function code</th>
<th>Number of read Bytes</th>
<th>Data 1. Byte</th>
<th>Data 2. Byte</th>
<th>Check sum CRC/LRC</th>
</tr>
</thead>
<tbody>
<tr>
<td>1Byte</td>
<td>1Byte</td>
<td>1Byte</td>
<td>1Byte</td>
<td>1Byte</td>
<td>1Word</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>max. 250Byte</td>
<td></td>
</tr>
</tbody>
</table>

### Read n Words

**03h, 04h**

03h: Read n Words of master output area 4x
04h: Read n Words master input area 3x

#### Command telegram

<table>
<thead>
<tr>
<th>Slave address</th>
<th>Function code</th>
<th>Address 1. Bit</th>
<th>Number of Words</th>
<th>Check sum CRC/LRC</th>
</tr>
</thead>
<tbody>
<tr>
<td>1Byte</td>
<td>1Byte</td>
<td>1Word</td>
<td>1Word</td>
<td>1Word</td>
</tr>
</tbody>
</table>

#### Respond telegram

<table>
<thead>
<tr>
<th>Slave address</th>
<th>Function code</th>
<th>Number of read Bytes</th>
<th>Data 1. Word</th>
<th>Data 2. Word</th>
<th>Check sum CRC/LRC</th>
</tr>
</thead>
<tbody>
<tr>
<td>1Byte</td>
<td>1Byte</td>
<td>1Byte</td>
<td>1Word</td>
<td>1Word</td>
<td>1Word</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>max. 125Words</td>
<td></td>
</tr>
</tbody>
</table>

### Write 1 Bit

**05h**

Code 05h: Write 1 Bit to master output area 0x

A status change is via "Status Bit" with following values:

"Status Bit" = 0000h → Bit = 0
"Status Bit" = FF00h → Bit = 1

#### Command telegram

<table>
<thead>
<tr>
<th>Slave address</th>
<th>Function code</th>
<th>Address Bit</th>
<th>Status Bit</th>
<th>Check sum CRC/LRC</th>
</tr>
</thead>
<tbody>
<tr>
<td>1Byte</td>
<td>1Byte</td>
<td>1Word</td>
<td>1Word</td>
<td>1Word</td>
</tr>
</tbody>
</table>

#### Respond telegram

<table>
<thead>
<tr>
<th>Slave address</th>
<th>Function code</th>
<th>Address Bit</th>
<th>Status Bit</th>
<th>Check sum CRC/LRC</th>
</tr>
</thead>
<tbody>
<tr>
<td>1Byte</td>
<td>1Byte</td>
<td>1Word</td>
<td>1Word</td>
<td>1Word</td>
</tr>
</tbody>
</table>
## Write 1 Word

### 06h

**Code 06h:** Write 1 Word to master output area 4x

**Command telegram**

<table>
<thead>
<tr>
<th>Slave address</th>
<th>Function code</th>
<th>Address word</th>
<th>Value word</th>
<th>Check sum CRC/LRC</th>
</tr>
</thead>
<tbody>
<tr>
<td>1Byte</td>
<td>1Byte</td>
<td>1Word</td>
<td>1Word</td>
<td>1Word</td>
</tr>
</tbody>
</table>

**Respond telegram**

<table>
<thead>
<tr>
<th>Slave address</th>
<th>Function code</th>
<th>Address word</th>
<th>Value word</th>
<th>Check sum CRC/LRC</th>
</tr>
</thead>
<tbody>
<tr>
<td>1Byte</td>
<td>1Byte</td>
<td>1Word</td>
<td>1Word</td>
<td>1Word</td>
</tr>
</tbody>
</table>

## Write n Bits

### 0Fh

**Code 0Fh:** Write n Bits to master output area 0x

Please regard that the number of Bits has additionally to be set in Byte.

**Command telegram**

<table>
<thead>
<tr>
<th>Slave address</th>
<th>Function code</th>
<th>1. Bit</th>
<th>Number of Bits</th>
<th>Number of Bytes</th>
<th>Data 1. Byte</th>
<th>Data 2. Byte</th>
<th>...</th>
<th>Check sum CRC/LRC</th>
</tr>
</thead>
<tbody>
<tr>
<td>1Byte</td>
<td>1Byte</td>
<td>1Word</td>
<td>1Word</td>
<td>1Byte</td>
<td>1Byte</td>
<td>1Byte</td>
<td>1Byte</td>
<td>1Word</td>
</tr>
</tbody>
</table>

**Respond telegram**

<table>
<thead>
<tr>
<th>Slave address</th>
<th>Function code</th>
<th>1. Bit</th>
<th>Number of Bits</th>
<th>Check sum CRC/LRC</th>
</tr>
</thead>
<tbody>
<tr>
<td>1Byte</td>
<td>1Byte</td>
<td>1Word</td>
<td>1Word</td>
<td>1Word</td>
</tr>
</tbody>
</table>

## Write n Words

### 10h

**Code 10h:** Write n Words to master output area 4x

**Command telegram**

<table>
<thead>
<tr>
<th>Slave address</th>
<th>Function code</th>
<th>Address 1. Word</th>
<th>Number of words</th>
<th>Number of Bytes</th>
<th>Data 1. Word</th>
<th>Data 2. Word</th>
<th>...</th>
<th>Check sum CRC/LRC</th>
</tr>
</thead>
<tbody>
<tr>
<td>1Byte</td>
<td>1Byte</td>
<td>1Word</td>
<td>1Word</td>
<td>1Byte</td>
<td>1Word</td>
<td>1Word</td>
<td>1Word</td>
<td>1Word</td>
</tr>
</tbody>
</table>

**Respond telegram**

<table>
<thead>
<tr>
<th>Slave address</th>
<th>Function code</th>
<th>Address 1. Word</th>
<th>Number of Words</th>
<th>Check sum CRC/LRC</th>
</tr>
</thead>
<tbody>
<tr>
<td>1Byte</td>
<td>1Byte</td>
<td>1Word</td>
<td>1Word</td>
<td>1Word</td>
</tr>
</tbody>
</table>
Modbus - Example communication

Outline
The example establishes a communication between a master and a slave via Modbus. The following combination options are shown:

- Modbus master (M) Modbus slave (S)
- CPU 51xS CPU 21xSER-1

Components
The following components are required for this example:

- CPU 51xS as Modbus RTU master
- CPU 21xSER-1 as Modbus RTU slave
- Siemens SIMATIC Manager and possibilities for the project transfer
- Modbus cable connection

Approach
- Assemble a Modbus system consisting of a CPU 51xS as Modbus master and a CPU 21xSER-1 as Modbus slave and Modbus cable.
- Execute the project engineering of the master!
  For this you create a PLC user application with the following structure:
  - OB 100: Call SFC 216 (configuration as Modbus RTU master) with timeout setting and error evaluation.
  - OB 1: Call SFC 217 (SER_SND) where the data is send with error evaluation. Here you have to build up the telegram according to the Modbus rules.
  - Call SFC 218 (SER_RECV) where the data is received with error evaluation.
- Execute the project engineering of the slave!
  The PLC user application at the slave has the following structure:
  - OB 100: Call SFC 216 (configuration as Modbus RTU slave) with timeout setting and Modbus address in the DB and error evaluation.
  - OB 1: Call SFC 217 (SER_SND) for data transport from the slave CPU to the output buffer.
  - Call SFC 218 (SER_RECV) for the data transport from the input buffer to the CPU. Allow an according error evaluation for both directions.

The following page shows the structure for the according PLC programs for master and slave.
Master

CPU 51xS

Slave

CPU 21xSER-1

OB100:

Start

SFC 216  
SER_CFG  
(DB: Timeout)

RetVal 0000h  ?

RetVal 8xxxh  ?

Error evaluation

OB1:

Start

SFC 216  
SER_CFG  
(DB: Timeout, slave address)

RetVal 0000h  ?

RetVal 8xxxh  ?

Error evaluation

SFC 217

SER SND

(Save Slave-Nr., Code, Bereich)

RetVal 700xh  ?

RetVal 0000h  ?

RetVal 2000h  ?

RetVal 2001h  ?

RetVal 9001h  ?

RetVal 0000h  ?

SFC 218

SER RCV

(Data evaluation, Error evaluation)

SFC 217

SER SND

(Save Slave-Nr., Code, Bereich)

RetVal 700xh  ?

RetVal 0000h  ?

RetVal 2000h  ?

RetVal 2001h  ?

RetVal 9001h  ?

RetVal 0000h  ?

SFC 218

SER RCV

(Data evaluation, Error evaluation)
Chapter 6  Deployment Ethernet communication

Overview

In this chapter the communication via Ethernet is described. Please regard the chapter "Fast introduction" where you will find every information compressed required for the project engineering of the CPU 517S/NET with CP 543. After the fast introduction, the mentioned steps are described in detail.

Content

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Chapter 6  Deployment Ethernet communication</strong></td>
<td>6-1</td>
</tr>
<tr>
<td>Basics - Industrial Ethernet in automation</td>
<td>6-2</td>
</tr>
<tr>
<td>Basics - ISO/OSI reference model</td>
<td>6-3</td>
</tr>
<tr>
<td>Basics - Terms</td>
<td>6-6</td>
</tr>
<tr>
<td>Basics - Protocols</td>
<td>6-7</td>
</tr>
<tr>
<td>Basics - IP address and subnet</td>
<td>6-11</td>
</tr>
<tr>
<td>Basics - MAC address and TSAP</td>
<td>6-13</td>
</tr>
<tr>
<td>Fast introduction</td>
<td>6-14</td>
</tr>
<tr>
<td>Hardware configuration</td>
<td>6-18</td>
</tr>
<tr>
<td>Configure connections</td>
<td>6-20</td>
</tr>
<tr>
<td>Communication connections in the user program</td>
<td>6-30</td>
</tr>
<tr>
<td>NCM diagnostic - Help for error diagnostic</td>
<td>6-37</td>
</tr>
<tr>
<td>Coupling to other systems</td>
<td>6-40</td>
</tr>
</tbody>
</table>
Basics - Industrial Ethernet in automation

Overview

The flow of information in a company presents a vast spectrum of requirements that must be met by the communication systems. Depending on the area of business the bus system or LAN must support a different number of users, different volumes of data must be transferred and the intervals between transfers may vary, etc.

It is for this reason that different bus systems are employed depending on the respective task. These may be subdivided into different classes. The following model depicts the relationship between the different bus systems and the hierarchical structures of a company:

<table>
<thead>
<tr>
<th>Operational layer</th>
<th>Management layer</th>
<th>System layer</th>
<th>Prozess layer</th>
<th>Sensor / actuator layer</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plant computer PPS CAD</td>
<td>Plant-oriented control computer, manufacturing, stock, production data PPS CAD</td>
<td>Machine and control computer</td>
<td>Peripheral systems, machines, CNC, NC, controllers (PLC), measuring systems</td>
<td>Peripheral components sensor, actuator, regulator, multiplexer, operating consoles</td>
</tr>
</tbody>
</table>

**Industrial Ethernet**

Industrial Ethernet is an electrical net based on shielded twisted pair cabling or optical net based on optical fiber.

Industrial Ethernet is defined by the international standard IEEE 802.3. The net access of Industrial Ethernet corresponds to IEEE 802.3 - CSMA/CD (Carrier Sense Multiple Access/Collision Detection) scheme: every station "listens" on the bus cable and receives communication messages that are addressed to it.

Stations will only initiate a transmission when the line is unoccupied. In the event that two participants should start transmitting simultaneously, they will detect this and stop transmitting to restart after a random delay time has expired.

Using switches there is the possibility for communication without collisions.
Basics - ISO/OSI reference model

Overview

The ISO/OSI reference model is based on a proposal that was developed by the International Standards Organization (ISO). This represents the first step towards an international standard for the different protocols. It is referred to as the ISO-OSI layer model. OSI is the abbreviation for Open System Interconnection, the communication between open systems. The ISO/OSI reference model does not represent a network architecture as it does not define the services and protocols used by the different layers. The model simply specifies the tasks that the different layers must perform.

All current communication systems are based on the ISO/OSI reference model, which is defined by the ISO 7498 standard. The reference model structures communication systems into 7 layers that cover different communication tasks. In this manner the complexity of the communication between different systems is divided amongst different layers to simplify the task.

The following layers have been defined:

<table>
<thead>
<tr>
<th>Layer</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Layer 7</td>
<td>Application Layer</td>
</tr>
<tr>
<td>Layer 6</td>
<td>Presentation Layer</td>
</tr>
<tr>
<td>Layer 5</td>
<td>Session Layer</td>
</tr>
<tr>
<td>Layer 4</td>
<td>Transport Layer</td>
</tr>
<tr>
<td>Layer 3</td>
<td>Network Layer</td>
</tr>
<tr>
<td>Layer 2</td>
<td>Data Link Layer</td>
</tr>
<tr>
<td>Layer 1</td>
<td>Physical Layer</td>
</tr>
</tbody>
</table>

Depending on the complexity and the requirements of the communication mechanisms a communication system may use a subset of these layers.
Layers  

Layer 1  
Bit communication layer (physical layer)  
The bit communication layer (physical layer) is concerned with the transfer of data bits via the communication channel. This layer is therefore responsible for the mechanical, electrical and the procedural interfaces and the physical communication medium located below the bit communication layer:

- Which voltage represents a logical 0 or a 1?
- The minimum time the voltage is present to be recognized as a bit.
- The pin assignment of the respective interface.

Layer 2  
Security layer (data link layer)  
This layer performs error-checking functions for bit strings transferred between two communicating partners. This includes the recognition and correction or flagging of communication errors and flow control functions.

The security layer (data link layer) converts raw communication data into a sequence of frames. This is where frame limits are inserted on the transmitting side and where the receiving side detects them. These limits consist of special bit patterns that are inserted at the beginning and at the end of every frame. The security layer often also incorporates flow control and error detection functions.

The data security layer is divided into two sub-levels, the LLC and the MAC level.

The MAC (Media Access Control) is the lower level and controls how senders are sharing a single transmit channel.

The LLC (Logical Link Control) is the upper level that establishes the connection for transferring the data frames from one device into the other.

Layer 3  
Network layer  
The network layer is an agency layer.

Business of this layer is to control the exchange of binary data between stations that are not directly connected. It is responsible for the logical connections of layer 2 communications. Layer 3 supports the identification of the single network addresses and the establishing and disconnecting of logical communication channels.

Additionally, layer 3 manages the prior transfer of data and the error processing of data packets. IP (Internet Protocol) is based on Layer 3.

Layer 4  
Transport layer  
Layer 4 connects the network structures with the structures of the higher levels by dividing the messages of higher layers into segments and passes them on to the network layer. Hereby, the transport layer converts the transport addresses into network addresses.

Common transport protocols are: TCP, SPX, NWLink and NetBEUI.
Layer 5  
Session layer  
The session layer is also called the communication control layer. It relieves the communication between service deliverer and the requestor by establishing and holding the connection if the transport system has a short time fail out. 
At this layer, logical users may communicate via several connections at the same time. If the transport system fails, a new connection is established if needed.
Additionally this layer provides methods for control and synchronization tasks.

Layer 6  
Presentation layer  
This layer manages the presentation of the messages, when different network systems are using different representations of data.
Layer 6 converts the data into a format that is acceptable for both communication partners.
Here compression/decompression and encrypting/decrypting tasks are processed.
This layer is also called interpreter. A typical use of this layer is the terminal emulation.

Layer 7  
Application layer  
The application layer is the link between the user application and the network. The tasks of the application layer include the network services like file, print, message, data base and application services as well as the according rules.
This layer is composed from a series of protocols that are permanently expanded following the increasing needs of the user.
Basics - Terms

**Network (LAN)**

A network res. LAN (Local Area Network) provides a link between different stations that enables them to communicate with each other.

Network stations consist of PCs, IPCs, TCP/IP adapters, etc.

Network stations are separated by a minimum distance and connected by means of a network cable. The combination of network stations and the network cable represent a complete segment.

All the segments of a network form the Ethernet (physics of a network).

**Twisted Pair**

In the early days of networking the Triaxial- (yellow cable) or thin Ethernet cable (Cheapernet) was used as communication medium. This has been superseded by the twisted-pair network cable due to its immunity to interference. The CPU has a twisted-pair connector.

The twisted-pair cable consists of 8 cores that are twisted together in pairs. Due to these twists this system is provides an increased level of immunity to electrical interference. For linking please use twisted pair cable which at least corresponds to the category 5.

Where the coaxial Ethernet networks are based on a bus topology the twisted-pair network is based on a point-to-point scheme.

The network that may be established by means of this cable has a star topology. Every station is connected to the star coupler (hub/switch) by means of a separate cable. The hub/switch provides the interface to the Ethernet.

**Hub (repeater)**

The hub is the central element that is required to implement a twisted-pair Ethernet network.

It is the job of the hub to regenerate and to amplify the signals in both directions. At the same time it must have the facility to detect and process segment wide collisions and to relay this information. The hub is not accessible by means of a separate network address since it is not visible to the stations on the network.

A hub has provisions to interface to Ethernet or to another hub res. switch.

**Switch**

A switch also is a central element for realizing Ethernet on Twisted Pair. Several stations res. hubs are connected via a switch. Afterwards they are able to communicate with each other via the switch without interfering the network. An intelligent hardware analyzes the incoming telegrams of every port of the switch and passes them collision free on to the destination stations of the switch. A switch optimizes the bandwidth in every connected segment of a network. Switches enable exclusive connections between the segments of a network changing at request.
Basics - Protocols

Overview
Protocols define a set of instructions or standards that enable computer to establish communication connections and exchange information as error free as possible. A commonly established protocol for the standardization of the complete computer communication is the so called ISO/OSI layer model, a model based upon seven layers with rules for the usage of hardware and software (see ISO/OSI reference model above).

The CPU from VIPA uses the following protocols:
- Siemens S7 connections
- TCP/IP
- UDP
- RFC1006 (ISO on TCP)
- ISO transport (once H1)

The protocols are described in the following:

Siemens S7 connections
With the Siemens S7 connection large data sets may be transferred between PLC systems based on Siemens STEP 7. Here the stations are connected via Ethernet.

Besides the communication connection a CPU may be controlled by an other CPU by means of the remote functions with the appropriate function block to set these e.g. to STOP.

Precondition for the Siemens S7 communication is a configured connection table, which contains the defined connections for communication.

Here WinPLC7 from VIPA or NetPro from Siemens may be used.

Properties
- A communication connection is specified by a connection ID for each connection partner.
- The acknowledgement of the data transfer is established from the partner station at level 7 of the ISO/OSI reference model.
- At the PLC side FB/SFB VIPA handling blocks are necessary for data transfer for the Siemens S7 connections.

Note!
More about the usage of the FB/SFB VIPA handling blocks concerning the S7 connections may be found in the manual "Operation list" of the CPU.
TCP/IP protocols are available on all major systems. At the bottom end this applies to simple PCs, through to the typical mini-computer up to mainframes.

For the wide spread of Internet accesses and connections, TCP/IP is often used to assemble heterogeneous system pools.

TCP/IP, standing for Transmission Control Protocol and Internet Protocol, collects a various range of protocols and functions.

TCP and IP are only two of the protocols required for the assembly of a complete architecture. The application layer provides programs like "FTP" and "Telnet" for the PC.

The application layer of the Ethernet CP is defined with the user application using the standard handling blocks.

These user applications use the transport layer with the protocols TCP and UDP for the data transfer which themselves communicate via the IP protocol with the Internet layer.

IP

The Internet protocol covers the network layer (Layer 3) of the ISO/OSI layer model.

The purpose of IP is to send data packages from on PC to another passing several other PCs. These data packages are referred to as datagrams. The IP doesn't neither guarantee the correct sequence of the datagrams nor the delivery at the receiver.

For the unambiguous identification between sender and receiver 32Bit addresses (IP addresses) are used that are normally written as four octets (exactly 8bit), e.g. 172.16.192.11.

These Internet addresses are defined and assigned worldwide from the DDN network (Defense Department Network), thus every user may communicate with all other TCP/IP users.

One part of the address specifies the network; the rest serves the identification of the participants inside the network. The boarder between the network and the host part is variable and depends on the size of the network.

To save IP addresses, so called NAT router are used that have one official IP address and cover the network. Then the network can use any IP address.

TCP

The TCP (Transmission Control Protocol) bases directly on the IP and thus covers the transport layer (layer 4) of the ISO/OSI layer model. TCP is a connection orientated end-to-end protocol and serves the logic connection between two partners.

TCP guarantees the correct sequence and reliability of the data transfer. Therefore you need a relatively large protocol overhead that slows down the transfer speed.

Every datagram gets a header of at least 20Byte. This header also contains a sequence number identifying the series. This has the consequence that the single datagrams may reach the destination on different ways through the network.

Using TCP connections, the telegram length is not transmitted. This means that the recipient has to know how many bytes belong to a message. To transfer data with variable length you may begin the user data with the length information and evaluate this at the counter station.
Besides of the IP address ports are used for the addressing. A port address should be within the range of 2000...65535. Partner and local ports may only be identical at one connection.

Not depending on the used protocol, the PLC needs the VIPA handling blocks AG_SEND (FC 5) and AG_RECV (FC 6) for data transfer.

The UDP (User Datagram Protocol) is a connection free transport protocol. It has been defined in the RFC768 (Request for Comment). Compared to TCP, it has much fewer characteristics.

The addressing happens via port numbers.

UDP is a fast unsafe protocol for it doesn't neither care about missing data packages nor about their sequence.

The TCP transport service works stream orientated. This means that data packages assembled by the user not necessarily have to receive the partner in the same packaging. Depending on the data amount, packages may though come in the correct sequence but differently packed. This causes that the recipient may not recognize the package borders anymore. For example you may send 2x 10Byte packages but the counter station receives them as 20Byte package. But for most of the applications the correct packaging is important.

Due to this you need another protocol above TCP. This purpose is defined in the protocol RFC1006. The protocol definition describes the function of an ISO transport interface (ISO 8072) basing upon the transport interface TCP (RFC793).

The basic protocol of RFC1006 is nearly identical to TP0 (Transport Protocol, Class 0) in ISO 8073.

For RFC1006 is run as protocol for TCP, the decoding takes place in the data section of the TCP package.

The receipt of data is confirmed by a TCP layer.

Instead of ports TSAPs are used for the addressing besides of the IP address. The TSAP length may be 1 ... 16 characters. The entry may happen in ASCII or Hex format. Remote and local TSAPs may only be identical at 1 connection.

Not depending on the used protocol, the PLC needs the VIPA handling blocks AG_SEND (FC 5) and AG_RECV (FC 6) for data transfer.

Contrary to TCP different telegram lengths can be received using RFC1006.
ISO transport (once H1)

The ISO transport service (ISO 8073 class 4) corresponds to the transport layer (Layer 4) of the ISO/OSI reference model. With ISO transport connections there is the possibility for program and event controlled communication via Industrial Ethernet. Here data blocks may be exchanged bi-directional.

The ISO transport connection offers services for a safety transfer of data by means of configured connections. Large data blocks may be transferred by means of blocking.

The transmission reliability is very high by the automatic repetition, by additional block test mechanisms and by the receipt acknowledgement at the receiver side. ISO transport connections are exclusively transferred via Industrial Ethernet and they are optimized for the deployment in a closed manufacturing area.

Properties

- ISO transport connections are only suited for Industrial Ethernet
- The receipt of data is acknowledged by the partner station. Here different telegram lengths may be processed.
- The addressing happens by MAC address (Ethernet address) and TSAPs (Transport Service Access Point).
- The data transfer is made by the services SEND/RECEIVE and FETCH/WRITE.
- Independent on the used protocol, the PLC needs the VIPA handling blocks AG_SEND (FC 5) and AG_RECV (FC 6) for data transfer.
Basics - IP address and subnet

**IP address structure**

Industrial Ethernet exclusively supports IPv4. At IPv4 the IP address is a 32Bit address that must be unique within the network and consists of 4 numbers that are separated by a dot.

Every IP address is a combination of a **Net-ID** and a **Host-ID** and its structure is as follows:  

```
XXX.XXX.XXX.XXX
```

Range: 000.000.000.000 to 255.255.255.255

The network administrator also defines IP addresses.

**Net-ID**

The **Net**work-ID identifies a network res. a network controller that administrates the network.

**Host-ID**

The **Host-ID** marks the network connections of a participant (host) to this network.

**Subnet mask**

The Host-ID can be further divided into a **Subnet-ID** and a **new Host-ID** by using a bit for bit AND assignment with the **Subnet mask**.

The area of the original Host-ID that is overwritten by 1 of the Subnet mask becomes the Subnet-ID, the rest is the new Host-ID.

| Subnet mask | binary all "1" | binary all "0"
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>IPv4 address</td>
<td>Net-ID</td>
<td>Host-ID</td>
</tr>
<tr>
<td>Subnet mask and IPv4 address</td>
<td>Net-ID</td>
<td>Subnet-ID</td>
</tr>
</tbody>
</table>

**Subnet**

A TCP-based communication via point-to-point, hub or switch connection is only possible between stations with identical Network-ID and Subnet-ID! Different area must be connected with a router.

The subnet mask allows you to sort the resources following your needs. This means e.g. that every department gets an own subnet and thus does not interfere another department.

**Address at first start-up**

At the first start-up of the CPU, the Ethernet PG/OP channel and the CP 343 part of the CPU do not have an IP address. The assignment takes place using the following possibilities:

- Using Siemens SIMATIC manager switch PG/PC interface to "TCP/IP... RFC1006". Via "Assign Ethernet address" search the appropriate CP and assign IP parameters. After that the CP is directly assigned to the new IP parameters without any restart of the CPU.
- You may assign an IP address and a subnet mask to your CP with the help of a "minimum project" and transfer this via MMC or MPI into the CPU. After a reboot of the CPU and after switching the PG/PC interface to "TCP/IP... RFC1006" you may now configure your CPU online via the favored CP.
For IPv4 addresses there are five address formats (class A to class E) that are all of a length of 4byte = 32bit.

<table>
<thead>
<tr>
<th>Class</th>
<th>Network-ID</th>
<th>Host-ID</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>0 Network-ID (1+7bit)</td>
<td>Host-ID (24bit)</td>
</tr>
<tr>
<td>B</td>
<td>10 Network-ID (2+14bit)</td>
<td>Host-ID (16bit)</td>
</tr>
<tr>
<td>C</td>
<td>110 Network-ID (3+21bit)</td>
<td>Host-ID (8bit)</td>
</tr>
<tr>
<td>D</td>
<td>1110 Multicast group</td>
<td></td>
</tr>
<tr>
<td>E</td>
<td>11110 Reserved</td>
<td></td>
</tr>
</tbody>
</table>

The classes A, B and C are used for individual addresses, class D for multicast addresses and class E is reserved for special purposes. The address formats of the 3 classes A, B, C are only differing in the length of Network-ID and Host-ID.

To build up private IP-Networks within the Internet, RFC1597/1918 reserves the following address areas:

<table>
<thead>
<tr>
<th>Network class</th>
<th>Start IP</th>
<th>End IP</th>
<th>Standard subnet mask</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>10.0.0.0</td>
<td>10.255.255.255</td>
<td>255.0.0.0</td>
</tr>
<tr>
<td>B</td>
<td>172.16.0.0</td>
<td>172.31.255.255</td>
<td>255.255.0.0</td>
</tr>
<tr>
<td>C</td>
<td>192.168.0.0</td>
<td>192.168.255.255</td>
<td>255.255.255.0</td>
</tr>
</tbody>
</table>

(The Host-ID is underlined.)

These addresses can be used as net-ID by several organizations without causing conflicts, for these IP addresses are neither assigned in the Internet nor are routed in the Internet.

Some Host-IDs are reserved for special purposes.

<table>
<thead>
<tr>
<th>Host-ID</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Identifier of this network, reserved!</td>
</tr>
<tr>
<td>Maximum (binary complete &quot;1&quot;)</td>
<td>Broadcast address of this network</td>
</tr>
</tbody>
</table>

Note!

Never choose an IP address with Host-ID=0 or Host-ID=maximum! (e.g. for class B with subnet mask = 255.255.0.0, the "172.16.0.0" is reserved and the "172.16.255.255" is occupied as local broadcast address for this network.)
Basics - MAC address and TSAP

MAC address
There is a unique MAC address (Media Access Control) necessary for each CP. Usually a module is labeled with its MAC address by the manufacturer. This address should be used for project engineering of the CP. The MAC address has a length of 6 bytes.

On delivery the first three bytes specify the manufacturer. These bytes are assigned by the IEEE committee. The last three bytes may be assigned by the manufacturer.

In a network several stations with the same MAC address may not exist. The MAC address may be changed at any time. You will get a valid MAC address from your network administrator.

Broadcast address
The MAC address, with which all bits are set to 1, is:
FF-FF-FF-FF-FF-FF
This address is used as Broadcast address and addresses all participants in the net.

Address at first start-up
At the first-start-up the CP 343 of the CPU has an unique MAC address. This may be found on a label beneath the front flap.

Note!
Please regard for the configuration of the network in the Siemens SIMATIC manager that it is necessary to activate the ISO protocol and to preset a valid MAC address within the properties dialog of the Ethernet interface of the CP!

TSAP
TSAP means Transport Service Access Point. ISO transport connections support TSAP length of 1...16 byte. TSAPs may be entered in ASCII format or hexadecimal.

Address parameters
An ISO transport connection is specified by a local and a remote connection endpoint.

<table>
<thead>
<tr>
<th>Station A</th>
<th>→</th>
<th>ISO transport-connection</th>
<th>←</th>
<th>Station B</th>
</tr>
</thead>
<tbody>
<tr>
<td>remote TSAP</td>
<td></td>
<td></td>
<td></td>
<td>local TSAP</td>
</tr>
<tr>
<td>local TSAP</td>
<td></td>
<td></td>
<td></td>
<td>remote TSAP</td>
</tr>
<tr>
<td>MAC address A</td>
<td></td>
<td></td>
<td></td>
<td>MAC address B</td>
</tr>
</tbody>
</table>

The TSAPs of an ISO transport connection must match as follows:
Remote TSAP (in CP) = local TSAP (in destination station)
Local TSAP (in CP) = remote TSAP (in destination station)
Fast introduction

Overview

At the first start-up respectively at an over all reset the Ethernet PG/OP channel and CP 543 of the CPU do not have any IP address. The CPs may only be contacted by its MAC addresses. IP address parameters may be assigned to the CPs by means of the MAC addresses, which may be found on labels beneath the front flap with the sequence 1. address PG/OP channel and beneath address of the CP 543. The assignment takes place directly via the hardware configuration of the Siemens SIMATIC manager. For the project engineering of the CPU 517S/NET with CP 543 please follow this approach:

- Assembly and commissioning
- Hardware configuration (Inclusion of CP in CPU)
- CP project engineering via NetPro (connection to Ethernet)
- PLC programming via user application (connection to PLC)
- Transfer of the complete project to CPU

Note

To be compatible to the Siemens SIMATIC Manager, the CPU 517S/NET from VIPA is to be configured as

CPU 318-2 (6ES7 318-2AJ00-0AB0)!

The Ethernet PG/OP channel of the CPU 517S/NET is always to be configured as CP343-1 (343-1EX11) from Siemens. The CP 543 of the CPU is always to be configured below the before configured PG/OP channel also as CP343-1 (343-1EX11).

Assembly and commissioning

- Install your CPU 517S/NET at a free PCI slot.
- Attach external voltage supply and note that your PC is connected with the network.
- Switch on the voltage supply.
  → After a short boot time, the CP is in idle mode. At the first commissioning res. after an overall reset of the CPU, the CP does not have an IP address. For control purposes you may now reach the CP via the MAC address. The MAC address is to be found at a small label on the board.
Assign IP Address parameters

You get valid IP address parameters from your system administrator. For the assignment of the IP address parameters such as IP address, Subnet mask etc. you have the following possibilities:

- Online using Siemens SIMATIC manager via "Assign Ethernet Address".
- With a project with IP address and IP parameters transferred via MMC or MPI to the CPU. After a reboot of the CPU and after switching the PG/PC interface to "TCP/IP... RFC1006" you may now configure your CPU online via the CP.

Address assignment with "Assign Ethernet Address"

In the following the proceeding with the Siemens SIMATIC manager starting with version V 5.3 & SP3 is described:

- Start the Siemens SIMATIC manager.
- Switch to "TCP/IP... RFC1006" using Options > Set PG/PC interface.
- The dialog for initialization of a station opens by PLC > Edit Ethernet Node.
- To get the stations and their MAC address, use the [Browse] button or type in the MAC Address. The Mac address can be found at a label beneath the front flap of the CP.
- Choose if necessary the known MAC address of the list of found stations.
- Either type in the IP configuration like IP address, subnet mask and gateway. Or your station is automatically provided with IP parameters by means of a DHCP server. Depending of the chosen option the DHCP server is to be supplied with MAC address, equipment name or client ID. The client ID is a numerical order of max. 63 characters. The following characters are allowed: "hyphen", 0-9, a-z, A-Z
- Confirm with [Assign ...].

Directly after the assignment the CP is online reachable using the set IP parameters.
• Start Siemens SIMATIC manager with new project.
• Place a new System 300 station with **Insert > Station > SIMATIC 300 station**
• Activate the station "SIMATIC 300" and open the hardware configurator by clicking on "Hardware".
• Configure a rack (SIMATIC 300 \ Rack-300 \ Profile rail).
• Configure in deputy of your CPU 517S/NET the Siemens CPU 318-2 with the order no. 6ES7 318-2AJ00-0AB0 V.3.0 which is to be found at SIMATIC 300 \ CPU 300 \ CPU 318-2 \ 318-2AJ00-0AB00. If needed, parameterize the CPU 318-2.
• Configure the internal PG/OP channel directly under the really plugged modules as virtual **CP 343-1 (343-1EX11)** from Siemens.
• Set IP address, subnet mask and gateway at CP properties.
• Always configure as 2. CP the internal CP 343 as **CP 343-1 (343-1EX11)** by setting another IP address, subnet mask and gateway.
• Save and compile your project.

This is the end of the project. After the project is transferred to CPU, the CP may be accessed by means of IP address and subnet mask of the project.

---

**Deployment of ISO transport connections**

For deployment of the ISO transport connections they must be enabled in the Ethernet properties of the CP at the project above. Here there is the possibility to assign the CP to a MAC address. With each start-up of the CPU the new MAC address is transferred to the CP.

**Configure connections with NetPro**

The link-up between the stations happens with the graphical interface NetPro. Start NetPro by clicking on a network in your project res. on connections in the CPU directory.
For the project engineering of connections, connected stations are presumed. To link-up stations, point on the colored net mark of the according CP with the mouse and drag it to the network you want to assign. The connection is displayed graphically by a line.

For the project engineering of new connections click on the according CPU and choose "Insert new connection" from the context menu.

Via the dialog window you may set the parameters for a connection. The parameters ID and LADDR are required for the usage on the blocks AG_SEND res. AG_RECV.

With deployment of Siemens S7 connections the parameter ID is to be passed to the respective FB/SFB VIPA handling blocks.

Always use the 2. CP from the route
Please take care to always choose the 2. CP from the route for communication. As 1. CP you will always see the Ethernet PG/OP channel that does not support configurable connections.

Save and compile your project and close NetPro. To store the CP project engineering data in the system data, you have to activate the option "Save configuration data on the CPU" (default setting) under object properties area Options in the hardware configuration of the CP.

For the execution of connection commands at the PLC, your CPU requires an user application. For this, exclusively the VIPA handling blocks are used, which you may get from VIPA as a library.

More information about the deployment of the blocks may be found in the manual "Operation list" of your CPU. Depending upon the connection type there are function blocks for Siemens S7 connections and Send/Receive connections.

Information about transferring a project may be found at chapter "Deployment CPU 517S/NET" at "Project transfer".

The following pages provide a more detailed description of the steps of the fast introduction.
### Hardware configuration

**Overview**
For the Hardware configuration the hardware configurator from Siemens is used. Here you set amongst others the IP address of the CP and configure the hardware components of your PLC.

Due to the fact that neither the Ethernet-PG/OP channel nor the CP 543 have an IP address in delivery state you may engineer the CPU exclusively via MPI or MMC.

For the access to the CPU via the Ethernet-PG/OP channel res. the CP 543 it is required that the CPU has a hardware project engineering where IP address and subnet mask for Ethernet-PG/OP res. CP 543 are defined.

**Requirements**
For the hardware configuration the following software is required:
- Siemens SIMATIC Manager V. 5.2 or higher
- SIMATIC NET

**Note!**
For the project engineering a thorough knowledge of the SIMATIC Manager and the hardware configurator from Siemens are required and assumed!

**Note!**
To be compatible to the Siemens SIMATIC Manager, the CPU 51xS from VIPA has to be configured as

**CPU 318-2DP (6ES7 318-2AJ00-0AB0)!**

The internal Ethernet-PG/OP channel is always configured virtually at slot 4 as CP343-1 (343-1EX11) from Siemens. The CP 543 of a CPU 51xSN/NET has always to be configured at slot 5 also as CP343-1 (343-1EX11).
Steps of the project engineering

The following text shows the approach of the project engineering in the hardware configurator from Siemens in an abstract sample. The project engineering is divided into 2 parts:

• Project engineering of the CPU
• Project engineering Ethernet-PG/OP channel and CP 543

Project engineering of the CPU

• Start the hardware configurator from Siemens with a new project and insert a profile rail from the hardware catalog.
• Place the following Siemens CPU at slot 2:
  CPU 318-2DP (6ES7 318-2AJ00-0AB0 V3.0)

For the internal Ethernet-PG/OP channel at slot 4 and the CP 543 at slot 5 you have to configure each a Siemens CP 343-1 (SIMATIC 300 \ CP 300 \ Industrial Ethernet \ CP 343-1 \ 6GK7 343-1EX11 0XE0).

Open the property window via double-click on the CP 343-1EX11 and enter at properties the IP address, subnet mask and gateway for the CPs and select the wanted subnet.

Save and compile your project.
Configure connections

Overview

The project engineering of connections i.e. the "link-up" between stations happens in NetPro from Siemens. NetPro is a graphical user interface for the link-up of stations.

A communication connection enables the program controlled communication between two participants at the Industrial Ethernet. The communication partners may here be part of the same project or - at multi projects - separated within related part projects.

Communication connections to partners outside of a project are configured via the object "In unknown project" or via deputy objects like "Other stations" or Siemens "SIMATIC S5 Station".

By means of the handling block like FB 55 - IP_CONFIG there is the possibility to establish program controlled communication connections. More may be found in the manual "Operation list" of the CPU.

Properties communication connection

The following properties are characterizing a communication connection:

- One station always executes an active connection establishment.
- Bi-directional data transfer (Send and receive on one connection)
- Both participant have equal rights, i.e. every participant may initialize the send res. receive process event controlled.
- Except of the UDP connection, at a communication connection the address of the communication partner is set via the project engineering. Here the connection is active established by one station.

Requirements

- Siemens SIMATIC manager V.5.2 or higher and SIMATIC NET are installed.
- The CP has been engineered at the hardware configuration, entered into the hardware configuration and linked-up to the Ethernet subnet.
- The CP as bus participant has an IP address respectively a MAC address for ISO transport connections.
Note!
Every station outside of the recent project must be configured as replacement objects like e.g. Siemens "SIMATIC S5" or "other station" or with the object "In unknown project".
When creating a connection you may also choose the partner type "unspecified" and set the required remote parameter directly in the connection dialog.

Work environment of NetPro
For the project engineering of connections, a thorough knowledge with NetPro from Siemens is required! The following passage only describes the basic usage of NetPro. More detailed information about NetPro is to be found in the according online manual res. documentation.
Start NetPro by clicking on a "net" in the Siemens SIMATIC manager or on "connections" within the CPU.
The environment of NetPro has the following structure:

1 Graphic net view
All stations and networks are displayed in a graphic view. By clicking on the according component you may access and alter the concerning properties.

2 Net objects
This area displays all available net objects in a directory view. By dragging a wanted object to the net view you may include further net objects and open them in the hardware configurator.

3 Connection table
The connection table lists all connections in a table. This list is only shown when you highlighted a connectable module like e.g. a CPU.
You may insert new connections into this table with the according command.
You receive the following graphical display for every PLC station and their component. By selecting the single components, the context menu offers you several functions:

1 **Station**
   This includes a PLC station with rack, CPU and communication components. Via the context menu you may configure a station added from the net objects and its concerning components in the hardware configurator. After returning to NetPro, the new configured components are shown.

2 **CPU**
   A click onto the CPU shows the connection table. The connection table shows all connections that are configured for the CPU.

3 **Internal communication components**
   This displays the communication components that are available in your CPU. For the NET-CPU is configured as CPU 318-2 the internal components do not show the CP.
   Due to this, the CPs that are included in the NET-CPU must be configured as external CPs behind the really plugged modules. The CPs are then also shown in NetPro as external CPs (4, 5) in the station.

4 **Ethernet PG/OP channel**
   The internal Ethernet PG/OP channel must always be configured as 1. CP in the hardware configuration. This CP only serves the PG/OP communication. You may not configure connections.

5 **CP 343**
   The internal CP 343 must always be configured as 2. CP in the hardware configuration after the Ethernet PG/OP channel.

**Link up stations**
NetPro offers you the option to link-up the communicating stations. You may link-up the stations via the properties in the hardware configuration or graphically via NetPro. For this you point the mouse on the colored net mark of the according CP and drag and drop it to the net you want to link. Now the CP is linked up to the wanted net by means of a line.
For the project engineering of connections, open the connection list by selecting the according CPU. Choose *Insert new connection* in the context menu:

![Connection list](image)

**Connection partner** (partner station)

A dialog window opens where you may choose the *connection partner* and the *connection type*.

- **Specified connection partner**
  Each station configured in the Siemens SIMATIC manager is listed in the table of connection partner. These stations are unique *specified* by an IP address and a subnet mask.

- **Unspecified connection partner**
  Here the connection partner may exist in the *current project* or in an *unknown project*. Connection jobs to an unknown project must be defined by an unique connection name, which is to be used in the projects of both stations. Due to this allocation the connection remains *unspecified*.

- **All broadcast stations**
  Exclusive at UDP connections you may send to every reachable participant. The receipt of user data is not possible. The broadcast participants are specified by *one* port and *one* broadcast address at sender and receiver.
  Per default, broadcasts that are only serving the Ethernet communication, like e.g. ARP-Requests (Search MAC <> IP address), are received and accordingly processed. For the identification of the broadcast participants within the net, you have to define a valid broadcast address as partner IP during project engineering of a broadcast connection. Additionally to the broadcast address you have to set a common port for sender and receiver.

- **All multicast stations**
  By selecting *All Multicast stations* you define that UDP telegrams have to be sent res. received by all participants of a multicast group. In opposite to broadcast here a reception is possible. For the identification of the multicast participants within the net, you have to define *one* valid multicast group address and *one* port for sender and receiver.
  The maximum number of multicast circles, which are supported by the CP, is identical to the maximum number of connections.
The following connection types are available for communication:

- Siemens S7 connections, Send/Receive connections (TCP, ISO-on-TCP and ISO transport) for secured data transfer of data blocks between two Ethernet stations
- UDP for not secured data transfer of data blocks between two stations.

Choose the connection partner and the type of connection and confirm with [OK].

If activated, a properties dialog for the according connection opens as link to your PLC user program.

At the following pages the relevant parameters of the different connection types are shortly described. More information about this may be found in the online help of Siemens NetPro respectively of VIPA WinPLC7.

After every connection was configured by this way, you may save and compile your project and exit NetPro.

To store the CP project engineering data in the system data, you have to activate the option "Store project data in the CPU" (default setting) at object properties area Options in the hardware configuration of the CP.
**Siemens S7 connection**

For data transfer with Siemens S7 connections the FB/SFB VIPA handling blocks are necessary; the deployment is described in the manual "Operation list" of your CPU.

At Siemens S7 connections the communication connections are specified by a connection ID for each communication partner.

A connection is specified by the **local** and **partner** connection end point. A link. At Siemens S7 connections the TSAPs must be congruent crosswise.

The following parameters define a connection end point:

<table>
<thead>
<tr>
<th>Station A</th>
<th>Station B</th>
</tr>
</thead>
<tbody>
<tr>
<td>remote TSAP → Siemens → local TSAP</td>
<td>local TSAP ← S7 connection ← remote TSAP</td>
</tr>
<tr>
<td>ID A</td>
<td>ID B</td>
</tr>
</tbody>
</table>

**Possibilities of combination**

The following table shows the combination options with Siemens S7 connections with deployment of the FB/SFB VIPA handling blocks.

The handling blocks are more described in the manual "Operation list" of the CPU.

<table>
<thead>
<tr>
<th>Connection partner specified in NetPro (in the current project)</th>
<th>Connection establishing active/passive</th>
<th>Connection specified</th>
</tr>
</thead>
<tbody>
<tr>
<td>unspecifed in NetPro (in the current project)</td>
<td>active</td>
<td>specified</td>
</tr>
<tr>
<td>unspecifed in NetPro (in the unknown project)</td>
<td>passive</td>
<td>unspecified</td>
</tr>
</tbody>
</table>

In the following every relevant parameter of a Siemens S7 connection is described:

**Local connection end point**

Here you may define how the connection is to be established. Since the Siemens SIMATIC manager can identify the communication options by means of the end points, some options are already preset and may not be changed.

**Establish an active connection**

An established connection is precondition for data transfer. By activating the option *Establish an active connection* the local station establishes the connection.

Please regard not every station is able to establish a connection. Here the job is to be made by the partner station.

**One-way**

If activated only one-way communication blocks like PUT and GET may be used for communication in the user program. Here the partner station acts as server, which neither may send active nor receive active
Chapter 6  Deployment Ethernet communication  

Block parameters

Local ID  The ID is the link to your PLC program. The ID must be identical to the ID of the call interface of the FB/SFB VIPA handling block.

[Default]  As soon as you click at [Default], the ID is reset to system generated ID.

Connection path  In this part of the dialog window the connection path between the local and the partner station may be set. Depending on the linking of the modules the possible interfaces for communication are listed in a selection field.

[Address details]  With this button a dialog window is opened, which shows address information about the local and partner station. The parameters may also be changed.

TSAP  With Siemens S7 connections a TSAP is automatically generated of the connection resource (one-way/two-way) and state of place (rack/slot respectively system internal ID at PC stations).

Connection resource  The connection resource is part of the TSAP of the local station respectively of the partner. Not every connection resource may be used for every connection type. Depending on the connection partner and the connection type the range of values is limited respectively the connection resource is fix specified.

Operating mode  With deploying of Siemens S7 connections the operating may be determined by deployment of the FB/SFB VIPA handling blocks in the user program. To use this blocks configured communication connections are always necessary in the active station.

More about the usage of these blocks may be found in the manual "Operation list" of your CPU.

The following blocks may be used with Siemens S7 connections:

<table>
<thead>
<tr>
<th>FB/SFB</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>FB/SFB 8</td>
<td>USEND</td>
<td>Uncoordinated data transmission</td>
</tr>
<tr>
<td>FB/SFB 9</td>
<td>URCV</td>
<td>Uncoordinated data reception</td>
</tr>
<tr>
<td>FB/SFB 12</td>
<td>BSEND</td>
<td>Sending data in blocks</td>
</tr>
<tr>
<td>FB/SFB 13</td>
<td>BRCV</td>
<td>Receiving data in blocks</td>
</tr>
<tr>
<td>FB/SFB 14</td>
<td>GET</td>
<td>Remote CPU read</td>
</tr>
<tr>
<td>FB/SFB 15</td>
<td>PUT</td>
<td>Remote CPU write</td>
</tr>
<tr>
<td>FB 55</td>
<td>IP_CONFIG</td>
<td>Programmed communication Connections</td>
</tr>
</tbody>
</table>
At the PLC side for data transfer with these connections the VIPA handling blocks AG_SEND (FC 5) and AG_RECV (FC 6) are to be used.

The following connections are Send/Receive connections:
- TCP (SEND-RECEIVE, FETCH-WRITE PASSIVE)
- ISO-on-TCP (SEND-RECEIVE, FETCH-WRITE PASSIVE)
- ISO transport (SEND-RECEIVE, FETCH-WRITE PASSIVE)
- UDP (SEND-RECEIVE)

Here the following parameters define a connection end point:

- **remote port** → TCP → **local port**
- **local port** ← connection ← **remote port**
- **IP address A**
- **IP address B**

**Possibilities of combination**

The following table shows the combination options with the different operating modes:

<table>
<thead>
<tr>
<th>Connection partner</th>
<th>Connection type</th>
<th>Conn. establ.</th>
<th>Connection</th>
<th>Operating mode</th>
</tr>
</thead>
<tbody>
<tr>
<td>Specified in NetPro (in recent project)</td>
<td>TCP / ISO-on-TCP / ISO transport</td>
<td>active/passive</td>
<td>specified</td>
<td>SEND/RECEIVE</td>
</tr>
<tr>
<td></td>
<td>UDP</td>
<td></td>
<td></td>
<td>SEND/RECEIVE</td>
</tr>
<tr>
<td>Unspecified in NetPro (in recent project)</td>
<td>TCP / ISO-on-TCP / ISO transport</td>
<td>active</td>
<td>specified (Port/TSAP)</td>
<td>SEND/RECEIVE FETCH PASSIV WRITE PASSIV</td>
</tr>
<tr>
<td></td>
<td>passive</td>
<td></td>
<td>unspecified</td>
<td></td>
</tr>
<tr>
<td></td>
<td>UDP</td>
<td></td>
<td>specified</td>
<td>SEND/RECEIVE</td>
</tr>
<tr>
<td>Unspecified in NetPro (in unknown project)</td>
<td>TCP / ISO-on-TCP / ISO transport</td>
<td>active</td>
<td>specified (connection name in an other project)</td>
<td>SEND/RECEIVE FETCH PASSIV WRITE PASSIV</td>
</tr>
<tr>
<td></td>
<td>passive</td>
<td></td>
<td></td>
<td>SEND/RECEIVE</td>
</tr>
<tr>
<td>All Broadcast stations</td>
<td>UDP</td>
<td></td>
<td>specified (Port, Broadcast addr.)</td>
<td>SEND</td>
</tr>
<tr>
<td>All Multicast stations</td>
<td>UDP</td>
<td></td>
<td>specified (Port, Multicast group)</td>
<td>SEND/RECEIVE</td>
</tr>
</tbody>
</table>
In this tab the general connection parameters are listed, which identify the local connection end point.

This entry is identical to the entry of the connection table. The value may always be changed. Please also regard to adjust the ID parameter of the call interface of the FC.

Note!

If a CP is exchanged by another one, this must at least provide the same services and must at least have the same version level. Only this can guarantee the connections configured via the CP to remain consistent and useable.

This field contains the name of the connection. The name is generated by the system and may be changed on every time.

Here is the CP listed, which should be used for connection. With the button [Route] the appropriate CP may be selected for communication.

Do not select the 1. CP of the route for communication connections. The 1. CP is always the Ethernet-PG/OP channel, which does not support configurable connections.

If activated the connection to the partner is active established by the local station. Here the partner is to be specified in the tab "Addresses".

At an unspecified connection the connection is passive established.

Here the parameters ID and LADDR for your user program are shown. Both are parameters, which are to be preset if you use the FC 5 and FC 6 (AG_SEND, AG_RECEIVE). Please always use the VIPA FCs, which you may receive from VIPA.

The Addresses tab displays the relevant local and remote address information as proposed values. Depending on the kind of communication the address information may remain unspecified.

Ports

Ports res. port addresses are defining the access point to the user application within the station/CPU. These must be unambiguous. A port address should be within the range of 2000...65535. Remote and local ports may only be identical with one connection.

ISO-on-TCP and ISO transport support TSAP lengths (Transport Service Access Point) of 1...16 byte. You may enter the TSAP in ASCII or hexadecimal format. The calculation of the length happens automatically.
Options

Dependent on the specification of the connecting partner the operating mode may be set respectively displayed.

Mode

SEND/RECEIVE
The SEND/RECEIVE interface allows the program-controlled communication to any partner station via a configured connection. Here the data transfer happens by a call from your user application. The FC5 and FC6 that are part of the VIPA block library are serving as interface.
This enables your control to send messages depending on process events.

FETCH/WRITE PASSIVE
With the help of FETCH/WRITE services partner systems have the direct access to memory areas of the CPU. These are "passive" communication connections that have to be configured. The connections are "actively" established by the connection partner (e.g. Siemens-S5).

FETCH PASSIVE (request data)
FETCH allows a partner system to request data.

WRITE PASSIVE (write data)
This allows a partner system to write data in the data area of the CPU.

Overview

Here every configured connections of this station and its partner are displayed. These data are information and may not be changed.

Note!
By appropriate shift respectively delete activities in the Siemens SIMATIC manager connections may lose the allocation to the CP.
These connections are marked with "!" at ID of the overview.
Communication connections in the user program

Overview
For the execution of connection commands at the PLC, your CPU requires an user application. For this, exclusively the VIPA handling blocks are to be used, which you may get as library from VIPA.
More information about the deployment of the blocks may be found in the manual "Operation list" of the CPU.
Depending on the connection type there are blocks for Siemens S7 connections and Send/Receive connections.
In the following the proceeding with both connection types is described.

User program at Siemens S7 connections
Larger data sets may be transferred between PLC systems based on Siemens STEP©7 by means of Siemens S7 connections. Here the stations are to be linked by Ethernet.
Using remote functions with the appropriate function block you can control a CPU with another CPU and switch it e.g. to STOP.
The communication connections are static, this means they are to be configured by a connection table.

Communication functions
With the SPEED7 CPUs of VIPA there are two possibilities for the deployment of the communication functions:
• Siemens S7-300 communication functions
  By integration of the function blocks FB 8 ... FB 55 from VIPA you may access the Siemens S7-300 communication functions.
• Siemens S7-400 communication functions
  For the Siemens S7-400 communication functions the SFB 8 ... SFB 15 are to be used, which were integrated to the operating system of the CPU. Here copy the interface description of the SFBs from the standard library at system function block to the directory container, generate an instance data block for each call and call the SFB with the associated instance data block.

Configuring
Precondition for Siemens S7 communication is a configured connection table in which the communication links are defined. For this e.g. WinPLC7 from VIPA or NetPro from Siemens can be used. A communication link is specified by a connection ID for each communication partner. Use the local ID to initialize the FB/SFB in the PLC from which the connection is regarded and the partner ID to configure the FB/SFB in the partner PLC.
**Function blocks**

The following function blocks may be used for Siemens S7 communications. More information about the deployment of the blocks may be found in the manual "Operation list" of the CPU.

<table>
<thead>
<tr>
<th>FB/SFB</th>
<th>Label</th>
<th>Description</th>
</tr>
</thead>
</table>
| FB/SFB 8 | USEND | *Uncoordinated data transmission*
|          |       | FB/SFB 8 USEND may be used to transmit data to a remote partner FB/SFB of the type URCV (FB/SFB 9). You must ensure that parameter **R_ID** of both FB/SFBs is identical. The transmission is started by a positive edge at control input **REQ** and proceeds without coordination with the partner FB/SFB. |
| FB/SFB 9 | URCV  | *Uncoordinated data reception*
|          |       | FB/SFB 9 URCV can be used to receive data asynchronously from a remote partner FB/SFB of the type USEND (FB/SFB 8). You must ensure that parameter **R_ID** of both FB/SFBs is identical. The block is ready to receive then there is a logical 1 at the **EN_R** input. An active job can be cancelled with **EN_R**=0. |
| FB/SFB 12 | BSEND | *Sending data in blocks*
|          |       | FB/SFB 12 BSEND sends data to a remote partner FB/SFB of the type BRCV (FB/SFB 13). The data area to be transmitted is segmented. Each segment is sent individually to the partner. The last segment is acknowledged by the partner as it is received, independently of the calling up of the corresponding FB/SFB/FB BRCV. With this type of data transfer, more data can be transported between the communications partners than is possible with all other communication FBs/SFBs for configured S7 connections, namely 65534 bytes. |
| FB/SFB 13 | BRCV  | *Receiving data in blocks*
|          |       | The FB/SFB 13 BRCV can receive data from a remote partner FB/SFB of the type BSEND (FB/SFB 12). The parameter **R_ID** of both FB/SFBs must be identical. After each received data segment an acknowledgement is sent to the partner FB/SFB and the **LEN** parameter is updated. |
| FB/SFB 14 | GET   | *Remote CPU read*
|          |       | The FB/SFB 14 GET can be used to read data from a remote CPU. The respective CPU must be in RUN mode or in STOP mode. |
| FB/SFB 15 | PUT   | *Remote CPU write*
|          |       | The FB/SFB 15 PUT can be used to write data to a remote CPU. The respective CPU may be in RUN mode or in STOP mode. |
| FB 55    | IP_CONFIG | *Programmed Communication Connections*
|          |       | With this block you may flexible transfer data blocks with configuration data to the CP within the user program. |
User program at Send/Receive connections

The following connections are Send/Receive connections:

- TCP (SEND-RECEIVE, FETCH-WRITE PASSIVE)
- ISO-on-TCP (SEND-RECEIVE, FETCH-WRITE PASSIVE)
- ISO Transport (SEND-RECEIVE, FETCH-WRITE PASSIVE)
- UDP (SEND-RECEIVE)

For the communication between CPU and CP, the following FCs are available:

AG_SEND (FC 5)
This block transfers the user data from the data area given in SEND to the CP specified via ID and LADDR. As data area you may set a PA, bit memory or data block area. When the data area has been transferred without errors, "order ready without error" is returned.

AG_RECV (FC 6)
The block transfers the user data from the CP into a data area defined via RECV. As data area you may set a PA, bit memory or data block area. When the data area has been transferred without errors, "order ready without error" is returned.

Note!
Please regard that you may only use the SEND/RECV-FCs from VIPA in your user application for the communication with VIPA-CPs. At a change to VIPA-CPs in an already existing project, the present AG_SEND/AG_LSEND res. AG_RECV/AG_LRECV may be replaced by AG_SEND res. AG_RECV from VIPA without adjustment. Due to the fact that the CP automatically adjusts itself to the length of the data to transfer, the L variant of SEND res. RECV is not required for VIPA CPs.

Status displays
The CP processes send and receive commands independently from the CPU cycle and needs for this transfer time. The interface with the FC blocks to the user application is here synchronized by means of acknowledgements/receipts.

For status evaluation the communication blocks return parameters that may be evaluated directly in the user application.

These status displays are updated at every block call.

Deployment at high communication load
Do not use cyclic calls of the communication blocks in OB 1. This causes a permanent communication between CPU and CP. Program instead the communication blocks within a time OB where the cycle time is higher res. event controlled.
**FC call is faster than CP transfer time**

If a block is called a second time in the user application before the data of the last time is already completely send res. received, the FC block interface reacts like this:

**AG_SEND**

No command is accepted until the data transfer has been acknowledged from the partner via the connection. Until this you receive the message "Order running" before the CP is able to receive a new command for this connection.

**AG_RECV**

The order is acknowledged with the message "No data available yet" as long as the CP has not received the receive data completely.

---

**AG_SEND, AG_RECV in the user application**

The following illustration shows a possible sequence for the FC blocks together with the organizations and program blocks in the CPU cycle:

The FC blocks with concerning communication connection are summed up by color. Here you may also see that your user application may consist of any number of blocks. This allows you to send or receive data (with AG_SEND res. AG_RECV) event or program driven at any wanted point within the CPU cycle.

You may also call the blocks for **one** communication connection several times within one cycle.
**AG_SEND (FC 5)**  
By means of AG_SEND the data to send are transferred to the CP.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Declaration</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ACT</td>
<td>Input</td>
<td>BOOL</td>
<td>Activation of the sender&lt;br&gt;0: Updates DONE, ERROR and STATUS&lt;br&gt;1: The data area defined in SEND with the length LEN is send</td>
</tr>
<tr>
<td>ID</td>
<td>Input</td>
<td>INT</td>
<td>Connection number 1 ... 16 (identical with ID of NetPro)</td>
</tr>
<tr>
<td>LADDR</td>
<td>Input</td>
<td>WORD</td>
<td>Logical basic address of the CP&lt;br&gt;(identical with LADDR of NetPro)</td>
</tr>
<tr>
<td>SEND</td>
<td>Input</td>
<td>ANY</td>
<td>Data area</td>
</tr>
<tr>
<td>LEN</td>
<td>Input</td>
<td>INT</td>
<td>Number of bytes from data area to transfer</td>
</tr>
<tr>
<td>DONE</td>
<td>Output</td>
<td>BOOL</td>
<td>Status parameter for the order&lt;br&gt;0: Order running&lt;br&gt;1: Order ready without error</td>
</tr>
<tr>
<td>ERROR</td>
<td>Output</td>
<td>BOOL</td>
<td>Error message&lt;br&gt;0: Order running (at DONE = 0)&lt;br&gt;0: Order ready without error (at DONE = 1)&lt;br&gt;1: Order ready with error</td>
</tr>
<tr>
<td>STATUS</td>
<td>Output</td>
<td>WORD</td>
<td>Status message returned with DONE and ERROR. More details are to be found in the following table.</td>
</tr>
</tbody>
</table>

**AG_RECV (FC 6)**  
By means of AG_RECV the data received from the CP are transferred to the CPU.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Declaration</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ID</td>
<td>Input</td>
<td>INT</td>
<td>Connection number 1 ... 16 (identical with ID of NetPro)</td>
</tr>
<tr>
<td>LADDR</td>
<td>Input</td>
<td>WORD</td>
<td>Logical basic address of the CP&lt;br&gt;(identical with LADDR of NetPro)</td>
</tr>
<tr>
<td>RECV</td>
<td>Input</td>
<td>ANY</td>
<td>Data area for the received data</td>
</tr>
<tr>
<td>NDR</td>
<td>Output</td>
<td>BOOL</td>
<td>Status parameter for the order&lt;br&gt;0: Order running&lt;br&gt;1: Order ready data received without error</td>
</tr>
<tr>
<td>ERROR</td>
<td>Output</td>
<td>BOOL</td>
<td>Error message&lt;br&gt;0: Order running (at NDR = 0)&lt;br&gt;0: Order ready without error (at NDR = 1)&lt;br&gt;1: Order ready with error</td>
</tr>
<tr>
<td>STATUS</td>
<td>Output</td>
<td>WORD</td>
<td>Status message returned with NDR and ERROR. More details are to be found in the following table.</td>
</tr>
<tr>
<td>LEN</td>
<td>Output</td>
<td>INT</td>
<td>Number of bytes that have been received</td>
</tr>
</tbody>
</table>
DONE, ERROR, STATUS  The following table shows all messages that can be returned by the CP after a SEND res. RECV command.
A "-" means that this message is not available for the concerning SEND res. RECV command.

<table>
<thead>
<tr>
<th>DONE (SEND)</th>
<th>NDR (RECV)</th>
<th>ERROR</th>
<th>STATUS</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>-</td>
<td>0</td>
<td>0000h</td>
<td>Order ready without error</td>
</tr>
<tr>
<td>-</td>
<td>1</td>
<td>0</td>
<td>0000h</td>
<td>New data received without error</td>
</tr>
<tr>
<td>0</td>
<td>-</td>
<td>0</td>
<td>0000h</td>
<td>No order present</td>
</tr>
<tr>
<td>-</td>
<td>0</td>
<td>0</td>
<td>8180h</td>
<td>No data available yet</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
<td>0</td>
<td>8181h</td>
<td>Order running</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
<td>1</td>
<td>8183h</td>
<td>No CP project engineering for this order</td>
</tr>
<tr>
<td>0</td>
<td>-</td>
<td>1</td>
<td>8184h</td>
<td>System error</td>
</tr>
<tr>
<td>-</td>
<td>0</td>
<td>1</td>
<td>8184h</td>
<td>System error (destination data area failure)</td>
</tr>
<tr>
<td>0</td>
<td>-</td>
<td>1</td>
<td>8185h</td>
<td>Parameter LEN exceeds source area SEND</td>
</tr>
<tr>
<td>-</td>
<td>0</td>
<td>1</td>
<td>8185h</td>
<td>Destination buffer (RECV) too small</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
<td>1</td>
<td>8186h</td>
<td>Parameter ID invalid (not within 1 ...16)</td>
</tr>
<tr>
<td>0</td>
<td>-</td>
<td>1</td>
<td>8302h</td>
<td>No receive resources at destination station, receive station is not able to process received data fast enough</td>
</tr>
<tr>
<td>-</td>
<td>0</td>
<td>1</td>
<td>8302h</td>
<td>No receive resources at destination station, receive station is not able to process received data fast enough</td>
</tr>
<tr>
<td>0</td>
<td>-</td>
<td>1</td>
<td>8304h</td>
<td>The connection is not established. The send command shouldn't be send again before a delay time of &gt;100ms.</td>
</tr>
<tr>
<td>-</td>
<td>0</td>
<td>1</td>
<td>8304h</td>
<td>The connection is not established. The receive command shouldn't be send again after a delay time of &gt;100ms.</td>
</tr>
<tr>
<td>0</td>
<td>-</td>
<td>1</td>
<td>8311h</td>
<td>Destination station not available under the defined Ethernet address.</td>
</tr>
<tr>
<td>0</td>
<td>-</td>
<td>1</td>
<td>8312h</td>
<td>Ethernet error in the CP</td>
</tr>
<tr>
<td>0</td>
<td>-</td>
<td>1</td>
<td>8F22h</td>
<td>Source area invalid, e.g. when area in DB not present Parameter LEN &lt; 0</td>
</tr>
<tr>
<td>-</td>
<td>0</td>
<td>1</td>
<td>8F23h</td>
<td>Source area invalid, e.g. when area in DB not present Parameter LEN &lt; 0</td>
</tr>
<tr>
<td>0</td>
<td>-</td>
<td>1</td>
<td>8F24h</td>
<td>Range error at reading a parameter.</td>
</tr>
<tr>
<td>-</td>
<td>0</td>
<td>1</td>
<td>8F25h</td>
<td>Range error at writing a parameter.</td>
</tr>
<tr>
<td>0</td>
<td>-</td>
<td>1</td>
<td>8F28h</td>
<td>Orientation error at reading a parameter.</td>
</tr>
<tr>
<td>-</td>
<td>0</td>
<td>1</td>
<td>8F29h</td>
<td>Orientation error at writing a parameter.</td>
</tr>
<tr>
<td>-</td>
<td>0</td>
<td>1</td>
<td>8F30h</td>
<td>Parameter is within write protected 1. recent data block</td>
</tr>
<tr>
<td>-</td>
<td>0</td>
<td>1</td>
<td>8F31h</td>
<td>Parameter is within write protected 2. recent data block</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
<td>1</td>
<td>8F32h</td>
<td>Parameter contains oversized DB number.</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
<td>1</td>
<td>8F33h</td>
<td>DB number error</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
<td>1</td>
<td>8F3Ah</td>
<td>Area not loaded (DB)</td>
</tr>
</tbody>
</table>

continued...
Chapter 6  Deployment Ethernet communication

... continue

<table>
<thead>
<tr>
<th>DONE (SEND)</th>
<th>NDR (RECV)</th>
<th>ERROR</th>
<th>STATUS</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>-</td>
<td>1</td>
<td>8F42h</td>
<td>Acknowledgement delay at reading a parameter from peripheral area.</td>
</tr>
<tr>
<td>-</td>
<td>0</td>
<td>1</td>
<td>8F43h</td>
<td>Acknowledgement delay at writing a parameter from peripheral area.</td>
</tr>
<tr>
<td>0</td>
<td>-</td>
<td>1</td>
<td>8F44h</td>
<td>Address of the parameter to read locked in access track</td>
</tr>
<tr>
<td>-</td>
<td>0</td>
<td>1</td>
<td>8F45h</td>
<td>Address of the parameter to write locked in access track</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
<td>1</td>
<td>8F7Fh</td>
<td>Internal error e.g. invalid ANY reference e.g. parameter LEN = 0</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
<td>1</td>
<td>8090h</td>
<td>Module with this module start address not present or CPU in STOP.</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
<td>1</td>
<td>8091h</td>
<td>Module start address not within double word grid.</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
<td>1</td>
<td>8092h</td>
<td>ANY reference contains type setting unequal BYTE.</td>
</tr>
<tr>
<td>-</td>
<td>0</td>
<td>1</td>
<td>80A0h</td>
<td>Negative acknowledgement at reading the module</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
<td>1</td>
<td>80A4h</td>
<td>reserved</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
<td>1</td>
<td>80B0h</td>
<td>Module doesn’t recognize record set.</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
<td>1</td>
<td>80B1h</td>
<td>The length setting (in parameter LEN) is invalid.</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
<td>1</td>
<td>80B2h</td>
<td>reserved</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
<td>1</td>
<td>80C0h</td>
<td>Record set not readable.</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
<td>1</td>
<td>80C1h</td>
<td>The set record set is still in process.</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
<td>1</td>
<td>80C2h</td>
<td>Order accumulation.</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
<td>1</td>
<td>80C3h</td>
<td>The operating sources (memory) of the CPU are temporarily occupied.</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
<td>1</td>
<td>80C4h</td>
<td>Communication error (occurs temporarily; a repetition in the user application is reasonable.)</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
<td>1</td>
<td>80D2h</td>
<td>Module start address is wrong.</td>
</tr>
</tbody>
</table>

Status parameter at reboot

At a reboot of the CP, the output parameters are reset as follows:

- DONE = 0
- NDR = 0
- ERROR = 8180h (at AG_RECV)
- ERROR = 8181h (at AG_SEND)

Project transfer

Information about transferring a project may be found at chapter "Deployment CPU ..." at "Project transfer".
NCM diagnostic - Help for error diagnostic

Check list for error search

This page shall help you with the error diagnostic. The following page lists a number of typical problems and their probable causes:

<table>
<thead>
<tr>
<th>Question</th>
<th>Solution with &quot;no&quot;</th>
</tr>
</thead>
<tbody>
<tr>
<td>CPU in Run?</td>
<td>Control DC 24V voltage supply. Set RUN/STOP lever in position RUN. Check PLC program and transfer it again.</td>
</tr>
<tr>
<td>AG_SEND, AG_RECV in user application?</td>
<td>These 2 blocks are required in the user application for the data transfer between CP and CPU. Both blocks must also be called with a passive connection.</td>
</tr>
<tr>
<td>Is CP able to connect?</td>
<td>Check Ethernet cable (at a point-to-point connection a crossed Ethernet cable is to be used). Check IP address.</td>
</tr>
<tr>
<td>Can data be transferred?</td>
<td>Check Port no. for read and write. Check source and destination areas. Check if the 2. CP is selected in the route. Enlarge the receive res. send buffer defined via the ANY pointer.</td>
</tr>
<tr>
<td>Is the complete data block sent at ISO-on-TCP?</td>
<td>Check the LEN parameter at AG_SEND. Set the receive res. send buffer defined via the ANY pointer to the required size.</td>
</tr>
</tbody>
</table>

Siemens NCM S7 diagnostic

The CP supports the Siemens NCM diagnostic tool. The NCM diagnostic tool is part of the Siemens SIMATIC manager. This tool delivers information about the operating state of the communication functions of the online CPs dynamically.

The following diagnostic functions are available:

- Check operating state at Ethernet
- Read the diagnostic buffer of the CP
- Diagnostic of connections

The following pages contain a short description of the NCM diagnostic. More details about the function range and for the deployment of the Siemens NCM diagnostic tool is to be found in the according online help res. the manual from Siemens.
Start NCM diagnostic

There are two options to start the diagnostic tool:

- Via Windows-START menu > SIMATIC ... NCM S7 > Diagnostic
- Within the project engineering res. the hardware configuration via the register "Diagnostic" in the "Property" dialog with [Execute].

Structure

The working surface of the diagnostic tool has the following structure:

The navigation area at the left side contains the hierarchical listed diagnostic objects. Depending on CP type and configured connections there is an adjusted object structure in the navigation area.

The information area at the right side always shows the result of the navigation function you chose in the navigation area.

No diagnostic without connection

A diagnostic always requires an online connection to the CP you want to control. For this click at at the symbol bar. The following dialog window appears:

Set the following parameters at destination station:

**Connection**: Ind. Ethernet TCP/IP

**Station addr.**: Enter the IP address of the CP

**Module rack/slot**: Enter the module rack and slot of the CP 343 that you’ve placed at the 2. slot.

Set your PG/PC interface to TCP/IP...RFC1006. Via [OK] you start the online diagnostic.
**Read diagnostic buffer**

The CP has a diagnostic buffer. This has the architecture of a ring memory and may store up to 100 diagnostic messages. The NCM diagnostic allows you to monitor and evaluate the CP diagnostic messages via the diagnostic object *Diagnostic buffer*.

Via a double click on a diagnostic message the NCM diagnostic shows further information.

**Approach for diagnostic**

You execute a diagnostic by clicking on a diagnostic object in the navigation area. More functions are available via the menu and the symbol bar.

**Note!**

Please always control the preconditions for an operative communication using the check at the beginning of this chapter.

For the aimed diagnostic deployment the following approach is convenient:

- Start diagnostic.
- Open the dialog for the online connection with \[ \text{ ]}, enter connection parameters and establish the online connection with [OK].
- Identify the CP and check the recent state of the CP via module status.
- Check the connections for particularities like:
  - Connection status
  - Receive status
  - Send status
- Control and evaluate the diagnostic buffer of the CP via *diagnostic buffer*.
- As needed, alter project engineering res. programming and restart diagnostic.
Coupling to other systems

Overview
The operating mode FETCH/WRITE supported at TCP res. ISO-on-TCP can be used for accesses of partner devices to the PLC system memory. To be able to use this access also for example for implementation in PC applications you have to know the telegram structure for orders. The specific headers for request and acknowledgement telegrams have per default a length of 16Byte and are described at the following pages.

ORG format
The organization format is the abbreviated description of a data source or a data destination in a PLC environment. The available ORG formats are listed in the following table.
The ERW-identifier is used for the addressing of data blocks. In this case the data block number is entered into this identifier. The start address and quantity provide the address for the memory area and they are stored in HIGH-/LOW- format (Motorola-formatted addresses)

<table>
<thead>
<tr>
<th>Description</th>
<th>Type</th>
<th>Range</th>
</tr>
</thead>
<tbody>
<tr>
<td>ORG identifier</td>
<td>BYTE</td>
<td>1...x</td>
</tr>
<tr>
<td>ERW identifier</td>
<td>BYTE</td>
<td>1...255</td>
</tr>
<tr>
<td>Start address</td>
<td>HILOWORD</td>
<td>0...y</td>
</tr>
<tr>
<td>Length</td>
<td>HILOWORD</td>
<td>1...z</td>
</tr>
</tbody>
</table>

The following table contains a list of available ORG-formats. The "length" must not be entered as -1 (FFFFh).

ORG identifier 01h-04h

<table>
<thead>
<tr>
<th>CPU area</th>
<th>DB</th>
<th>MB</th>
<th>EB</th>
<th>AB</th>
</tr>
</thead>
<tbody>
<tr>
<td>ORG identifier</td>
<td>01h</td>
<td>02h</td>
<td>03h</td>
<td>04h</td>
</tr>
<tr>
<td>Description</td>
<td>Source/destination data from/into data Block in main memory.</td>
<td>Source/destination data from/into flag memory area</td>
<td>Source/destination data from/into process image of the inputs (PII).</td>
<td>Source/destination data from/into process image of the outputs (PIQ).</td>
</tr>
<tr>
<td>ERW identifier (DBNO)</td>
<td>DB, from where the source data is retrieved or to where the destination data is transferred.</td>
<td>irrelevant</td>
<td>irrelevant</td>
<td>irrelevant</td>
</tr>
<tr>
<td>Start address significance</td>
<td>DBB-No., from where the data is retrieved or where the data is saved.</td>
<td>MB-No., from where the data is retrieved or where the data is saved.</td>
<td>IB-No., from where the data is retrieved or where the data is saved.</td>
<td>QB-No., from where the data is retrieved or where the data is saved.</td>
</tr>
<tr>
<td>Length significance</td>
<td>Length of the source/destination data block in words</td>
<td>Length of the source/destination data block in bytes</td>
<td>Length of the source/destination data block in bytes</td>
<td>Length of the source/destination data block in bytes</td>
</tr>
</tbody>
</table>
Note!
Information about the valid range can be found at Chapter "Hardware description of the CPU".

**ORG identifier 05h-0Ah**

<table>
<thead>
<tr>
<th>CPU area</th>
<th>PB</th>
<th>ZB</th>
<th>TB</th>
</tr>
</thead>
<tbody>
<tr>
<td>ORG identifier</td>
<td>05h</td>
<td>06h</td>
<td>07h</td>
</tr>
</tbody>
</table>

- **Description**: source/destination data from/into peripheral modules. Input module for source data, output module for destination data.
- **Source/destination data**: from/into peripheral modules. Input module for source data, output module for destination data.
- **Source/destination data**: from/into counter cells.
- **Source/destination data**: from/into timer cells.

**ERW identifier (DBNO)**

- **irrelevant**
- **irrelevant**
- **irrelevant**

**Start address Significance**

- **PB-No.**, from where the data can be retrieved or where it is saved.
- **ZB-No.**, from where the data can be retrieved or where it is saved.
- **TB-No.**, from where the data can be retrieved or where it is saved.

**Length Significance**

- **Length** of the source/destination data block in bytes.
- **Length** of the source/destination data block in words (counter cell = 1 word).
- **Length** of the source/destination data block in words (counter cell = 1 word).

**Transfer of blocks with numbers >255**

**ORG identifier 81h-FFh**

To transfer data blocks of the number range 256 ... 32768 you may use the ORG identifier 81h-FFh.

For the setting of a DB No. >255 needs a length of one word, the **DBNO<sub>new</sub>** is assembled from the content of the ORG identifier and the DBNO. DBNO<sub>new</sub> is created as word as follows:

\[
DBNO_{new} = 256 \times (\text{ORG-identifier AND 7Fh}) + \text{DBNO}
\]

If the highest bit of the ORG identifier is set, the Low-Byte of DBNO<sub>new</sub> is defined via DBNO and the High-Byte of DBNO<sub>new</sub> via ORG identifier, where the highest bit of the ORG identifier is eliminated.

The following formula illustrates this:

\[
\begin{array}{c|c}
\text{High-Byte} & \text{Low-Byte} \\
\hline
1 & \text{X} \times \text{X} \times \text{X} \\
\end{array}
\]

ORG identifier (0XXXXXXX) (DBNO (XXXXXXX)](image)
Structure of PLC-Header

For every FETCH and WRITE the CP generates PLC header for request and acknowledgment messages. Normally the length of these headers is 16Bytes and have the following structure:

WRITE

Request telegram

Remote Station

<table>
<thead>
<tr>
<th>System ID</th>
<th>&quot;S5&quot; (Word)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Length Header</td>
<td>=10h (Byte)</td>
</tr>
<tr>
<td>ID OP-Code</td>
<td>=01h (Byte)</td>
</tr>
<tr>
<td>Length OP-Code</td>
<td>=03h (Byte)</td>
</tr>
<tr>
<td>OP-Code</td>
<td>=03h (Byte)</td>
</tr>
<tr>
<td>ORG block</td>
<td>=03h (Byte)</td>
</tr>
<tr>
<td>Length ORG block</td>
<td>=08h (Byte)</td>
</tr>
<tr>
<td>ORG identifier*</td>
<td>(Byte)</td>
</tr>
<tr>
<td>ERW identifier</td>
<td>(Byte)</td>
</tr>
<tr>
<td>Start address</td>
<td>(Word)</td>
</tr>
<tr>
<td>Length</td>
<td>(Word)</td>
</tr>
<tr>
<td>Empty block</td>
<td>=FFh (Byte)</td>
</tr>
<tr>
<td>Length empty block</td>
<td>=02h (Byte)</td>
</tr>
<tr>
<td>Data up to 64kByte (only if error no.=0)</td>
<td></td>
</tr>
</tbody>
</table>

Acknowledgement telegram CP

<table>
<thead>
<tr>
<th>System ID</th>
<th>&quot;S5&quot; (Word)</th>
</tr>
</thead>
<tbody>
<tr>
<td>ID OP-Code</td>
<td>=01h (Byte)</td>
</tr>
<tr>
<td>Length OP-Code</td>
<td>=03h (Byte)</td>
</tr>
<tr>
<td>OP-Code</td>
<td>=04h (Byte)</td>
</tr>
<tr>
<td>Ackn. block</td>
<td>=0Fh (Byte)</td>
</tr>
<tr>
<td>Length Ack. block</td>
<td>=03h (Byte)</td>
</tr>
<tr>
<td>Error no.</td>
<td>(Byte)</td>
</tr>
<tr>
<td>Empty block</td>
<td>=FFh (Byte)</td>
</tr>
<tr>
<td>Length empty block</td>
<td>=07h (Byte)</td>
</tr>
<tr>
<td>5 empty bytes attached</td>
<td></td>
</tr>
</tbody>
</table>

.FETCH

Request telegram

Remote Station

<table>
<thead>
<tr>
<th>System ID</th>
<th>&quot;S5&quot; (Word)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Length Header</td>
<td>=10h (Byte)</td>
</tr>
<tr>
<td>ID OP-Code</td>
<td>=01h (Byte)</td>
</tr>
<tr>
<td>Length OP-Code</td>
<td>=03h (Byte)</td>
</tr>
<tr>
<td>OP-Code</td>
<td>=05h (Byte)</td>
</tr>
<tr>
<td>ORG block</td>
<td>=03h (Byte)</td>
</tr>
<tr>
<td>Length ORG block</td>
<td>=08h (Byte)</td>
</tr>
<tr>
<td>ORG identifier*</td>
<td>(Byte)</td>
</tr>
<tr>
<td>ERW identifier</td>
<td>(Byte)</td>
</tr>
<tr>
<td>Start address</td>
<td>(Word)</td>
</tr>
<tr>
<td>Length</td>
<td>(Word)</td>
</tr>
<tr>
<td>Empty block</td>
<td>=FFh (Byte)</td>
</tr>
<tr>
<td>Length empty block</td>
<td>=02h (Byte)</td>
</tr>
<tr>
<td>Data up to 64kByte (only if error no.=0)</td>
<td></td>
</tr>
</tbody>
</table>

Acknowledgement telegram CP

<table>
<thead>
<tr>
<th>System ID</th>
<th>&quot;S5&quot; (Word)</th>
</tr>
</thead>
<tbody>
<tr>
<td>ID OP-Code</td>
<td>=01h (Byte)</td>
</tr>
<tr>
<td>Length OP-Code</td>
<td>=03h (Byte)</td>
</tr>
<tr>
<td>OP-Code</td>
<td>=06h (Byte)</td>
</tr>
<tr>
<td>Ackn. block</td>
<td>=0Fh (Byte)</td>
</tr>
<tr>
<td>Length Ackn. block</td>
<td>=03h (Byte)</td>
</tr>
<tr>
<td>Error no.</td>
<td>(Byte)</td>
</tr>
<tr>
<td>Empty block</td>
<td>=FFh (Byte)</td>
</tr>
<tr>
<td>Length empty block</td>
<td>=07h (Byte)</td>
</tr>
<tr>
<td>5 empty bytes attached</td>
<td></td>
</tr>
</tbody>
</table>

*) More details to the data area is to be found at "ORG-Format" above.

Note!

Please regard that in opposite to Siemens-S5 systems, the block addressing of these CPUs takes the start address as byte number and the length as number of words.

Messages of error no.

The following messages can be returned via error no.:

<table>
<thead>
<tr>
<th>Error no.</th>
<th>Message</th>
</tr>
</thead>
<tbody>
<tr>
<td>00h</td>
<td>No error occurred</td>
</tr>
<tr>
<td>01h</td>
<td>The defined area cannot be read res. written</td>
</tr>
</tbody>
</table>
Chapter 7  Deployment PLC-Tool

Overview
This chapter contains the description of the control software PLC-Tool from VIPA. PLC-Tool is a component of the OPC-Server package and is installed together with the OPC server at the standard installation. The OPC-Server package can be found at the enclosed CD SW-ToolDemo.

Content

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chapter 7 Deployment PLC-Tool</td>
<td>7-1</td>
</tr>
<tr>
<td>General</td>
<td>7-2</td>
</tr>
<tr>
<td>Setup and run of program</td>
<td>7-3</td>
</tr>
<tr>
<td>PLC-Tool Operation</td>
<td>7-4</td>
</tr>
<tr>
<td>Deployment PLC-Tool</td>
<td>7-7</td>
</tr>
</tbody>
</table>
General

Overview

PLC-Tool

PLC-Tool is a program for operating the CPU 51xS. The OPC-Server is required for communicating with the CPU. The OPC-Server has to be installed on the PC. The PLC-Tool enables you to "talk" to external CPUs which are connected via MPI to the serial interface of the PC.

The operating surface (see figure above), which is a schematically top view of a CPU, serves for monitoring and operating the CPU. Here, the status of the LEDs on the CPU as well as the position of the mode switch are shown.

Tray-Icon

When starting the program, it installs itself also as a small icon (Tray-Icon) in the windows tool bar.

The Tray-Icon also visualizes the status of the CPU. This example here shows the CPU in run status. The program can be started repeatedly in order to simultaneously operate and monitor several CPUs. For each connection to a CPU, you have to assign an own MPI-address. Any other trademarks referred to in the text are the trademarks of the respective owner and we acknowledge their registration.
Setup and run of program

System requirements
For deployment of the PLC-Tool on your PC there are the following system requirements:

- PC with Windows operating system (Windows 2000 or higher, Windows XP professional or Windows NT 4.0 Service package 6)
- at least 32MB work memory (64MB are recommended)
- for installation about 10MB for OPC-Server and PLC-Tool

Requirements
The installation of the OPC-Server is required when using PLC-Tool, as the required drivers for the PLC-Tool will be installed on your PC by installing the OPC-Server.

Setup
As the PLC-Tool is a component of the OPC-Server package, the PLC-Tool will be installed together with the OPC-Server during the standard setup.

The PLC-Tool can also be installed separately. Like installing the OPC-Server, the installation of the PLC-Tool is supported by a setup-program.

Close all Windows-programs before starting the setup-program.

Insert the CD SW-Tool/Demo. The overview will be loaded via the auto-start function of the CD. From now on, you will be guided through the installation.

Run of program
PLC-Tool can be opened like any other PC-application. You have three options:

Start menu
In windows start menu, please click OPC! Then click on PLC-Tool!

Explorer
You can start the PLC-Tool by double clicking on file: \VPLCTool.exe in directory C:\Programs\OPC Server.

Tool bar via Tray-Icon
As soon as PLC-Tool has been started, tray-icon (mini symbol) is shown in the start tool bar.

PLC-Tool can be opened by double clicking onto that tray-icon.
PLC-Tool Operation

Operating Dialog

Open operating dialog

The operating dialog will be opened after starting the program.

Main menu

The menu of the program consists of the following entries:

<table>
<thead>
<tr>
<th>File</th>
<th>CPU</th>
<th>Options</th>
<th>?(Help)</th>
</tr>
</thead>
<tbody>
<tr>
<td>- Minimize</td>
<td>- New connection …</td>
<td>- Language</td>
<td>- Content</td>
</tr>
<tr>
<td>- Exit</td>
<td>- Connection diagnosis …</td>
<td>- Create link</td>
<td>- Help index</td>
</tr>
<tr>
<td></td>
<td>- Download WLD file</td>
<td>- Always on top</td>
<td>- Use help</td>
</tr>
</tbody>
</table>

Name of the PLC system

Here, the name of your PLC system is shown. You can enter the name into the dialog box CPU > New connection.

Status indicators

The LED states of the corresponding CPU are copied into the status indicators. The set up of the status indicator depends on the CPU in use. As long as there is not a connection to the CPU, the status indicator is deactivated. Additionally, there is a status indication in the tool bar of your windows-system (tray-icon).

Operating mode switch

The push buttons which are accordingly to the operating mode either activated or deactivated, serve for adjusting the operating mode of the CPU. Additionally the physical status of the operating mode switch is shown on the desk top in form of a switch.
**Structure of menu**

**File**

Minimize
By using the command „minimize“ the operating dialog will be closed. The program continues actively and will be stored as icon (tray-icon) on the tool bar.

Exit
Herewith, the program will be stopped and the tray-icon deleted from the tool bar.

**CPU**

New connection
With this command a dialog box will be opened. You can specify your connection to the CPU within this dialog box.

Connection diagnosis
When using this command a dialog box is opened which gives information regarding the effective connection.

Download WLD file
This function allows you to transfer wld files to the module.

**Options**

Language
When marking this command, a submenu containing a list of available languages for the surface is being opened. The active language is marked with a hook. The language on the program surface can be changed by clicking on another language.

Note!
As long as your operating system does not support languages, these languages will be shown as deactivated. The languages do exist but it is not possible to choose them.

Create link
Via setting up a link you can set up a link for your CPU connection which is momentarily active. In the dialog box you have to mention where you stored it.

Always on top
This function always puts the operating dialog onto the top level of the monitor. Therewith, the window is always visible, even then, when you are working with different applications. This function is marked with a hook, if active. By clicking anew onto that function – it can be deactivated again.
? (Help)  

Content  
This command opens an overview with topics of online-support.

Help Index  
This command offers the option to have all catchwords regarding information for support alphabetically indicated. In that list you can go up and down by using the arrow-keys and stop at the word you are looking for to mark it. After having marked that word the appropriate text for help will be shown.

Use help  
This function opens a window with standard-help for windows. Here, you can obtain information for using the help system.

Info  
Via information you will obtain details about revision date of the PLC-Tool and copyright.
Deployment PLC-Tool

Establish connection to the CPU

With **CPU** > *New connection* the dialog window "Create new adapter" is opened.

To access the CPU 51xS set *Connection type* to "Ethernet". The following dialog window is opened.

![Create new adapter dialog window]

**Name of adapter**

Please enter here an unique name! The name should signify the PLC system in which your CPU is, e.g. "mixer".

**Description**

Into this dialog box, you may enter an additional description, which explains your system more specifically. The assigned name in here will be given as tool-tip. If you don’t assign a description – then the name of the adapter will be given as "tool-tip".

**Local IP address**

The initialization by PLC function can only be established if Siemens SIMATIC manager and CPU 51xS slot card are at the same PC.

If the CPU 51xS slot card and PLC-Tool are at the same PC please enter here the IP address of the Ethernet part of the CPU 51xS.

If you want to access the CPU 51xS from an external PC via Ethernet, so you have to enter the IP address of the network card of the external PC. Additionally you have to set the routing to the CPU 51xS slot card in the target PC and to enter this route in the external PC. More concerning this may be found at "External access to PG/OP channel via routing".

**PLC IP address**

Please enter here the IP address of the CPU part of the slot card

**Slot number (Rack)**

Leave this parameter at 2.

**Finish**

By clicking at [Finish] a connection to your CPU is established.

---

**Note!**

The adjustments made in the dialog box are only of temporary existence.

As soon as you close the PLC-Tool, your entries will be deleted. For securing your settings you should secure your data in form of a link via *options > create link*. 

---
Connection diagnosis

Dialog box

The following dialog box will be opened under CPU > connection diagnosis:

This dialog box gives information about the effective connection.

Protocol of Procedures

Similar to the event protocol of windows, for indicating diagnosis data three procedure modes are used and are shown via a proper symbol.

The symbols have the following meaning:

- **ok**: A procedure was successfully finished.
- **i**: A procedure is in process.
- **!**: While in process, an error has occured.
Create link

When clicking **Options** > *create link* you reach a dialog box setting up a link. By starting the program via that link the PLC-Tool is being started and is automatically setting up the stored connection.

It’s possible to enter the following inputs for the link which has to be created.

**Link directory**

By clicking on the arrow a list with different options is being opened – it contains various directories out of the start menu as well as the desk top. Choose the requested file for the link with your mouse.

Via entry „another folder“ you can insert any other file for the link. For this, a standard dialog for a new folder is being opened.

**Adapter**

Via this selection-list you can see the connections already set up. This list is equivalent to the list in menu **CPU**.

In this selection-list you can find the connections already set up. You can also find this list in the connection-dialog box.

**Language**

In the menu **options** > *language* various languages are listed. Via selection list you have the option to choose one of these languages you prefer for the link and confirm it by mouse click.

**Hidden (as icon shown in the tool bar)**

By clicking this option it is reached that the program, when started via the link, will not me maximized but will only be started as icon in the tool bar.
Always on top

This option enables this program, when being started via the link, always to be atop all other programs on the monitor.

Note!

By saving your link in autostart (all users) with a setting „hidden“ the PCL-Tool is being started and secured as tray icon on the tool bar as soon your windows system is getting started.

Change of operating mode

Operating mode switch

The effective operation mode is indicated by LEDs.
The effective position of the operating mode switch on the CPU is visualized by a graphic in the PLC-Tool.

The switch has the following positions:

The CPU is in run modus.

The CPU is in stop modus.

M-Res (overall reset) – the CPU is in overall reset modus.

Push buttons

Next to the operating mode switch there are three push buttons with which the CPU can be positioned into the proper operation mode.

The following push buttons can be operated:

The CPU will be set into run modus.

The CPU will be set into run modus.

The CPU will be set into overall reset modus.

Note!

The push buttons are released or disabled for operation depending on the current operating mode (LED) and the effective position of the operating mode switch. Thereby, you can only use the push buttons which are suggestive for the current situation at a time.
Tray-Icon

Each entity of the program installs itself after starting as tray icon located in the windows-toolbar. When having finished the program, the tray icon will be deleted.

The tray icon has the following formats, according to the operating mode of the CPU:

- ![Icon](image)
  - CPU is in run modus

- ![Icon](image)
  - CPU is in start-up (changing from stop into run).

- ![Icon](image)
  - CPU is in stop modus

- ![Icon](image)
  - Status of CPU unknown (no connection).

Tool tip

When strolling over the tray icon with the mouse a small information window (tool tip) with the name of the adapter will be displayed. The dialog is being opened by double-clicking on the symbol. Right mouse click onto the symbol opens a menu via which the dialog can be called. Besides, finishing of the program is offered via the menu.
Status indication

For status indication, the PLC-Tool has LED-rows for the CPU and for the Profibus master. Use and the proper colors are to be found in below mentioned columns. For a detailed description of the LEDs, please refer to the manual for the respective CPU!

Not all LEDs listed below have to be always indicated. In fact, the PLC-Tool indicates the LEDs only which enable the PLC-Tool to read information from the CPU.

### Status LEDs CPU

<table>
<thead>
<tr>
<th>Description</th>
<th>Color</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>PWR</td>
<td>yellow</td>
<td>CPU is supplied with voltage.</td>
</tr>
<tr>
<td>RUN</td>
<td>green</td>
<td>CPU is in run-status. If LED flashing, CPU is in start up.</td>
</tr>
<tr>
<td>STOP</td>
<td>red</td>
<td>CPU is in STOP status.</td>
</tr>
<tr>
<td>SF</td>
<td>red</td>
<td>Lights up when system error occurs</td>
</tr>
<tr>
<td>MMC</td>
<td>red</td>
<td>Flashes when access to MMC</td>
</tr>
<tr>
<td>FRCE</td>
<td>yellow</td>
<td>Lights up as soon as variables are fixed.</td>
</tr>
<tr>
<td>DESL</td>
<td>yellow</td>
<td>Indicates Profibus slave activity as long as the integrated Profibus master is activated.</td>
</tr>
</tbody>
</table>

### Status of LEDs Profibus master

<table>
<thead>
<tr>
<th>Description</th>
<th>Color</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>RUN</td>
<td>green</td>
<td>Profibus master in operation. If LED flashes, Profibus master in start-up.</td>
</tr>
<tr>
<td>ERR</td>
<td>red</td>
<td>Lights up when breakdown of slave</td>
</tr>
<tr>
<td>DE</td>
<td>yellow</td>
<td>DE (Data exchange) indicates communication via Profibus</td>
</tr>
<tr>
<td>IF</td>
<td>red</td>
<td>Initializing error when parameterization is faulty</td>
</tr>
</tbody>
</table>

---

[57x789]Chapter 7   Deployment PLC-Tool

Manual VIPA System 500S SPEED7

7-12  HB145E - CPU - RE_517-4NE02 - Rev. 10/23
Chapter 8  WinPLC7

Overview
In this chapter the programming and simulation software WinPLC7 from VIPA is presented. WinPLC7 is suited for every with Siemens STEP® 7 programmable PLC.
Besides the system presentation and installation here the basics for using the software is explained with a sample project.
More information concerning the usage of WinPLC7 may be found in the online help respectively in the online documentation of WinPLC7.

Content
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chapter 8 WinPLC7</td>
<td>8-1</td>
</tr>
<tr>
<td>System presentation</td>
<td>8-2</td>
</tr>
<tr>
<td>Installation</td>
<td>8-3</td>
</tr>
<tr>
<td>Example project engineering</td>
<td>8-4</td>
</tr>
</tbody>
</table>
System presentation

General
WinPLC7 is a programming and simulation software from VIPA for every PLC programmable with Siemens STEP®7.
This tool allows you to create user applications in FBD, LAD and STL.
Besides of a comfortable programming environment, WinPLC7 has an integrated simulator that enables the simulation of your user application at the PC without additional hardware.
This “Soft-PLC” is handled like a real PLC and offers the same error behavior and diagnosis options via diagnosis buffer, USTACK and BSTACK.

Note!
Detailed information and programming samples may be found at the online help respectively in the online documentation of WinPLC7.

Alternatives
There is also the possibility to use the Siemens SIMATIC manager instead of WinPLC7 from VIPA. Here the proceeding is part of this manual.

System requirements
- Pentium with 233MHz and 64Mbyte work space
- Graphics card with at least 16bit color - we recommend a screen resolution of at least 1024x768 pixel.
- Windows 98SE/ME, Windows 2000, Windows XP (Home and Professional), Windows Vista

Source
You may receive a demo version from VIPA. Without any activation with the demo version the CPUs 11x of the System 100V from VIPA may be configured.
To configure the SPEED7 CPUs a license for the "profi" version is necessary. This may be online received and activated.
There are the following sources to get WinPLC7:

Online
At www.vipa.de in the service area at Downloads a link to the current demo version and the updates of WinPLC7 may be found.

CD
<table>
<thead>
<tr>
<th>Order no.</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SW211C1DD</td>
<td>WinPLC7 Single license, CD, with documentation in german</td>
</tr>
<tr>
<td>SW211C1ED</td>
<td>WinPLC7 Single license, CD, with documentation in english</td>
</tr>
<tr>
<td>SW900T0LA</td>
<td>ToolDemo VIPA software library free of charge respectively demo versions, which may be activated</td>
</tr>
</tbody>
</table>
Installation

Preconditions
The project engineering of a SPEED7 CPU from VIPA with WinPLC7 is only possible using an activated "Profi" version of WinPLC7.

Installation of WinPLC7
The installation and the registration of WinPLC7 has the following approach:
• For installation of WinPLC7 start the setup program of the corresponding CD respectively execute the online received exe file.
• Choose the according language.
• Agree to the software license contract.
• Set an installation directory and a group assignment and start the installation.

Demo
• Start WinPLC7. A "Demo" dialog is shown.
• Press the <q> key. The following dialog for activation is shown:

![Activation dialog](image)

• Fill in the following fields: Email-Addr., Your Name and Serial number. The serial number may be found on a label at the CD case.
• If your computer is connected to Internet you may online request the Activation Key by [Get activation key via Internet]. Otherwise click at [This PC has no access to the internet] and follow the instructions.
• With successful registration the activation key is listed in the dialog window respectively is sent by email.
• Enter the activation key and click to [OK]. Now, WinPLC7 is activated as "Profi" version.

Activation of the "Profi" version

Installation of WinPCAP for station search via Ethernet
To find a station via Ethernet (accessible nodes) you have to install the WinPCAP driver. This driver may be found on your PC in the installation directory at WinPLC7-V4/WnPCap_4_0.exe. Execute this file and follow the instructions.
Example project engineering

Job definition
In the example a FC 1 is programmed, which is cyclically called by the OB 1. By setting of 2 comparison values (value1 and value2) during the FC call, an output of the PLC-System should be activated depending on the comparison result.

Project engineering for deployment in the simulator
For the output in the simulator the following should apply:
- if value1 = value2 activate output Q 124.0
- if value1 > value2 activate output Q 124.1
- if value1 < value2 activate output Q 124.2

Precondition
- You have administrator rights for your PC.
- WinPLC7 is installed and activated as "Profi" version.

Hardware configuration
For the exclusive deployment in the simulator no hardware configuration is necessary.

Programming of the FC 1
The PLC programming happens by WinPLC7.
- Start WinPLC7 ("Profi" version)
- Create and open a new project by File > Open/create a project.

Creating block FC 1
- Choose File > Create new block.
- Enter "FC1" as block and confirm with [OK]. The editor for FC 1 is called.

Creating parameters
In the upper part of the editor there is the parameter table. In this example the 2 integer values value1 und value2 are to be compared together. Since both values are read only by the function, these are to be defined as "in".
- Select the "in -->" row at the parameter table and enter at the field Name "value1". Press the [Return] key. The cursor jumps to the column with the data type.
- The data type may either directly be entered or be selected from a list of available data types by pressing the [Return] key. Set the data type to INT and press the [Return] key. Now the cursor jumps to the Comment column.
- Here enter "1. compare value" and press the [Return] key. A new "in -->" row is created and the cursor jumps to Name.
- Proceed for value2 in the same way as described for value1.
- Save the block.
Parameter table

The parameter table shows the following entries, now:

<table>
<thead>
<tr>
<th>Address</th>
<th>Description</th>
<th>Name</th>
<th>Type</th>
<th>Initial value</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.0</td>
<td></td>
<td>value1</td>
<td>INT</td>
<td></td>
<td>1: comparison value</td>
</tr>
<tr>
<td>2.0</td>
<td></td>
<td>value2</td>
<td>INT</td>
<td></td>
<td>2: comparison value</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>FB00</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>temp</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Enter the program

As requested in the job definition, the corresponding output is activated depending on the comparison of value1 and value2. For each comparison operation a separate network is to be created.

- The program is to be created as FBD (function block diagram). Here change to the FBD view by clicking at FBD.
- Click to the input field designated as "empty". The available operations may be added to your project by drag&drop from the hardware catalog or by double click at them in the hardware catalog.
- Open in the catalog the category "Comparator" and add the operation "CMP==I" to your network.
- Click to the input left above and insert value1. Since these are block parameters a selection list of block parameters may be viewed by entering "#".
- Type in "#" and press the [Return] key.
- Choose the corresponding parameter and confirm it with the [Return] key.
- Proceed in the same way with the parameter value2.
The allocation to the corresponding output, here Q 124.0, takes place with the following proceeding:

- Click to the output at the right side of the operator.

- Open in the catalog the category “Bit logic” and select the function "--[=]". The inserting of "---=" corresponds to the WinPLC7 shortcut [F7].

- Insert the output Q 124.0 by clicking to the operand.

Network 1 is finished, now.

For further comparisons the operations "CMP>I" at Q 124.1 and "CMP<I" at Q 124.2 are necessary. Create a network for both operations with the following proceeding:

- Move your mouse at an arbitrary position on the editor window and press the right mouse key.
- Select at the context menu "Insert new network". A dialog field is opened to enter the position and number of the networks.
- Proceed as described for "Network 1".
- Save the FC 1 with File > Save content of focused window respectively press [Strg]+[S].
After you have programmed the still missing networks, the FC 1 has the following structure:

**Network 1:**
- **Network title:**
- **Network comment:**

```
<table>
<thead>
<tr>
<th>STL</th>
<th>FEL</th>
<th>LAD</th>
</tr>
</thead>
</table>
```

```
#value1
==?
#value2
...  QI21.0
=     
```

**Network 2:**
- **Network title:**
- **Network comment:**

```
<table>
<thead>
<tr>
<th>STL</th>
<th>FEL</th>
<th>LAD</th>
</tr>
</thead>
</table>
```

```
#value1
>?
#value2
...  QI24.1
=     
```

**Network 3:**
- **Network title:**
- **Network comment:**

```
<table>
<thead>
<tr>
<th>STL</th>
<th>FEL</th>
<th>LAD</th>
</tr>
</thead>
</table>
```

```
#value1
<?
#value2
...  QI24.2
=     
```
Creating the block OB 1

The FC 1 is to be called from the cycle OB 1.
- To create the OB 1 either you select **File > Create new block** or click to button [Display OB 1] and create the OB 1.
- Change to the STL view.
- Type in "Call FC 1" and press the [Return] key. The FC parameters are automatically displayed and the following parameters are assigned:

```
Network 1: Network title=
Network comment=

<table>
<thead>
<tr>
<th>STL</th>
<th>PBD</th>
<th>LAD</th>
</tr>
</thead>
<tbody>
<tr>
<td>0:</td>
<td>CALL FC 1</td>
<td></td>
</tr>
<tr>
<td>1:</td>
<td>value1:=10</td>
<td></td>
</tr>
<tr>
<td>2:</td>
<td>value2:=10</td>
<td></td>
</tr>
</tbody>
</table>
```
- Save the OB 1 with **File > Save content of focused window** respectively press [Strg]+[S].

Test the PLC program in the Simulator

With WinPLC7 there is the possibility to test your project in a **simulator**.
- **Here select "Target: Simulator"**.

```
WinPLC7 94.19, CRU15SC.W7
```
- Transfer the blocks to the simulator with **PLC > Send all blocks**.
- Switch the CPU to RUN, by clicking to the photo "Switch/Operating mode" and select in the dialog window the button [Warm restart]. The displayed state changes from STOP to RUN.
- To view the process image select **View > Display process image window**.
- Double click to the process image and enter at "Line 2" the address PQB124. Confirm with [OK]. A value marked by red color corresponds to a logical "1".
- Open the OB 1 with the button [Display OB 1].
- Change the value of one variable, save the OB 1 and transfer it to the simulator. According to your settings the process image changes immediately. The status of your blocks may be displayed with **Block > Monitoring On/Off**.
A further component of the simulator is the *PLC mask*. Here a CPU is graphically displayed, which may be expanded by digital and analog peripheral modules.

As soon as the CPU of the simulator is switched to RUN state, inputs may be activated by mouse and outputs may be displayed.

- Open the PLC mask with **view > PLC mask**. A CPU is graphically displayed.
- By clicking the right mouse button within the PLC mask the context menu is opened. Choose for this example "Insert 16-port digital input module". The module is displayed at the right side of the CPU.
- Double-click to the output module, open its properties dialog and enter the *Module address* 124.
- Switch the operating mode switch to RUN by means of the mouse. Your program is executed and displayed in the simulator, now.
For the output in the CPU 51xS the following should apply:

- if $value1 = value2$ activate bit memory M 124.0
- if $value1 > value2$ activate bit memory M 124.1
- if $value1 < value2$ activate bit memory M 124.2

Precondition

- You have administrator rights for your PC.
- WinPLC7 is installed and activated as "Profi" version.
- Your CPU 51xS is installed and the PG/OP channel may be accessed via Ethernet.
- WinPCap for station search via Ethernet is installed.
- The power supply of the CPU and the I/O periphery are activated and the CPU is in STOP state.

Hardware configuration

- Start WinPLC7 ("Profi" version).
- Create and open a new project by File > Open/create a project.
- For the call of the hardware configurator it is necessary to set WinPLC7 from the Simulator-Mode to the Offline-Mode. For this and the communication via Ethernet set "Target: TCP/IP Direct".
- Start the hardware configurator with . Please regard an object is selected with a double click at an object in the hardware configurator.
- Choose in the register Select PLC-System the parameter "VIPA SPEED7" and click to [Create]. A new station is created.
- Save the empty station. A station name and a comment may be entered before saving.
- By double click choose the according VIPA CPU in the hardware catalog at CPU SPEED7.
- For output place a digital output module and assign the start address 124.
- Save the hardware configuration.
Online access via Ethernet PG/OP channel

- Open the **CP343 properties** by double clicking to the CPU at slot 2 in the hardware configurator and selecting [Ethernet CP properties (PG/OP channel)] respectively by double clicking at “SPEED7 Ethernet (CP343)” slot 11 at UR3.
- Chose the register **Common Options**.
- Click to [Properties Ethernet].
- Choose the subnet “PG_OP_Ethernet”.
- Enter a valid IP address-and a subnet mask. You may get this from your system administrator.
- Close every dialog window with [OK].
- Select, if not already done, "Target: External TCP/IP direct".
- Open with Online > Send configuration to the CPU a dialog with the same name.
- Click to [Accessible nodes]. Please regard to use this function it is necessary to install WinPCap before!
- Choose your network card and click to [Determining accessible nodes]. After a waiting time every accessible station is listed. Here your CPU with IP 0.0.0.0 is listed, too. To check this the according MAC address of the CPU is also listed.
- For the temporary setting of an IP address select you CPU and click to [Temporary setting of the IP parameters]. Please enter the same IP parameters, you configured in the CPU properties and click to [Write Parameters].
- Confirm the message concerning the overall reset of the CPU. The IP parameters are transferred to the CPU and the list of accessible stations is refreshed.
- Select you CPU and click to [Confirm]. Now you are back in the dialog "Send configuration".

Transfer hardware configuration

- Choose your network card and click to [Send configuration]. After a short time a message is displayed concerning the transfer of the configuration is finished.

**Note!**

Usually the online transfer of the hardware configuration happens within the hardware configurator.

With **File** > Save active station in the WinPL7 sub project there is also the possibility to store the hardware configuration as a system file in WinPLC7 to transfer it from WinPLC7 to the CPU.

The hardware configuration is finished, now and the CPU may always be accessed by the IP parameters as well by means of WinPLC7.
The PLC programming happens by WinPLC7. Close the hardware configurator and return to your project in WinPLC7.

The PLC program is to be created in the FC 1.

Creating block FC 1

- Choose **File > Create new block**.
- Enter "FC1" as block and confirm with [OK]. The editor for FC 1 is called.

Creating parameters

In the upper part of the editor there is the **parameter table**. In this example the 2 integer values `value1` und `value2` are to be compared together. Since both values are read only by the function, these are to be defined as "in".

- Select the "in -->" row at the parameter table and enter at the field **Name** "value1". Press the [Return] key. The cursor jumps to the column with the data type.
- The data type may either directly be entered or be selected from a list of available data types by pressing the [Return] key. Set the data type to INT and press the [Return] key. Now the cursor jumps to the **Comment** column.
- Here enter "1. compare value" and press the [Return] key. A new "in -->" row is created and the cursor jumps to **Name**.
- Proceed for **value2** in the same way as described for **value1**.
- Save the block.

The parameter table shows the following entries, now:

![Parameter Table Screenshot]

Enter the program

As requested in the job definition, the corresponding output is activated depending on the comparison of **value1** and **value2**. For each comparison operation a separate network is to be created.

- The program is to be created as FBD (function block diagram). Here change to the FBD view by clicking at FBD.

![FBD Screenshot]

- Click to the input field designated as "empty". The available operations may be added to your project by drag&drop from the hardware catalog or by double click at them in the hardware catalog.
Open in the catalog the category "Comparator" and add the operation "CMP==I" to your network.

Click to the input left above and insert value1. Since these are block parameters a selection list of block parameters may be viewed by entering "#".

Type in "#" and press the [Return] key.

Choose the corresponding parameter and confirm it with the [Return] key.

Proceed in the same way with the parameter value2.

The allocation to the corresponding bit memory, here M 124.0, takes place with the following proceeding:

Click to the output at the right side of the operator.

Open in the catalog the category "Bit logic" and select the function "-=". The inserting of "-=" corresponds to the WinPLC7 shortcut [F7].

Enter the bit memory M 124.0 by clicking to the operand.

Network1 is finished, now.
Adding a new network

For further comparisons the operations "CMP>l" at M 124.1 and "CMP<l" at M 124.2 are necessary. Create a network for both operations with the following proceeding:

- Move your mouse at an arbitrary position on the editor window and press the right mouse key.
- Select at the context menu "Insert new network". A dialog field is opened to enter the position and number of the networks.
- Proceed as described for "Network 1".
- Save the FC 1 with File > Save content of focused window respectively press [Strg]+[S].

After you have programmed the still missing networks, the FC 1 has the following structure:

Network 1: Network title:  
Network comment:  
<table>
<thead>
<tr>
<th>STL</th>
<th>FLD</th>
<th>LAD</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>#value1</td>
<td>CMP</td>
<td>M124.0</td>
</tr>
<tr>
<td>#value2</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Network 2: Network title:  
Network comment:  
<table>
<thead>
<tr>
<th>STL</th>
<th>FLD</th>
<th>LAD</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>#value1</td>
<td>CMP</td>
<td>M124.1</td>
</tr>
<tr>
<td>#value2</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Network 3: Network title:  
Network comment:  
<table>
<thead>
<tr>
<th>STL</th>
<th>FLD</th>
<th>LAD</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>#value1</td>
<td>CMP</td>
<td>M124.2</td>
</tr>
<tr>
<td>#value2</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Creating the block OB 1

The FC 1 is to be called from the cycle OB 1.

- To create the OB 1 either you select **File > Create new block** or click to button [Display OB 1] and create the OB 1.
- Change to the STL view.
- Type in "Call FC 1" and press the [Return] key. The FC parameters are automatically displayed and the following parameters are assigned:

<table>
<thead>
<tr>
<th>Network 1:</th>
<th>Network title=</th>
</tr>
</thead>
<tbody>
<tr>
<td>Network comment=</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>STL</th>
<th>FBD</th>
<th>LAD</th>
</tr>
</thead>
<tbody>
<tr>
<td>0: CALL FC 1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1: value1=10</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2: value2=10</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

- Save the OB 1 with **File > Save content of focused window** respectively press [Strg]+[S].

Transfer PLC program to CPU and its execution

- For transfer to the CPU set the transfer mode to "Target: TCP/IP-Direct".
- For presetting the Ethernet data click to [...] and click to [Accessible nodes].
- Choose your network card and click to [Determining accessible nodes]. After a waiting time every accessible station is listed.
- Choose your CPU, which was provided with TCP/IP address parameters during the hardware configuration and click to [Confirm].
- Close the "Ethernet properties“ dialog with [OK].
- Transfer the blocks to your CPU with **PLC > Send all blocks**.
- Switch your CPU to RUN state.
- Open the OB 1 with the button [Display OB 1].
- Change the value of one variable, save the OB 1 and transfer it to the CPU. According to your settings the process image changes immediately. The status of your blocks may be displayed with **Block > Monitoring On/Off**.
Appendix

A  Index

3
3964R ........................................... 5-16

A
Accu............................................ 2-9
Address classes ..................1-5, 3-6
AG_RECV (FC 6).............6-34
AG_SEND (FC 5).............6-34
Application layer .............6-5
ASCII ........................................... 5-15
Assembly ..................................... 3-3

B
Basics ........................................... 1-1
Bit communication layer ....6-4-1
Break points .....................3-41
Broadcast .................................. 6-23

C
Clock............................................ 2-9
Communication
Connection ......................... 6-20
User program ..................... 6-30
Ethernet .....................................6-1
Layers ........................................ 6-2
Components .......................... 2-4
Connection
End point............................. 6-25
Path ........................................ 6-26
Type ........................................ 6-24
Coupling................................. 6-40
Cycle time surveillance ........ 3-42

D
Deployment
CPU 517S/NET ..................... 3-1
Ethernet .................................6-1, 6-14
Profibus DP master ............ 4-1
PtP communication ............. 5-1
Diagnostic .............................. 6-37
Buffer .................................... 3-54
Driver .................................... 3-4

E
Environment conditions ......... 1-10
Error
Diagnostic ......................... 6-37
Messages .................................. 6-35
ERW identifier ...................... 6-40
ESD ........................................... 1-10

Ethernet
Connection ......................... 6-20
Deployment ............................. 6-1
Fast introduction ................. 6-14
Hardware configuration ......... 6-18
Event-ID ................................. 3-54

F
Factory reset ........................... 3-48
Fast introduction
Ethernet................................. 6-14
NetPro .....................................6-16
PtP communication ................. 5-2

Firmware
Info by Web page .....................3-46
transfer .................................. 3-47
update .................................. 3-45
First start-up ......................... 3-4

H
H1 connection ......................... 6-10
Hardware description .......... 2-1
Host-ID .....................................1-3, 3-5, 6-11
reserved ..................1-5, 3-6, 6-12
Hub .......................................... 6-6

I
Initialisation
Ethernet component .......... 3-4
Initialization
CPU component .................. 3-10
Installation .......................... 3-2
Driver .................................... 3-4
IP address assignment ........ 3-5
Overview .................................. 3-2

Interfaces
MPI ........................................ 2-6
Profibus DP master ............ 2-6
RJ45 CP543 ..................................2-7
RS485
PtP ........................................ 5-1
IP address ......................... 6-11
at startup ......................... 6-11
Classes ................................... 6-12
CPU component .................. 3-24
ISO transport connection ....6-10, 6-27
ISO/OSI reference model ...... 6-3
ISO-on-TCP connection ...... 6-9, 6-27

HB145E - CPU - RE_517-4NE02 - Rev. 10/23

A-1
<table>
<thead>
<tr>
<th>K</th>
<th>3-50</th>
</tr>
</thead>
<tbody>
<tr>
<td>Know-how protection</td>
<td>3-50</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>L</td>
<td>2-4</td>
</tr>
<tr>
<td>LEDs</td>
<td>2-4</td>
</tr>
<tr>
<td>CP 543</td>
<td>2-5</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>M</td>
<td>3-49</td>
</tr>
<tr>
<td>MAC address</td>
<td>6-13</td>
</tr>
<tr>
<td>first start-up</td>
<td>6-13</td>
</tr>
<tr>
<td>MCC</td>
<td>3-49</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>Memory</td>
<td>2-7</td>
</tr>
<tr>
<td>expansion</td>
<td>3-49</td>
</tr>
<tr>
<td>management</td>
<td>2-7</td>
</tr>
<tr>
<td>MMC</td>
<td>3-39</td>
</tr>
<tr>
<td>-Cmd - Auto commands</td>
<td>3-52</td>
</tr>
<tr>
<td>Project transfer</td>
<td>3-39</td>
</tr>
<tr>
<td>Diagnostic</td>
<td>3-39</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>Modbus</td>
<td>5-18</td>
</tr>
<tr>
<td>Example</td>
<td>5-23</td>
</tr>
<tr>
<td>Function codes</td>
<td>5-19</td>
</tr>
<tr>
<td>Slave respond</td>
<td>5-20</td>
</tr>
<tr>
<td>Telegram</td>
<td>5-19</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>MPI interface</td>
<td>2-6</td>
</tr>
<tr>
<td>Multicast</td>
<td>2-6</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>N</td>
<td>3-40</td>
</tr>
<tr>
<td>NCM diagnostic</td>
<td>6-37</td>
</tr>
<tr>
<td>Net-ID</td>
<td>1-3, 3-5, 6-11</td>
</tr>
<tr>
<td>NetPro</td>
<td>6-21</td>
</tr>
<tr>
<td>Addresses</td>
<td>6-28</td>
</tr>
<tr>
<td>Block parameters</td>
<td>6-28</td>
</tr>
<tr>
<td>Connections</td>
<td>6-23</td>
</tr>
<tr>
<td>Fast introduction</td>
<td>6-16</td>
</tr>
<tr>
<td>Options</td>
<td>6-29</td>
</tr>
<tr>
<td>Route</td>
<td>6-28</td>
</tr>
<tr>
<td>Station</td>
<td>6-22</td>
</tr>
<tr>
<td>link up</td>
<td>6-22</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>Network</td>
<td>6-6</td>
</tr>
<tr>
<td>Network layer</td>
<td>6-4</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>O</td>
<td>3-41</td>
</tr>
<tr>
<td>OPC-Server</td>
<td>7-2</td>
</tr>
<tr>
<td>Operating mode</td>
<td>6-26</td>
</tr>
<tr>
<td>Operating mode switch</td>
<td>2-7</td>
</tr>
<tr>
<td>Operating modes</td>
<td>3-40</td>
</tr>
<tr>
<td>FLAG</td>
<td>3-41</td>
</tr>
<tr>
<td>ORG format</td>
<td>6-40</td>
</tr>
<tr>
<td>Overall reset</td>
<td>3-43</td>
</tr>
<tr>
<td>Overview</td>
<td>1-9</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>P</td>
<td>3-24</td>
</tr>
<tr>
<td>Parameter</td>
<td>3-24</td>
</tr>
<tr>
<td>via CPU 318-2DP</td>
<td>3-24</td>
</tr>
<tr>
<td>VIPA specific</td>
<td>3-31</td>
</tr>
<tr>
<td>PG/OP channel</td>
<td>3-14</td>
</tr>
<tr>
<td>external access</td>
<td>3-15</td>
</tr>
<tr>
<td>internal access</td>
<td>3-14</td>
</tr>
<tr>
<td>pkg file</td>
<td>3-45</td>
</tr>
<tr>
<td>PLC functions</td>
<td>3-59</td>
</tr>
<tr>
<td>PLC header</td>
<td>6-42</td>
</tr>
<tr>
<td>PLC-Tool</td>
<td>7-1</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Parameterization....................... 5-6
Principle data transfer ............... 5-3
Protocols................................ 5-15
RS485 interface........................ 5-4
SFCs.................................. 5-2, 5-9
STX/ETX.................................. 5-15
USS ......................................... 5-17

R
Reset
factory................................. 3-48
Overall .................................. 3-43
RFC1006 .................................. 6-9
Routing ................................... 3-15
Example.................................. 3-17

S
Safety Information ...................... 1-2
Security layer........................... 6-4
Send/Receive connection ............. 6-27
Session layer............................ 6-5
Shock resistance........................ 1-10
Siemens S7 connection ............... 6-7, 6-25
Structure................................ 2-3
STX/ETX.................................. 5-15

Subnet mask.................. 1-4, 3-6, 6-11
Subnet-ID.............................. 1-3, 3-5
Switch.................................... 6-6

T
TCP connection ...................... 6-8, 6-27
TCP/IP.................................. 6-8
Technical Data........................ 2-10
Test functions.......................... 3-58
Transport layer...................... 6-4
Tray-Icon............................... 7-2, 7-3
TSAP.................................... 6-13, 6-28
Twisted Pair........................... 6-6

U
UDP connection ...................... 6-9, 6-27
USS...................................... 5-17

V
Voltage supply......................... 2-8, 3-8

W
Watchdog................................ 3-42
Web page................................ 3-18
WinPLC7................................... 8-1
wld files................................. 3-39, 3-50